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Client Suite
CSM provides multiple clients to access the system.
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CSM Desktop Client
The CSM Desktop Client is the main application in the CSM suite. The Client runs under Microsoft®
Windows®, and provides all the features and default Business Objects/processes for service desk
professionals to effectively and proactively manage their support desks.
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About the CSM Desktop Client
Desktop Client features include:

• Record Logging: Log and manage records (ex: Incident, Problem, Change, Customer, CMDB,
etc.).

• Dashboards and Widgets: Use Dashboards to view critical metrics, analyze and predict trends,
drill-down into data, execute Actions, or just display a hodge-podge of information that might be
relevant to a group of Users/Customers.

• One-Step Actions: Run One-Step Actions to initiate one or more defined Actions, automating
common or repetitive tasks.

• Searching: Run Quick Searches or Search Groups (saved searches) to efficiently and thoroughly
search/filter your CSM data, locating one record or a set of records.

• Customer: Use the Contact Manager to view and manage Customer records.

• Reporting: Use a host of powerful reporting tools (defined Reports and report writing tools, Search
Groups, Dashboards/Widgets, and Visualizations) to gather and measure data, analyze metrics, and
predict trends.

• Knowledge: Search for Knowledge from configured Knowledge Sources (ex: Knowledge Articles,
records, attachments, web, etc.).

• Additional Features: Approvals, Attachments, Calendars, E-mail, Journals, Tasks, Queues,
Settings, Visualization, etc.
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Log in to the CSM Desktop Client or CSM
Administrator

To log in to the CSM Desktop Client:

1. Double-click the blue Cherwell Service Management icon  or orange CSM Administrator

icon  on the desktop, or click Start>All Programs>Cherwell Service Management or
Cherwell Administrator.

Note: If the Automatically Use Connection Without Asking check box was previously
selected or if the system administrator already set up a permanent database connection, the
database connection window will not open.

2. Select a database connection:

Note: Typically, Users connect using an Application Server (3-tier connection), identified by

the Application Server icon .

a. Click the All Users tab to view database connections available to All Users or the User tab to
view database connections available to only to the User logging in.

b. Click a database connection.

Note: To create a database connection, click Add to launch the Connection Wizard. To modify
an existing database connection, click the database connection, then click Edit. To delete an
existing database connection, click the database connection, then click Delete.

c. Select the Automatically Use Connection Without Asking check box to automatically use
this database connection each time CSM is launched. Afterward, the prompt is no longer
available to select a connection.

d. Click OK.
3. Provide the CSM login credentials:

a. User ID: Provide the CSM login ID (this could be domain name/network Username or just
Username).

b. Password: Provide the CSM password. Passwords are case-sensitive.

Tip: By default, there is a User ID called CSDAdmin with a password of CSDAdmin in the
Demo and Starter databases.

c. Automatically Login Without Asking: Select this check box to automatically use the above
information at the next log in. This avoids a login prompt.

d. Click OK.

e. If a User is assigned to more than one CSM Role (and have not previously selected thee. 
Automatically Use Selected Role check box), the Choose Role window opens.
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4. Select the login Role for the session:
a. Click the appropriate Role.

b. Always Use Selected Role: Select this check box to automatically use the selected Role at the
next log in. This avoids the Role prompt.
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Tour the CSM Desktop Client User Interface
The CSM Desktop Client User Interface is personal, dynamic, and highly configurable. Typically, the main
window displays the following items:

• Menu bar

• Search Control

• Toolbar

• Task Pane

• Main Pane

• Knowledge Pane

Each User has a personal interface that is controlled by login Role, security rights, and personal settings.
For example, your default Dashboard (displayed in the Main Pane when you log in or click the Home
button) might display real-time Incidents, Twitter Feeds, or metrics for your Team. Your default Calendar
(displayed when you click the Calendar button) might display your active Tasks. Your Task Pane might
display your Queues or your common operations, such as Reports or One-Step Actions. The toolbars and
panes are dynamic, so they change to accommodate active content. Toolbars and panes are also
configurable, collapsible, and dockable so that you can display what you want and put it where you need
it.

CSM provides a default Desktop Client interface; however, the system administrator typically tailors this to
meet your organization's requirements (ex: The system administrator can configure what to display in the
Task Pane, Knowledge Pane, Search Control, etc.). With security rights, you can also personalize the
interface to meet your personal needs.

The following figure shows two sample main windows:
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1. A sample Dashboard in the Main Pane.

2. A sample Incident record, along with its Arrangement, in the Main Pane. Notice that the Task Pane
and Knowledge Pane can be collapsed to allow more area for the record. Also, notice that the Task
Pane and CSM Desktop Client toolbar change to display information and buttons specific to the
active record.
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CSM Desktop Client Main Window
The CSM Desktop Client Main window is configurable and puts information at your fingertips. You decide
what to display and where to put it. By default, the main window contains the following:

1. Menu bar: Dynamic row of drop-down menus that are used for common operations.

2. Toolbars: Dynamic row of buttons that are used for common operations.

3. Search Control: Search box to find specific words or phrases.

4. Culture selector: Switch cultures to change the language for platform and content strings. Available
only when globalization features are enabled.

5. Task Pane: Highly configurable and dynamic tool used to quickly access operations.

6. Main Pane: Primary interface that displays the Records, Forms, etc. that you are working on.

7. Knowledge Pane: Highly configurable and dynamic tool used to quickly access Knowledge Sources
in your Knowledge Base.
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CSM Desktop Client Menu Bar
Use the CSM Desktop Client menu bar, located at the top of the main window, to access common CSM
operations.

These menu options appear only if they have been configured in CSM Administrator:

• Actions

• Localization

File Menu

Action Description

New Creates a new record (ex: Incident).

Save Saves the active record.

Abandon Abandons changes to the active record.

Delete Deletes the active record.

Print Prints the active pane.

Print Grid Prints the active Grid.

Export Grid

Exports the active Grid to the following formats:

• .csv

• .html

• .txt

• .rtf

• .xml

Send E-mail Creates an e-mail to send.

E-mail Current Customer Creates an e-mail to send to the active Customer.

New Window Launches a new CSM window.

Logout Logs you out of the CSM Desktop Client.

Close Closes the CSM Desktop Client.

Edit Menu

Action Description

Undo Cancels the last operation.

Redo Repeats the last operation.
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Action Description

Cut Moves the selected item to the clipboard, where you can paste the item into a new
location.

Copy Copies the selected item to the clipboard, where you can paste the item to a new
location.

Paste Inserts an item from the clipboard.

Show Legal
Values Displays a list of legal values (for Lookup Fields only).

Refresh Refreshes the active record.

Zoom Zoom the Field into a larger window.

Unlock Releases the lock (unlocks) the active record.

User Locks Opens the Record Locking Manager, where you can view and release any/all
locked records.

View Menu

Action Description

Task Pane Displays/hides the Task Pane.

Knowledge Displays/hides the Knowledge Pane.

Navigation (window) Displays the default (Home) Dashboard and navigates back/forward through the
session history.

Record (Navigation) Navigates through the current record set.

Searching Menu

Action Description

Search Manager Opens the Search Group Manager, where you can run and manage saved
searches (Search Groups).

Quick Search Builder Opens the Quick Search window, where you can build a Quick Search.

Edit Current Search Opens the Edit Search window, where you can change the parameters of the
active search.

Save Current Search
As Saves the active search as a saved search that you can use again later.

MRU list Lists the MRU (Most Recently Used) items.
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One-Step Action Menu

Action Description

One-Step Action Manager Opens the One-Step Manager, where you can run and manage One-Step
Actions.

MRU list Lists the most recently used (MRU) One-Step Actions.

Customer Menu

Action Description

Contact Manager Opens the Contact Manager, where you can view and manage Customer Records.

Current Info Displays the current Customer's information.

Config Items Displays the current Customer's Configuration Items.

Dashboards Menu

Action Description

Dashboard Manager Opens the Dashboard Manager, where you can view and manage
Dashboards.

Edit <current Dashboard> Opens the Dashboard Editor, where you can edit the current
Dashboard.

Set <current Dashboard> as
default Changes the current Dashboard to be the User default.

Focus on Dashboard Sets focus on the current Dashboard view.

Widget Manager Opens the Widget Manager, where you can manage Widgets.

Metric Manager Opens the Metric Manager, where you can manage Metrics.

Color Palette Manager Opens the Color Palette Manager, where you can manage color
palettes.

Heads-up Display Opens the Heads-Up Display (HUD) in a new window.

MRU list Lists the most recently used (MRU) Dashboards.

Tools Menu

Action Description

CMDB Opens the CMDB interface, where you can manage Configuration Items (CIs).

Queues Opens the Queue Manager, where you can manage Queues.
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Action Description

Knowledge Opens the Knowledge Pane, where you can search configured Knowledge
Sources.

Reports Opens the Report Manager, where you can run and manage Reports.

Calendars Displays the default (Main) Calendar. Also displays an option to open the
Calendar Manager, where you can view and manage Calendars.

Visualizations Displays the default Visualization. Also displays an option to open the
Visualization Manager, where you can view and manage Visualizations.

Attachments Opens the Attachment Manager, where you can view and manage Attachments.

Current Record
Automation
Processes

Displays Automation Processes for the current record.

Table Management Opens the Table Management interface, where you can manage Lookup Table
values.

Options
Opens the Options window, where you can configure personal settings (ex:
General, Display, Task Pane/Search Control, Dashboard/HUD/Calendar, User
information, and E-mail).

Actions Menu
If configured, an Actions menu also appears when a record is displayed in the Main Pane (example: The
Incident Actions menu item displays when an Incident is active). The Actions are defined as part of the
Business Object definition in CSM Administrator.

Action Description

Quick Templates Displays a list of available Quick Templates (ex: Reset Password).

Localization Menu
This option is only available when Globalization is enabled.

Action Description

Culture Quick Swap (CTRL+W) Switch between the preferred culture and the last
selected culture.

Preferred Culture (CTRL+D) Switch to the preferred culture.

Previous Culture (CTRL+P) Switch to the last culture you selected.
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Help Menu

Action Description

Contents Opens the online help.

Reload Definitions Reloads all definitions.

Current Field
Information

Displays properties for the active Field (ex: Name, type, description, search
properties, required or not, validation, and Field ID).

Report Error Opens the Report Error window so you can report an error to Cherwell
Software.

System Analyzer Opens the System Analyzer, where you can track behind-the-scenes
operations in a live environment directly from the CSM Desktop Client.

About Display information about CSM (version, copyright, licensing details, and
contact information).
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CSM Desktop Client Search Control
Use the CSM Desktop Client Search Control, located in the upper right corner of the Main window, to
quickly find all records that contain a specific word or phrase.

You can Quick Search all records (ex: Find all records that contain the word "printer") or limit the search to
records of a particular type (ex: Find all Incidents that contain the word "printer"). When searching a
particular Business Object, you can refine the search by defining search options, such as search open
records only, search attachments and/or related Business Objects, search a timeframe, etc. If needed,
you can also access the Search Manager to run or create a Search Group (saved search).

The Search Control is configurable (technically, it is a Search Widget) and can vary by Role. The system
administrator decides if it is displayed, which Business Objects can be searched, and what the search
options are. Your default Search Control (either System or Role) is initially set in CSM Administrator by a
system administrator; however, if you have security rights, you can select your own default.

Good to know:

• Searches can use AND (all words) or OR (any word) logic; the system administrator defines this
default.

• Wildcards (*, %) can be used.

• If results are the same type (ex: all are Incidents), the results are displayed in the Grid. If results are
of different types (ex: Incidents and Problems), the results are displayed in a list.

The default Search Control contains the following items.

Action Description

Choose Items to
Search

Drops down so that you can select what to search:

• Quick Search: Searches all records that contain a specific word or phrase
(ex: find all records that contain the word "printer").

• Specific Search: Searches only records of a particular type (ex: find all
Incidents that contain the word "printer").

Search Displays the word or phrase to search for. The drop-down displays the most
recently used (MRU) searches.

Go Runs the search. Search results are displayed in a Grid (if they are of the same
type) or a List (if they are of different types).

Search Options Drops down so that you can refine search options for a specific record type.
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Action Description

Open "Business
Objects" only

Limits the search to records that have not reached their final state (ex: not
closed).

Note: The lifecycle and terminology vary depending on the Business
Object and scenario (ex: "Unapproved Changes only" might appear
when searching Changes). If the Business Object does not have a "final"
or closed state, the check box does not appear.

Changed Options Limits the search to records that have changed during a specific timeframe.

Relationships
Includes related Business Objects in the search (ex: If the search word appears
in a Journal entry, the Incident to which it is attached will be included in the
search results).

Attachments Includes record Attachments in the search (ex: Searches file attachments in each
record).

Sort by Selects the Business Object field (column) to use to sort the search results.

Descending Sort
Order Sorts the results in descending order (Z-A) instead of ascending order (A-Z).

Search Manager Opens the Search Manager where you can create a Search Group.

Close Closes the Search options drop-down box.
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CSM Desktop Client Toolbar
Use the CSM Desktop Client toolbar to quickly access common CSM operations. The toolbar is made up
of several smaller toolbars:

• Main toolbar: Displays buttons for performing common CSM operations.

• Navigation toolbar: Displays buttons for navigating between records (ex: Incident, Problem, etc.).

• Action toolbars: Display buttons specific to the type of record displayed in the Main Pane (ex: The
Incident toolbar displays when an Incident is active). These toolbars are created as part of the
Business Object definition in CSM Administrator.

• User toolbars: Display personal toolbars that Users create.

• Arrangement/Relationship toolbars: Display buttons for working with Form Arrangement records
(child records in a relationship with a parent record).

By default, all toolbars are located under the menu bar in the main window; however you can
independently display/hide and move/dock each toolbar so that you can display them when and where
you want. Buttons are dynamic (ex: The Lock button appears only when a record is displayed in the Main
window; the Save button is grayed out until CSM detects that there is content to save, etc.).

The default toolbars contain the following items.

Main Toolbar

Button Action Description

Back/Forward Navigates backward or forward in the content pane sequence.

Home Displays the CSM Home page with the default Dashboard active.

Calendar Displays the default Calendar.

New Displays item options (you choose the type). The icon on the button
indicates the type of record.

Save Saves changes in the active window.

Abandon Abandons changes to the current item.
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Button Action Description

Lock Record

Unlock Record

Record is
locked by
another User

Locks the active record.

Unlocks the active record.

Record is locked by another User.

Note: This button toggles depending on the current status of
the active record and who has the record locked. This button
appears only if record locking is enabled and only when a
record is active in the CSM Main Window.

Cut Moves the selected item to the clipboard, so you can then paste the
item into a new location.

Copy Creates a new item whose properties are the same as the copied
item. The new item can then be named and customized.

Paste Inserts an item from the clipboard to a new location.

Attach Attaches a file, Web page, image or shortcut. Also, has an option for
displaying/hiding the Attachment Bar.

Show Legal
Values
(Lookup)

Displays a list of legal values (for lookup fields only).

Print Prints the active pane.

Search
Manager

Opens the Search Group Manager, where you can run and manage
saved searches (Search Groups).

Navigation Toolbar

Button Action Description

Show results Displays a set of records meeting a specific criteria.

Show current record Displays the currently selected record.

Go to first record Jumps to the first record in set.

Go to previous record Jumps to the previous record in set.
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Go to next record Jumps to the next record in set.

Go to last record Jumps to the last record in the set.

Action Toolbar

The Action toolbars are created as part of a Business Object definition, vary by Record Type (ex: Incident
is different than Problem), and appear only when a record is open.

Form Arrangement/Relationship Toolbar

The Relationship toolbars are created as part of the Form Arrangement definition, vary by Relationship,
and appear only when a child tab is displayed in an Arrangement. The following figure shows an example
of a Configuration Item (CI) toolbar displayed in an Incident's Arrangement.

Button Action Description

Link Adds/links additional items.

Unlink Unlinks the selected item.

Go To (Quick View) Goes to the source record.

Save Saves changes in the active window.

Quick View Opens the item in a second window so you can take a quick look
at the details.

Go to first record Jumps to the first record in the set.

Go to previous record Jumps to the previous record in the set.

Go to next record Jumps to the next record in the set.

Go to last record Jumps to the last record in the set.

Filter Filter items in the Grid.

Print Prints the active Grid.

Export Export Grid to a file.
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View

Displays items as:

• Form

• Grid

• Split screen (both Form and Grid): horizontal or vertical.
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CSM Desktop Client Task Pane
The CSM Desktop Client Task Pane is highly configurable and is used to quickly access tasks. The tasks
in the Task Pane vary depending on the active item in the Main Pane (ex: If an Incident is active, the tasks
will be Incident-specific).

By default, the Task Pane is located on the left side of the main window; however, you can display it/hide
it, collapse/pin it, and move/dock it so that you can display it when and where you want.

The system administrator initially chooses which items appear by default for each Role; however, if you
have security rights, you can can select which items appear on your own Task Pane. By default, the Task
Pane contains the following sections:

• Quick Search: Displays the Quick Search Control, and then create a simple query to quickly
find all records that contain a specific word or phrase. In the Task Pane, a Quick Search finds
all records of a particular type (Incident, Problem, etc.).

Note: For more information, refer to About Quick Search.

• Common Tasks: Displays tasks you frequently do.

• Actions: Displays common actions for the active record. This area changes based on the record
(Business Object) you are working with.

• Queues: Displays the current record and a list of specific grouped records.

Note: For more information, refer to About Queues.

• Process & Terminology: Displays helpful text for the active record.

• Customer Info: Displays a mini Customer summary for any active record that allows you to
select a Customer (ex: Incident).
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CSM Desktop Client Main Pane
Use the CSM Desktop Client Main Pane to view data and to perform the majority of your CSM operations.
Upon logging in, the Main Pane displays the Home Dashboard.

Depending on the operation, the Main Pane can also display:

• Records: Incident, Problem, Knowledge Article, etc.

• Search Results: Quick Search, Knowledge Search, etc.

• Default Calendar.

• Contact Manager.

• Configuration Management Database (CMDB).

• Table Management.
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CSM Desktop Client Knowledge Pane
Use the CSM Desktop Client Knowledge Pane to quickly access the Knowledge Sources in your
Knowledge Base (ex: Knowledge Articles, Business Objects, web, etc.). The available Knowledge
Sources vary depending on which Business Object is displayed in the CSM Main Pane.

By default, the Knowledge Pane is located on the right side of the main window; however you can display/
hide it, collapse/pin it, and move/dock it so that you can display it when and where you want.

The system administrator decides which Knowledge Sources can be searched and the searching options.
By default, the Knowledge Pane contains the following items:

Note: For more information about using the Knowledge Pane functionality, refer to About
Knowledge Search.
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CSM Desktop Client Search
CSM provides multiple ways to search for information and records. The Search feature can be viewed in
two locations in the main window:

1. Task Pane

2. Search Control
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Personalize the Desktop Client User Interface
The CSM Desktop Client interface is highly configurable. You can:

• Configure User settings: General, Display, Task Pane/Search Control, Dashboard/HUD/Calendar,
User information, and E-mail.

• Display/hide a toolbar or pane.

• Pin/collapse a pane.

• Move/dock a pane.

• Move/dock a toolbar.

• Create a personal User toolbar.
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Configure User Settings
Global and User settings are initially configured in CSM Administrator. Personal settings/defaults control
how CSM looks and behaves for you, a User. Use the CSM Options window (Tools>Options) to configure
the following User settings:

• User General settings: Restore, Searching, MRU (Most Recently Used), IME (Input Method
Editor), Catalog, and Logging settings.

• User Display settings: Default Theme, and Windows titles, DPI/Scaling, and Multiple Monitor
settings.

• User Task Pane and Search settings: Which default items appear in the Task Pane and which
Search Control is used on the CSM menu bar.

• User Dashboard and Calendar settings: Personal default Dashboard, Heads-Up Display (HUD),
Calendar, and Mobile Dashboard. You can also configure personal Web Proxies for Web Requests
(RSS, Twitter, etc.).

• User Information settings: Personal login credentials, authentication, User Profile information.

• User E-mail settings: Personal e-mail accounts.
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Configure User General Settings
Use the General page in the Options window to configure the following General settings for a User:

• Restore Settings: Reset message prompts and Grids to their default settings.

• Searching: Automatically open a record if it is the only record returned in a Search.

• MRU (Most Recently Used) Items: Define the number of items that display in a CSM Item's MRU
list (in the CSM Desktop Client menu bar). Ten items display by default.

Note: The number of items that can be viewed in the MRU list at one time includes items
that are pinned using CSM Item Managers.

• IME (Input Method Editor): Use IME capabilities so that Users can enter characters and symbols
(ex: Chinese, Japanese, or Korean language symbols) not found on the input device (ex:
Keyboard).

• Logging: Configure event logging for the CSM Desktop Client, which records significant events/
errors and is used for troubleshooting. When you configure event logging, you define:

◦ Where to log events: To the event log (so they can be viewed by the Windows Event Viewer),
to a specified file (where you determine location and size), or to a Splunk server (so you can
use the tool to manage event data).

◦ Which classification of server events to log: Debug, Stats, Info, Warning, Error, or Fatal.

To configure User General settings:

1. From the menu bar, select Tools>Options.

2. Click the General page.

3. Configure Restore settings for messages and Grids:
a. Restore All Dismissed Message Prompts: Select this check box to restore any previously

dismissed message prompts so that they appear again.

b. Restore All Customized Grids to Admin Defaults: Select this check box to restore all
customized Grids back to their default definitions.

4. Configure Search Results settings:
a. If Only One Record is Found in a Search, Automatically Go To That Record: Select this check

box to be directed straight to the only search result, instead of first viewing the single item in a
Grid List.

5. Configure MRU settings:
a. Use the up and down arrows to increase or decrease the number of CSM Items that display in

the item's MRU list (in the CSM Desktop Client menu bar). Ten items display by default.

6. Configure IME Compatibility settings:
a. Use IME Compatible Multi-line Text Controls: Select this check box to allow Input Method

Editor (IME) capabilities so that Users can enter characters and symbols (example: Chinese,
Japanese, or Korean language symbols) not found on the input device (example: Keyboard).

b. Configure Definition Catalog settings:
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i. Select an option for storing primary system definitions in a local catalog file on a User's
machine:

◦ Use System Settings: Select this option to adhere to the Administrator definitions of
catalog usage.

◦ Use a Local Definition Catalog: Select this option to ensure the usage of a catalog,
regardless of Administrator definitions.

◦ Don't Use a Local Definition Catalog: Select this option to ensure a catalog is not
used, regardless of Administrator definitions.

7. Configure event logging for the CSM Desktop Client:
a. Configure: Click the Configure button to open the Logging options window.

b. Select where to log CSM events (select one or more options):

◦ Log to event log: Check this box to log CSM events so that they can be viewed by the
Windows Event Viewer. Then, select which events to log:

◦ Debug and above: Very verbose messages. Leaving this on continuously can get space
and resource intensive.

◦ Stats and above: Detailed messages that track performance.

◦ Info and above: Informational messages that can be used to diagnose a problem with
your Server.

◦ Warning and above: Warning messages that occurred while the Server was running.

◦ Error and above: Errors that were encountered while the Server was running.

◦ Fatal only: Errors that were encountered while the Server was running that caused the
Server to stop.

◦ Log to file: Check this box to write the logs to a specific file and location. Then, set your file
limits.

◦ Log Level: Select an event classification as described above (example: Debug and
above, Info and above, etc.)

◦ File Name: Click the Ellipses button  to select a location for the log file.

◦ File Size Limit: By default, the file size is set to 10 MB, but can be changed by entering a
new value in the field.

◦ File Count Limit: Rolling event logs are used, so that when the maximum file size is
reached for a log file, a new file is created. By default, the number of files is set to 20 (but
can be changed), after which the oldest log file is overwritten by continued logging.

◦ Log to Splunk: Check this check box to log CSM events to a Splunk server, where they can be
indexed and searched. Then, set your server parameters.

◦ Log Level: Select an event classification as described above (example: Debug and
above, Info and above, etc.)

◦ Server: The name of the Splunk server. If a Splunk server has not already been
configured, go to the next step.

◦ (Optional) If a Splunk server has not been configured, click Configure.

The Splunk Server Settings window opens.
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Define the following, and then click OK:

◦ Server URL: Type the URL of the Splunk server (example: https://
splunkserver:8089).

◦ User Name: Type the user name of the individual with an account on the Splunk
server.

◦ Password: Type the password of the individual with an account on the Splunk
server.

◦ Ignore Certificate Errors: Check this box to ignore certificate errors that might be
generated by Splunk using self-signed certificates to encrypt data. Tip: Check this
box if you trust your connection is with the server.

◦ Test: Click this button to test the CSM connection to the Splunk server.

8. Click OK to close the Logging options window.

9. Click OK.9. 
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Configure User Display Settings
Use the Display page in the CSM Options window to configure the following User Display settings:

• The application skin for the Desktop Client and Administrator Client

• Windows titles

• DPI/Scaling settings

• Multiple monitor settings

• Accessibility display options for Forms

To configure User Display settings:

1. From the menu bar, select Tools>Options.

2. Click the Display page.

3. Select an application skin from the Skin list to control the appearance of the Desktop Client and
Administrator Client shells.

4. Configure Window Title settings by selecting the Display Connection information check box and
then selecting an option from the drop-down menu:

◦ Connection: Displays as <connection name> connection.

◦ Database: Displays as <database name> database.

◦ Environment (Production, Development, or Test): Displays as <environment name>
environment.

◦ Connection and database: Displays as <connection name> connection, <database name>
database.

◦ Connection and environment: Displays as <connection name>, <environment> name.

◦ Connection, database, and environment: Displays as <connection name> connection,
<database name> database, <environment name> environment. If an environment value is not
selected, the content displays as Unknown environment.

Note: This setting applies to all CSM databases (ex: CSM Administrator) on your current
computer.

5. (Not recommended) Select the Override system scaling settings check box to control how
Business Object Forms are scaled based on a User's Windows DPI settings.

These settings do not control scaling of other visual elements in CSM. These settings only apply to
the current database in which you define the settings.

6. If you have multiple monitors, you can specify where to open/restore CSM application windows. Not
all Cherwell windows persist their location. For those windows, the standard behavior depends on
Microsoft Windows.

Select the Override System Window Restore Settings check box, and then select one of these
options:
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◦ Original Monitor

Window opens in the same location on the same monitor where it was last closed.

◦ Application Main Window Monitor

Window opens in the same location on the same monitor as the application Main window (the
upper-left of the main application is the control point if the application straddles multiple
monitors).

◦ Mouse Pointer Monitor

Window opens in the same location on the same monitor as the mouse pointer. This option
only differs from the Application Main Window Monitor option when the User uses the
keyboard to open windows in CSM, and the mouse pointer is located on a different monitor
from the one where the application Main window is located. For example, if you have the CSM
Main application on monitor 2, but bring up the One-Step Action Manager and drag it to
monitor 1, when you edit an existing One-Step Action, the Manager will appear on monitor 1,
even though the main application is still on monitor 2.

Note: This setting applies to all CSM databases (example: CSM Administrator) on your
current computer. Windows that always open fully on the screen are not governed by
these changes. If a window is too large to physically fit on the monitor, it will be
snapped to the left and/or top edges depending on if it is too big in just one or both
dimensions. You might notice this if you consistently drags windows partially off of the
screen and expect them to open that way the next time.

7. Override Business Object form themes with Windows colors

Select this check box to use Windows colors instead of the Form's defined Theme. This assists
users with accessibility needs because the Forms display with high-contrast colors.

8. Click OK.8. 
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Override System Scaling Settings
If you have security rights, you can override the global CSM Administrator system scaling settings.

Note: Overriding the global scaling settings is not recommended. If Users increase their Windows
DPI levels above 96, the default settings in CSM Administrator allow for automatic scaling of
Business Object Forms in CSM. If the default settings are overridden, items will not be scaled at
higher DPI settings. Business Object Forms can be manually scaled during design, but this leaves
more room for error.

To override system scaling settings:

1. Open the CSM Display page (Tools > Options > Display Page).

2. Define personal scaling settings:
a. Override System Scaling Settings: Select this check box to override the global scaling settings

defined in CSM Administrator.

b. Scale Business Object Forms Based on User's Text Size (DPI): Select this check box to have
Business Object Forms automatically scaled.

c. When a Creation Size Does Not Exist, Use: Select an option in the drop-downs to determine
whether Business Object Forms are scaled from a specific DPI value if there are no cached
DPI property values in CSM.

i. Select a specific DPI value to scale Business Object Forms from a certain DPI level
when CSM does not have any cached DPI values. This setting allows the system to
assume that the Forms were created at the selected DPI.

ii. Select None if you don't want items to be automatically scaled from a certain DPI value
when a creation size does not exist. In this case, CSM will not attempt to scale Forms
that have not been edited in version 4.60 or later, and Forms will likely be skewed and
hard to read at higher DPI values.
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Configure User Task Pane and Search Control
Settings

Use the Task Pane and Search page in the CSM Options window to configure which default items appear
in the Task Pane and which Search Control is used on the CSM menu bar.

To configure User Task Pane and Search Control settings:

1. From the menu bar, select Tools>Options.

2. Click the Task Pane and Search page.

3. Configure Task Pane settings:
◦ View or hide sections.

◦ Add new sections.

◦ Configure sections (only applicable to new sections).

◦ Delete sections (only applicable to new sections).

◦ Organize sections.

4. Check or uncheck the corresponding check box to view or hide the following sections in the Task
Pane:

◦ Quick Search

◦ Common Tasks

◦ Actions

◦ Queues

◦ Process and Terminology

◦ Customer Information

5. Add items to the Task Pane (if not using the Default Task Pane Setup):
a. Uncheck Default Task Pane Setup check box.

b. Click Add to open the Task Pane Section window.

c. Specify a name for the Task pane section.

d. Click Add to open the Action Manager.

e. Select the items you want to appear in the Task Pane (example: Calendars).

6. Customize the CSM Search Control in the menu bar Search Options:
◦ Use Default: Use the Default Search Menu Search Widget, which allows Users to run a Quick

Search on multiple Business Objects simultaneously (example: Knowledge Article and Change
Request). Users can also select a Business Object in the drop-down to search one item at a
time (Specific Search).

◦ Use Search Widget: Click the Ellipses button to open the Widget Manager and select an
existing Search Widget or create your own.

◦ No Menu Bar Search: Remove the option to search from the menu bar.

7. Click OK.7. 
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Configure User Dashboard and Calendar Settings
Use the Dashboards & Calendars page in the CSM Options window to configure the following User
Dashboard and Calendar settings:

• Default Dashboard (Home Dashboard).

• Default Heads Up Display (HUD).

• Default Calendar.

• Default Mobile settings: Configure how Cherwell Mobile looks and behaves on your personal mobile
device.

• Allow Web Proxies for Web Requests (RSS, Twitter, etc.).

• Clear the local Metric Cache.

To configure User Dashboard and Calendar settings:

1. From the menu bar, select Tools>Options.

2. Click the Dashboards & Calendars page.

3. Select a default Dashboard:
a. Use default: Select this radio button to use the global default Dashboard.

b. Dashboard: Select this radio button to use select your own Dashboard instead of the default
Dashboard.

c. Click the Dashboard button  to open the Dashboard Manager, and then select an existing
Dashboard or create a new Dashboard.

4. Select a default HUD:
a. Use default: Select this radio button to use the global default HUD.

b. Heads-up Display: Select this radio button to select your own HUD instead of the default HUD.

5. Select a default Calendar:
a. Use default: Select this radio button to use the global default Calendar.

b. Calendar: Select this radio button to select your own Calendar instead of the default Calendar.

c. Click the Calendar button  to open the Calendar Manager, and then select an existing
Calendar or create a new Calendar to use as the default.

6. Configure default Mobile Settings:
a. Customize Mobile Settings: Select this check box to override the default Cherwell Mobile

Dashboards configured in CSM Administrator.

b. Click the Mobile Dashboards button to open the Default Mobile Access Setup window, and
then define how Cherwell Mobile looks and behaves on your personal mobile device.

Note: For more information, refer to Define User Cherwell Mobile Settings in the Cherwell
Mobile documentation.

7. Configure whether or not to allow Web Proxy for RSS, Twitter, and other Web requests:
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a. Allow Web Proxy for RSS, Twitter, and Other Web Requests: Select this check box to
receive CSM RSS Feeds.

Note: CSM RSS Feeds allow Customers of an RSS reader to subscribe to CSM data
(such as newly created Incidents) based on a Search Group or other criteria. Note that
for RSS Feeds to operate, the Cherwell Web Service must be installed. RSS Feeds
are disabled in the Browser Application settings in CSM Administrator.

8. Clear the Local Metric Cache: Click this button to clear all the Metric values that are stored on your
local machine.

9. Click OK.9. 
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Define Personal User Information
Use the User Information page in the CSM Options window to configure User Login Credentials,
Authentication options, and User details.

To configure User Information settings:

1. From the menu bar, select Tools>Options.

2. Click the User Info page.

3. View or change the information for the current User.

4. Click OK.4. 
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Configure User E-mail Settings
Use the E-mail page in the CSM Options window to configure the following User e-mail settings:

• Adding a new e-mail account.

• Editing or copying an existing account.

• Deleting an account.

• Designating an account as the default account for sending e-mails from within CSM.

• Finding dependencies.

To configure User e-mail settings:

1. From the menu bar, select Tools>Options.

2. Click the E-mail page.

3. Configure a personal e-mail account or customize a Global e-mail account:
◦ Add button: Click to configure a new personal e-mail account (POP, IMAP, or Exchange).

◦ Edit button: Click to edit the settings for an existing account.

◦ Delete button: Click to delete an existing account.

◦ Revert: Click to remove your personal settings and revert to the default settings for a global e-
mail account.

◦ Copy: Click to copy the settings for an existing account, and then edit the settings as
necessary.

4. Define e-mail account settings:
a. Define personal POP or IMAP Account settings.

b. Define personal Microsoft Exchange Account settings.

5. Spell check e-mail: Select this check box to have CSM spell-check e-mails before they are sent.

6. Make default account: Makes the selected account the default account for sending e-mails within
CSM.

7. Find dependencies: Displays other CSM Items using the selected e-mail account (example: An E-
mail and Event Monitor).

8. Click OK.8. 

Note: For more information about e-mail accounts and how to use e-mail in CSM, refer to
the E-mail documentation.
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Configure User Cherwell Mobile Settings
Use the Default Mobile Access window (accessed from the Dashboards & Calendars page in the CSM
Desktop Client Options window) to configure how Cherwell Mobile looks and behaves on your personal
mobile device. You can configure which:

• Mobile Home Dashboard to display by default.

• Mobile Alert Dashboard to display by default.

• Business Objects to make available. Associated Search Groups will also be available.

• Actions/One-Step Actions to make available for each Business Object.

Good to know:

• Users must have Cherwell Mobile security rights to configure User Cherwell Mobile settings.

To configure User Cherwell Mobile settings:

1. From the CSM Desktop Client toolbar, click Tools>Options.

2. Click the Dashboards and Calendars page.
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3. Select the Customize Mobile Settings check box.

Note: If you do not have rights, this check box does not show up in the window. If you clear
this check box, the Cherwell Mobile settings revert to the Global or Role default.
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4. Select default Mobile Dashboards (Home and Alert)

Tip: If you do not want to display any Dashboards, remove the Dashboard item from the List of
Objects to Display on Mobile Device list.

a. Home Page: Select a default Mobile Home Dashboard.
◦ Click the drop-down to select from a list of recently used Mobile Dashboards.

◦ Click the Mobile Dashboard button  to open the Mobile Dashboard Manager, and
then select an existing Mobile Dashboard or create a new Mobile Dashboard.

b. Alerts Page: Select a default Mobile Alert Dashboard.
◦ Click the drop-down to select from a list of recently used Mobile Dashboards

◦ Click the Mobile Dashboard button  to open the Mobile Dashboard Manager,and
then select an existing Mobile Alert Dashboard or create a new Mobile Alert Dashboard..

5. Select the Business Objects to make available in Cherwell Mobile:

Note: In order for a Business Object to be available, it must have the Show in Search
Manager property set (in the Business Object properties within a Blueprint).

a. Override List of Objects to Display on Mobile Device: Select this check box to override the
current default list of available Business Objects (Global or Role, set in CSM Administrator).

b. Click Add, and then select the Business Object to make available on mobile devices.

Tip: Click Edit to edit a selected item. Click Remove to remove the selected item from the list.
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c. Define how to display the Business Object in Cherwell Mobile:
◦ Custom Name: Provide a display name to use in Cherwell Mobile. If this is left blank,

the Business Object name will be displayed.

◦ Custom Image:

Click the Image button to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

If you do not select an image (None), the default image for the Business Object is
displayed.

Android: Android devices use standard color images. For the best results, use the
images in the BusObs>32x32 folder in the Image Manager. If you are setting up a mobile
configuration for use on both Android™ and iOS® devices, use the iOS-specific images.
They are automatically mapped to equivalent standard images for non-iOS® devices.

d. Select the Actions/One-Step Actions to make available in Cherwell Mobile:
i. Click Add to add a new Action/One-Step Action to the list.

Tip: Click Edit to edit a selected item. Click Remove to remove the selected item from

the list. Use the Up/Down arrows   to change the order of the Actions/One-Step
Actions when displayed in Cherwell Mobile (ex: In the Actions list).

ii. Define additional options for the list of Actions.
◦ Also Show Default Business Object Actions: Select this check box to make

available any default Actions for the Business Object. This option is only available if
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the Business Object has default Actions available (ex: Approvals have built-in
functionality to approve, deny, and abstain).

◦ Also Show Role Actions: Select this check box to make available any Actions that
were configured for the Business Object as part of the User’s default Role settings.
If no defaults were configured for the Role, then Global defaults are used.

6. Configure the order of the Actions when displayed in Cherwell Mobile (ex: On the Actions popup
list):

a. Use the Up/Down arrows   to order the Actions.

Note: You can change the order for all custom Actions/One-Step Actions, but you
cannot change the order of the Barcode scan, camera, and Location Awareness
Actions/One-Step Actions.

7. Click OK.7. 
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Display/Hide a Toolbar or Pane
The CSM toolbars and Knowledge Pane can be displayed or hidden.

To display/hide a toolbar or pane:

1. Right-click anywhere on a CSM menu bar, toolbar, or pane.

A drop-down appears, listing the items that can be displayed/hidden. Currently displayed items have
a check next to them.

2. Select an item to display it. Clear a checked item to hide it.
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Pin/Collapse a Pane
The Task Pane and Knowledge pane can be temporarily viewed, or permanently pinned in the CSM Main
window.

To pin/collapse a pane:

• Click the Pin button  in the upper right corner of a pane to collapse it. The pane displays as a tab
on the left side of the CSM Main window.

• Click the tab to temporarily view a collapsed pane. The pane displays until the cursor is removed
from inside the pane.

• Click the horizontal Pin icon  to permanently display the pane.
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Move/Dock a Pane
The Task Pane and Knowledge Pane can be moved anywhere within the CSM Main window or docked to
their default locations.

To move a pane:

1. Click the banner title until a Four-Arrow Plus Sign  appears.

2. Drag the pane to any location in the CSM Main window. After the pane is removed from the original
location, it becomes a small window that can be resized.

The following image shows the Task Pane moved into the Main Pane.

Tip: To dock the pane back to its default location, double-click the banner title.
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Move/Dock a Toolbar

Use the Grab bars  on a CSM toolbar to move, dock, and re-dock a toolbar.

To move a toolbar within the menu bar and toolbar area:

1. There are two ways to move a toolbar:

◦ Double-click the Grab bar  on the left side of the toolbar, and then drag the toolbar to a new
location within the toolbar area.

Note: If the toolbar is moved from the toolbar area, it becomes an independent window that
can be resized.

◦ Click the Grab bar until the Four-Arrow Plus Sign  appears, and then drag the toolbar to
a new location within the toolbar area.

The following figure shows the Navigation toolbar moved to the line below where it was initially
pinned.

2. Let go of the cursor to dock the toolbar.

To move a toolbar outside the menu bar and toolbar area:

1. There are two ways to move a toolbar:

◦ Double-click the Grab bar  on the left side of the toolbar, and then drag the toolbar to a new
location in the CSM window.

Note: If the toolbar is moved from the toolbar area, it becomes an independent window that
can be resized.

◦ Click the Grab bar until the Four-Arrow Plus Sign  appears, and then drag the toolbar to
a new location within the CSM window.

The following figure shows the Navigation toolbar moved to the Main pane.

Tip: Double-click the header banner of an undocked toolbar to re-dock the toolbar back to its
default location.

CSM 9.4.0 Client Suite 53

CSM 9.4.0 Client Suite



Create a User Toolbar
Create one or more personal toolbars (called a User toolbar) to initiate important Actions. For example,
create a User toolbar to:

• Run a One-Step Action.

• Run a command (Zoom, Attach, Undo, etc.).

• Display a Dashboard, Calendar, or Visualization.

• Run a Report or Search Group.

A User toolbar displays with the other CSM toolbars in the CSM Main window.

To create a User toolbar:

1. Right-click anywhere in the CSM toolbar area, and then select Customize.

The toolbars for User window opens.

2. Click the Add button.

The New Toolbar window opens, listing Actions that are applicable for a toolbar.

3. Click the Add Action button , and then select the type of Action to add to the toolbar (ex: Add
Command Action).

A CSM Item Manager opens (varies by type of Action selected in the previous step) to select/create
the CSM Item to initiate through the Action.

4. Select a CSM Item (ex: a specific Dashboard).

5. Define properties for a new Action:
a. Action: Displays the name of the Action as it is recognized by CSM (ex: Name of the

Dashboard or Report). It is recommended that you do not change this.

b. Display text: Type the text to display on the toolbar button if the "Show text on button check
box" (below) is checked.

c. Image button:

Click the Image button to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

d. Help text: Type a tooltip to display when the cursor is on the menu item.

e. Begin group: Select this check box to display a horizontal line before the menu item,
separating it from other menu items.

f. Show text on button: Select this check box to display the Display Text on the toolbar button.

6. Add additional actions to the toolbar.

7. Click OK.7. 
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Keyboard Shortcuts

Key Action

F1 Help

F2 Rename current item

F3 Show the legal values for a Field

F4 Heads Up Display

F5 Refresh

F6 Displays the current User's information

F7 Displays the current User's configuration items

F8 Zooms the current Field (if a large text Field)

F10 Select Menu

CTRL+C Copy current text to the clipboard

CTRL+D
Switch to the preferred culture.

This option is only available when Globalization is enabled.

CTRL+K Paste the text from the current Field into Knowledge Search pane

CTRL+P
Switch to the last culture you selected.

This option is only available when Globalization is enabled.

CTRL+S Save the current record

CTRL+T Toggle between form and list views

CTRL+V Paste text from the clipboard

CTRL+W
Switch between the preferred culture and the last selected culture.

This option is only available when Globalization is enabled.

CTRL+X Cut current text to the clipboard

CTRL+Y Redo last operation that was undone

CTRL+Z Undo last operation

ALT+DOWN ARROW
Drop-down a combo-box

Move down in a list of records
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Key Action

ALT+LEFT ARROW Move back to previous location

ALT+RIGHT ARROW Move forward

ALT+F1–F8 Select tab in the current Form Arrangement

CTRL+F4 Go to Home Page

CTRL+F5
Displays Self-Service settings (Self-Service setup must be configured on your
machine and you must be on a customer type that is set up to be exposed via
Self-Service)

CTRL+SCROLL Zoom in/out in Editors

CTRL+SHIFT+E Email current customer

CTRL+SHIFT+K Paste the text from the current Field into Knowledge Search pane and searches

SHIFT+DRAG Ignore snapping in an Editor

Defined in our database, but can be changed by the User:

CTRL+SHIFT+I New Incident

SHIFT+ALT+C Go to Quick Search for Customer
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CSM Web Applications
CSM includes two web applications: the CSM Browser Client and the Customer Portal.
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Browser Client
The CSM Browser Client is a web application that enables Users to access most of the features available
from the CSM Windows-based Desktop Client using a browser. The CSM Browser Client supports most
major modern browsers on desktop machines and tablets.
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About the CSM Browser Client
CSM Browser Client features include:

• Record Logging: Log and manage records (Incident, Problem, Change, Customer, etc.).

• Searching: Run Quick Searches or Search Groups (saved searches) to efficiently and thoroughly
search/filter CSM data, locating one record or a set of records.

• One-Step Actions: Run One-Step Actions to initiate one or more defined Actions, automating
common or repetitive tasks.

• E-mail: Define and send messages to a single recipient or a group of recipients using
comprehensive e-mail functionality.

• Dashboards and Widgets: Use Dashboards to view critical metrics, analyze and predict trends, drill
down into data, execute Actions, or display a collection of information that might be relevant to a
group of Users/Customers.

• Reporting: Use a host of powerful reporting tools (defined Reports and report writing tools, Search
Groups, Dashboards/Widgets, and Visualizations) to gather and measure data, analyze metrics, and
predict trends.

• Visualizations: View Visualizations to see the relationships between records in a variety of layouts.

• Calendars: View Calendars to keep track of ongoing or upcoming tasks.

• Tools: Access the Contact Manager, Table Management, and CMDB.

• Additional Features: Access HTML Pages, Knowledge Articles, and Queues.
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The main Business Objects available in the Desktop Client are also available in the Browser Client. The
majority of the differences in functionality are in configuring and administrative functions within the
Browser Client. The configurations and settings for the Browser Client are determined in the CSM
Desktop Client and CSM Administrator. Many functions behave differently in the Browser Client than they
do in the Desktop Client. To see the differences in functionality between the Browser Client and the
Desktop Client, see Browser Client Features.

Before Users can access the Browser Client, it must be configured by a system administrator.
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Tour the Browser Client User Interface (UI)
The Browser Client User Interface (UI) provides efficient access to CSM. The main window displays the
following items:

• Account information

• Menu bar

• Toolbar

• Main Pane

• Search Control

Each User has a personal interface that is controlled by login Role and security rights. For example, the
default Dashboard (displayed in the main pane upon log in or by clicking the Home button) might display
real-time Incidents, Twitter Feeds, or metrics for a Team.

The Browser Client menu bar collapses into a hamburger menu on mobile screens and browser windows
sized below 768 pixels. It cannot be configured, but the CSM Items accessed from the menu bar are
driven by configurations and personal settings in the Desktop Client. For example, a Search Group can be
created and saved in the Desktop Client and then used in the Browser Client by using the Browser Client
Managers.

Note: The Navigation toolbar opens when a record is active in the main pane.
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Browser Client Main Window
The Browser Client main window is simplified compared to the dynamic capabilities of the CSM Desktop
Client, but the look-and-feel is similar.

1. Account Information: Displays login and User/company information.

2. Menu bar: Displays drop-down menus for features and functions within the Browser Client. The
Browser Client menu bar collapses into a hamburger menu on mobile screens and browser windows
sized below 768 pixels.

3. Search Control: Allows Users to run Quick Searches and specific record Searches.

4. Toolbar: Displays available actions and operations within the main pane and within records.

5. Main pane: Displays Dashboards, records, Reports, and Search Results.

Browser Client Item Managers are opened from the menu bar. To open a Manager, click the desired
menu (example: Dashboards) and then select [Item] Manager.
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Browser Client Account Information
Options in the Browser Client account information section are described below.

Table 1. User Information

Action Description

Languages Allows Users to switch cultures to change the language for platform
and content strings.

My Profile
Allows Users to view their personal information (Contact information,
manager information, etc.). The form is populated using information
from the User Profile.

Logout Logs the User out of the current session.

Table 2. Company Information

Action Description

Report Error
Allows Users to submit information about an error they receive while
working in Cherwell Service Management to the Cherwell Software
Support Team.

(719) 386-7000 Cherwell Software company phone number.

<Version Number> Current version of Cherwell Service Management.

<Environment Type> Environment Current system environment (Development, Production, or Test). If an
environment is not selected, the text does not display.

Cherwell Copyright © 2006-2018
Cherwell Software, LLC. Cherwell Service Management copyright information.

Table 3. Help Icon

Action Description

Help Icon Allows Users to access a defined Help System/site. For information on
configuring a Help site, see Configure Global Help Settings.
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Browser Client Menu Bar
Options in the Browser Client menu bar are described below.

Table 1. Home

Action Description

Home Opens the default home Dashboard.

Table 2. New

Action Description

New Creates a new record (example: New Config - Mobile Device).

Table 3. Searches

Action Description

Search Manager Opens the Search Group Manager, where you can run saved
searches (Search Groups).

Quick Search Builder Opens the Quick Search Builder, where you can create a Quick
Search.

Queues Opens the Queues menu, including the Queue Manager and Most
Recently Used (MRU) Queues.

Table 4. One-Steps

Action Description

One-Step Manager Opens the One-Step Action Manager, where you can run One-Step
Actions.

Recent Unassociated One-Steps Runs the Most Recently Used (MRU) One-Step Actions.

Table 5. E-mail

Action Description

Send E-mail

Opens the E-mail Message window to create and send e-mails directly
from the CSM Browser Client.

Note: An e-mail account must first be set up and given
security rights in order to send an e-mail. See Send an E-mail
from Within CSM.

E-mail Current Customer

Opens the E-mail Message window to create and send e-mails to a
Customer's e-mail address from your current page (An Incident record,
Problem record, etc.). The To line is automatically populated with this
address, and an error will open if there is no active Customer on the
record.
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Table 6. Dashboards

Action Description

Home Directs you back to the default Home Dashboard.

Dashboard Manager Opens the Dashboard Manager, where you can view Dashboards.

MRU Lists the Most Recently Used (MRU) Dashboards.

Table 7. Pages

Action Description

Pages Manager Opens the HTML Page Manager, where you can view HTML Pages.

MRU Lists the Most Recently Used (MRU) Pages.

Table 8. Reports

Action Description

Report Manager Opens the Report Manager, where you can run Reports.

MRU Lists the Most Recently Used (MRU) Reports.

Table 9. Visualizations

Action Description

Visualization Manager Opens the Visualization Manager, where you can run Visualizations.

Config Visualization Opens the Configuration Map Visualization.

MRU Lists the Most Recently Used (MRU) Visualizations.

Table 10. Calendars

Action Description

Calendar Manager Opens the Calendar Manager, where you can run Calendars.

Main Calendar

Opens the Main Calendar.

Note: This is configured in CSM Administrator. For more
information, refer to the Calendars documentation.

MRU Lists the Most Recently Used (MRU) Calendars.

Table 11. Tools

Action Description

Contact Manager Opens the Contact Manager, where you can view and manage
Customer Records.

Table Management Opens the Table Management interface, where you can manage
Lookup Table values.
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Action Description

CMDB Opens the CMDB interface, where you can manage Configuration
Items (CIs).

Note: The Browser Client menu bar collapses into a hamburger menu on mobile screens and
browser windows sized below 768 pixels.
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Browser Client Search Control
Options in the Browser Client Search Control are described below.

Table 1. Search Control

Item Description

Quick Search drop-down

Allows Users to select the type of Search:

• Quick Search: Searches all records that contain a specific word or
phrase (example: Find all records that contain the word "printer").

• Specific Search: Searches only records of a particular type
(example: Find all Incidents that contain the word "printer").

Search field

Displays the word or phrase to be searched. The drop-down displays
the most recently used (MRU) searches.
The Search field supports:

• AND (all words) logic or the OR (any word) logic. System
administrators define the default.

• Wildcards (*, %) can be used.

Search options (wrench icon)

Displays advanced search options for a specific record type (ex:
Incident).

Note: Advanced options are not available for Quick Searches;
a specific record type must be selected before the options
become visible. The search options for each record type are
configured by a system administrator.

Search (magnifying glass icon)

Runs the search. If results are the same type (example: Results are only
Incidents), the results are displayed in the Grid. If results are different
types (example: Results are Incidents and Problems), the results are
displayed in a list.
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Browser Client Toolbars
Options for the Browser Client toolbars are described below.

Table 1. Dashboard Theme Toolbar

Button Action Description

Select a Theme Applies a new Theme to the current
Dashboard.

Refresh the Dashboard Refreshes the current Dashboard.

Table 2. Record Toolbar

Button Action Description

Save Saves changes in the active window.

Abandon Abandons changes to the current item.

Refresh Refreshes the data of the current item.

Delete Deletes the current selection.

Legal values Displays a list of legal values (for lookup
fields only).

Attach Import a file attachment.

Search Knowledge Search for Knowledge sources related to
the current record (example: Incident).

Go to first record Navigate to the first record.

Go to previous record Navigate to the previous record.

Go to next record Navigate to the next record.

Go to last record Navigate to the last record.
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Button Action Description

Add to Queue Add the record to a Queue.
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Browser Client Main Pane
The Browser Client main pane is located in the center of the CSM main window and displays content
relevant to the current operation. When you log in, the main pane displays the Home Dashboard.
Depending on the operation, the main pane can also display the following:

• Records (Incident, Problem, Knowledge Article, etc.).

• Search Results (Quick Search, Knowledge Article Search, etc.).

• Reports, Calendars, Visualizations, Grids, and more.
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Browser Client Managers
CSM Item Managers help manage CSM items (Dashboards, Search Groups, One-Step Actions, etc.). In
the Browser Client Managers, Users can:

• Run/Display: Runs/displays the selected item (example: Run a Search Group, One-Step™ Action,
or Report; display a Dashboard).

• Filter (Association or Status): Filters items by record type (Incident, Problem, Change, etc.) or Status
(for the Queue Manager).

Note: Filtering by record type is only available in the Search Group, One-Step™ Action,
Dashboard, and Report Managers.

• View: View a list of available items in either List view or Icon view.

To open Managers in the CSM Browser Client:

1. From the Browser Client menu bar, click the desired menu (example: Dashboards), and then click
the [Item] Manager.

Rather than utilizing the folder structure of the CSM Desktop Client and Administrator Managers, Browser
Client Managers use tabs to navigate the areas where CSM items are located within the Manager. The
tabs correspond to folders in the Desktop Client and contain the same CSM items. Clicking a tab takes
you to the items located in that file. Clicking an Item's Home takes you to the base file structure (example:
Dashboards>Pinboard, User, Role, Team, Global).
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Browser Client Features
The CSM Browser Client has been designed to support many features. Use the table below for details on
the available functionality.

Features Supported in the Browser Client

Feature Supported Notes

Actions Yes Run only.

Attachments Yes Import and view file attachments only.

Automation Processes Yes Run only.

Blueprints No CSM Administrator only.

Business Hours Yes View only.

Business Objects Yes View, create, edit, and delete Business Object records, but not
the Business Objects themselves.

Calendars Yes View only.

Contact Manager Yes View and export.

Counters Yes View only.

Dashboards Yes View only.

Definition Editor No  

E-mail Yes Send e-mail. Configuration must be done in CSM Administrator.

Expressions Yes View only.

Forms Yes Users can work in Forms but Forms cannot be created or deleted.

Grids Yes  

HTML Pages Yes View only.

Knowledge Yes Search and create Knowledge Articles. Use internal Knowledge
sources for record resolution.

Metrics Yes View only.

One-Step Actions Yes Run only.

Prompts Yes Run or use for Quick Searches.

Queues Yes View only.

Record Locking Yes  

Reports Yes Run only.

Rich Text Yes  

Searching Yes Run, create, edit, and delete with security rights.
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Feature Supported Notes

System Analyzer No  

Table Management Yes View and export.

Themes Yes Run only.

Visualizations Yes View only.

Widgets Yes View and drill-down only.
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Browser Client Forms
Forms are supported in the CSM Browser Client. In addition to records, forms contain a Form
Arrangement area (as they do in the CSM Desktop Client). The Form Arrangement contains child objects
and supporting tabs (Journal, Queues, Tasks, etc.). Use form splitters and the Text Editor to enhance the
way you work with forms.

Using forms in the Browser Client, you can:

• View existing records.

• Log a record.

• View child objects for records in the Form Arrangement.

Forms are accessed using the New drop-down on the Browser Client menu bar to log a new record or by
drilling down into a Widget and then opening an existing record via a Grid.
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Browser Client Form Splitters
In the Browser Client, Forms contain splitters that help Users resize the Form Arrangement using both
horizontal and vertical splitters.

Good to know:

• In an open record, the horizontal splitter above the Form Arrangement (child object tabs) adjusts the
overall height of the Form Arrangement. The vertical splitter in the middle of the Form Arrangement
adjusts the overall width of the Form Arrangement if the tab features more than one section.

• Adjust the Form Arrangement by clicking anywhere on the splitters except for the Show/Hide Form
Arrangement arrows and the Show/Hide Child Object Details arrows.

There are several buttons and icons featured in the Browser Client splitters.

Button/Icon Action Description

Show Form Arrangement Shows a currently hidden Form Arrangement.

Or

Separators Indicate that the splitter bars can be dragged-and-dropped
where needed.

Hide Form Arrangement Hides a currently visible Form Arrangement.

Show Child Object Details Shows the child object, including details or additional
Forms.

Hide Child Object Details Hides the child object details or additional Forms so only the
child object Grid is visible.

To show or hide the Form Arrangement:

• Click the Show Form Arrangement arrows to show a currently hidden Form Arrangement.

To expand the Form Arrangement so that it fills the full area of the record, click the Show
Form Arrangement arrows a second time.

• Click the Hide Form Arrangement arrows to hide a currently displayed Form Arrangement.

To hide the Form Arrangement after expanding it to fill the entire area of the record, click the
Hide Form Arrangement arrows twice: once to return the Form Arrangement to its original
size, and then again to hide it completely.
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To adjust the overall height of the Form Arrangement:

• Click and hold the horizontal splitter above the Form Arrangement. and then move the
horizontal splitter up or down until the Form Arrangement is the desired height.

To show or hide a child object's details or additional Forms:

• Click the Show Child Object Details arrows to show both the child object (example: Task) and
its additional details or Forms (example: Task form).

To expand the child object's additional details or Forms on the right-hand side of the Form
Arrangement space, click the Show Child Object Details arrows a second time.

• Click the Hide Child Object Details arrows to hide the additional details or Forms.

To hide the additional details or Forms after expanding them to fill the entire area of the Form
Arrangement, click the Hide Child Object Details arrows twice: once to return it to its original
size, and then again to hide it completely and only display the child object's Grid.

To adjust the overall width of the child objects and their details or additional forms:

• Click and hold the vertical splitter in the middle of the Form Arrangement and then move the
vertical splitter left or right until the child object and its details are the desired width.
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Browser Client Rich Text Editor

The Rich Text Editor can be opened by clicking the Text Editor button  in a field on a form in the
Browser Client.

Using the Text Editor, you can import an image, insert a hyperlink, and edit text in the field using
properties such as paragraph styling, font, and background color.
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Browser Client Grids
Grids in the Browser Client and Portal look very similar to Desktop Client Grids, except that Export, Run
Action, and Add/Remove Grid column options are available on a Grid toolbar rather than from a context
menu or menu bar. Grid grouping is not currently available.

View a Grid using one of the following features:

• Search Results: List of records located through a Quick Search or Search Group.

• Search Results List Widget: List of results on a Dashboard.

• Form Arrangement: List of related records on a tab.

• Contact Manager: List of Customer records.

• CMDB interface: List of Configuration Item records.

• Table Management interface: List of Lookup values.

• CSM Item Managers: List of CSM Items (Dashboards, One-Step Actions, etc.).

1. Grid menu bar: Displays actions available for the Grid, including navigation, Actions, and available
columns.

2. Title: Displays the title of the Grid. This might or might not match the name of the Business Object
that the Grid represents. Also, a Business Object might have multiple Grids, so each might have its
own name.

3. Sizing handles: Allow you to drag the column to the width you want.

4. Sort icon: Indicates the column currently sorting the Grid and if it is in ascending or descending
order ( ). Click the icon to toggle sorting. By default, the Browser Client sorts Grids using single-
column sorting. To sort the Grid using multiple columns, click the Multi-Column Sorting button in the
Grid menu bar.
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5. Filter icon: Indicates the column data can be filtered. Click the icon to show filtering options
(possible filter values appear in the column's Filter drop-down).

6. Grid item: Each item within a Grid contains its own line of information. Clicking the item opens the
record in the Main Pane.

7. Images: Expression-driven images can be used to indicate a condition has been met (example:
Display breached SLAs with an Alarm Clock image). Grid rows also support expression-driven
colors.

There are several actions available when working with Grids in the Browser Client:

Grid
Capability Description

Export

Export a Grid to use CSM data in other applications for reporting or display purposes.
For example, export a list of Customers to a .csv file so you can use a spreadsheet tool
to manage a mass mail communication. You can export to CSV (.csv) and Excel (.xlsx)
formats.

Run an
Action

Run a defined Business Object context menu Action directly from a Business Object
Grid (record Grid) to quickly initiate common operations. Context Menu Actions are
defined as part of a Business Object's definition.

Sort

Sort a Grid in alphabetical or numerical order, in ascending (1-10 or A-Z) or descending
order (10-1 or Z-A).

Grids in the Browser Client can also be sorted using single-column sorting (the default
setting for Browser Client Grids) or multi-column sorting, allowing Users to sort the Grid
using multiple columns at a time.

Filter

Filter a Grid by a column value so that the Grid shows only the data you want (example:
Show only New Incidents). To show even more specific data, multi-filter a Grid, either
by using multiple values in a single column (example: Show Incidents with a status of
Assigned, In Progress, or Pending) or by using multiple column values (example: Filter
by owner, and then by status).

Size Size a Grid column to a specific width to see as much or as little data as you want.

Move/reorder Rearrange a Grid by moving (reordering) a Grid column to a different location in a Grid.

Add/remove
columns

Business Object Grids are created and managed by a system administrator in CSM
Administrator; however, you can add and remove columns (Fields) from your instance
of the Grid to display only Fields that are important to you (example: Add the Owned By
field to the Incident grid to view record owners). If configured, you can also add Fields
from other Business Object.

For more information on Grid function in the Browser Client, see Browser Client Grid Functions.
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Browser Client Grid Functions
When working with Browser Client Grids, you can:

• View a Grid.

• Filter a Grid.

• Run an Action from a Grid.

• Add/Remove a Grid column.

Good to know:

• Exportable Fields are organized by category; uncategorized Fields are listed at the top, and are
likely listed in the menu. Relationships Fields are listed below the Relationship node (example:
Incident Links Problem Fields).

• If a column has a filter applied to it, the Filter icon will have a highlighted square around it to indicate
that a filter has been applied.

• Grid changes are remembered until the Grid is reset in the CSM Desktop Client or Administrator, the
settings are cleared (Tools>Options>General>Restore all Customized Grids to the Admin Defaults,
or File>Clear Settings in the Role or User Manager), or a new System Grid definition is
automatically pushed out. If a new System Grid definition is pushed out, a Personal Grid definition
can be reverted manually but the changes in the new definition will be lost. For detailed information,
refer to Grid Persistence.

To view a Grid in the Browser Client:

1. A Grid can be viewed several ways:
◦ Search Results: List of records located through a Quick Search or Search Group.

◦ Search Results List Widget: List of results on a Dashboard.

◦ Form Arrangement: List of related records on a tab.

◦ Contact Manager: List of Customer records.

◦ CMDB interface: List of Configuration Item records.

◦ Table Management interface: List of Lookup values.

◦ CSM Item Managers: List of CSM Items (example: List of Dashboards in the Dashboard
Manager).

To run an Action from a Grid in the Browser Client or Portal:

1. In a Grid, select a record by selecting the radio button next to the row.

2. In the Actions drop-down, select an Action (example: Print).

To filter a Grid in the Browser Client or Portal:

1. In a Grid, click the Filter in the header of the column to filter.

2. Click in the Filter box to activate the drop-down.
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The drop-down shows filtering options. Options vary according to the type of data in the column
(example: Number, Text, etc.).

3. Select a filtering option and then click the Filter button.

4. (Optional) To continue filtering by another column, click the Filter icon over another column, and
then select another filtering option.

The Grid filters the data again and displays the filtered results.

Tip: To clear the filtering criteria, click the Filter icon on the filtered column, and then click the Clear
button in the Filter drop-down.

For more information on filtering Grids, refer to the Grids documentation.
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Browser Client Searches
Searches in the Browser Client behave very similarly to those in the Desktop Client. Search behaviors
include:

• Searches edited or saved in the Browser Client carry over to the Desktop Client. Depending on Role
and the scope (folder) of the Search, others may be able to see and use created Searches
(example: If you create an All Tasks Search and save it to the Team folder, only members of your
Team will have access the Search).

• Use the Search Manager to create, edit, and delete Search Groups (saved Searches) or use the
Quick Search Builder to create and run a one-time Search. Both are accessed via the Searches
drop-down on the menu bar.

• The Search Manager behaves differently in the Browser Client than it does in the CSM Desktop
Client. See Browser Client Managers for more information.

• Queues can be run from the Queue Manager in the Browser Client, but cannot be created, edited,
or deleted. The Queue Manager and MRU Queues are accessed via the Search drop-down on the
menu bar.

To run a Search:

1. From the Browser Client menu bar, click the Searches drop-down.

2. Select an option from the drop-down:
◦ Search Manager: Create and/or run a defined Search.

◦ Quick Search Builder: Create and run a Quick Search.

◦ Queues: Select and run a Queue from the Queue Manager.

The results display in the Main Pane.

If card view is enabled for a Business Object, Search results are displayed as medium or large
cards. To view a specific record in card view, select an item from the results list or the title link in a
card.
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In card view, you can access:

• Navigation: Use page numbers and arrow buttons that allow you to navigate between pages of
results.

• Side menu: Access options, such as showing the currently selected record or showing results in a
Grid view, sorting results by a Field in ascending or descending order, and changing card size.

Note: To ensure that card size selections persist and do not revert to the default, uninstall
WebDAV in IIS.

• Ellipses: Access a menu of actions available for the Business Object. Actions can be run directly
from the card view without drilling down into a record.

When viewing the Search results, more options become available in the Search menu drop-down that
allow Users to edit the current Search and save the current Search.
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Browser Client Quick Search Builder
The Browser Client Quick Search Builder is very similar in behavior to that of the Desktop Client Quick
Search Builder.

Searches saved in the Browser Client carry over to the Desktop Client. Depending on Role and the scope
of the search, others might be able to see and use created Searches (example: If you create an All Tasks
Search and save it to the Team folder, members of your Team will be able to access the All Tasks
Search).

CSM 9.4.0 Client Suite 86

CSM 9.4.0 Client Suite

https://help.cherwell.com/csh?topicname=quick_search_query_builder
https://help.cherwell.com/csh?topicname=quick_search_query_builder
https://help.cherwell.com/csh?topicname=about_roles
https://help.cherwell.com/csh?topicname=scope


Browser Client Queues
Access Queues from the Queues drop-down in the Searches menu or work with Queues from the
Business Object toolbar. Queues cannot be created or edited in the Browser Client and they can only be
viewed with the proper security rights and Role defined in CSM Administrator.

To open a Queue:

1. Click Queues in the Searches drop-down.

2. To find a Queue that is not listed in the Queues MRU menu, click Queue Manager.

Note: The Queue Manager behaves differently in the Browser Client than in the Desktop
Client. See Browser Client Managers for more information.

Queue results appear in the same list format as other Browser Search results.

To work with Queues:

1. Open a Business Object record.

2. On the Business Object toolbar, click the Queue drop-down.

If the record is not currently in a Queue, the only enabled button in the Queue Status drop-down is
Add to Queue.

3. Add a record to a Queue:
a. In the Queue drop-down, click Add to Queue.

b. From the Queue Manager, select a Queue (ex: Network Support).

The name of the Queue displays in the Queues section of the toolbar.

4. Check out/check in a record from the Queue:
a. In the Queue drop-down, click On <Name of Queue> Queue and select Check Out.
b. On the Queue Status toolbar, click Check Out.

When a record is checked out of the Queue, the record cannot be checked out by another
User until the User working with the record checks it in.

c. In the Queue drop-down, click On <Name of Queue> Queue and select Check In or Check
In and Remove (checks in the record and removes it from the Queue).

After the record is checked in, it can be checked out by another User.

5. Remove a record from a Queue:
a. In the Queue drop-down, click On <Name of Queue> Queue and then select Remove from

Queue.
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Browser Client One-Step Actions
Browser Client One-Step Actions look and behave similarly to One-Step Actions in the Desktop Client.

In the Browser Client, Users can run One-Step Actions from:

• The Browser Client menu bar (run from the One-Step Action Manager or the list of Most Recently
Used (MRU) One-Step Actions).

• Buttons, links, and Widgets on Dashboards.

• Business Object records (as buttons or links). Some One-Step Actions might also run as Automatic
Actions that are executed when a Business Object is saved.

• The One-Step Action Manager (accessed from the Browser Client menu bar).

• An Actions menu on a Grid.

Good to know:

• The One-Step Actions accessed and run in the Browser Client are created in the CSM Desktop
Client or in CSM Administrator. One-Step Actions cannot be created, edited, or deleted in the
Browser Client.

• When One-Step Actions execute in the Browser Client, the interface appears as disabled until the
One-Step Actions completes.

• Print Actions are not supported in the CSM Browser Client and Portal.

• When One-Step Actions that contain multiple Actions are executed in a CSM web application, the
end result of the One-Step Action is shown to Users when execution is complete. Users are
prompted for input as needed, but if the Save Business Object After Action check box is cleared
for a particular Action, changes made by the Action are not saved.

• There is currently no option in the Browser Client to run a One-Step Action for a group. You can,
however, configure a One-Step Action to run against a specific Search Group. In this case, the One-
Step Action runs against the defined group of records, regardless of the client used to run the One-
Step Action. For more information, see Define the Conditions for a One-Step Action.

• Write file, read file, run program, and transfer Attachments (to or from a file system) One-Step
Actions generally works for the CSM Browser Client, but the One-Step Action must be designed to
write an accessible file on the server, and then execute a program on the server using the contents
of that file. This requires configuring IIS security rights specifically to handle this capability.
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Browser Client E-mail
The Browser Client offers comprehensive e-mail functionality, including:

• Rich Text and plain text: Define messages using either multiple format options or a plain text
format. Rich Text supports drag-and-drop image upload functionality (including a thumbnail preview)
and the ability to insert a hyperlink with display text and a tool tip, if necessary.

• Attachments: Upload an associated file and add it directly to the e-mail.

• Importance: Indicate to the recipient that the e-mail is high priority.

• Address Book: Search, filter, and sort Customers, Users, Teams, and Workgroups and then add
them as recipients to the e-mail. Access the Address Book by clicking either the To or CC button.

• Recipient attachment options: Define which Customer records should include an attached e-mail
as a Journal - Mail History Record after the e-mail is sent.

Note: You must have the appropriate security rights to access various features and functionality.
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You can send an e-mail from the Browser Client multiple ways:

• Using the E-mail>Send E-mail option in the menu bar from anywhere in the Browser Client. You
select the recipients when using this option.

• Using the E-mail>Current Customer option in the menu bar when a Business Object record is
active.

• Clicking a Customer's e-mail address on a Business Object record.

Note: The Customer must have a defined e-mail address on record.

• Running a One-Step Action configured with an e-mail Action directly from the One-Step Action
Manager.

Note: E-mails are sent from a defined default account. If you have not configured e-mail for CSM,
refer to the e-mail accounts documentation for more information.
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Browser Client Dashboards
Browser Client Dashboards are very similar in appearance and functionality to Dashboards in the CSM
Desktop Client.

When working with Dashboards in the CSM Browser Client, Users can:

• View a Dashboard:
◦ View your default Home Dashboard by clicking the Home button on the Browser Client menu

bar.

◦ View all your Dashboards Using the Dashboard Manager (Dashboards>Dashboard Manager).

• Manually refresh a Dashboard.

• Select a User Theme on a Dashboard.

• Set the current Dashboard to be the default.

• Drill down into Dashboard data.

• Initiate a One-Step Action/Action from a Dashboard (example: Run a report, run a search, etc.).

Good to know:
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• Dashboards can be viewed and used in the Browser Client; however, Dashboards are managed
(created, edited, deleted, etc.) and configured (security rights and defaults) only in the CSM Desktop
Client and CSM Administrator.

• Browser Client Themes are accessed differently in the Browser Client than they are in the CSM
Desktop Client. See Browser Client Dashboard Functions for more information.

• Browser Client Widgets behave differently in the Browser Client than they do in the CSM Desktop
Client. See Browser Client Widgets for more information.

• The Dashboard Manager behaves differently in the Browser Client than it does in the CSM Desktop
Client. See Browser Client Managers for more information.

CSM 9.4.0 Client Suite 92

CSM 9.4.0 Client Suite



Browser Client Widgets
Widgets behave similarly in both the Browser and CSM Desktop Client. You can click a Widget to open
records, reports, tables, or graphs relevant to the Widget's statistics. However, you cannot create, edit, or
delete Widgets from the Browser Client.

he ability to refresh the Dashboard aids in generating new data more quickly in the Browser Client. The
ability to set the priority of Widgets for refresh helps see the selected data faster, allowing one Widget to
refresh before another in a decided order.
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Browser Client Dashboard Functions
With the CSM Browser Client Dashboard Functions, Users can change the Dashboard Theme and
refresh the Dashboard so your Browser Client Widgets display the latest data.

The Theme drop-down can change the Dashboard Theme. The Themes available in the drop-down are
the Most Recently Used (MRU) Theme. Access more Themes by clicking More to open the Theme
Manager. Refresh the Dashboard by clicking the Refresh button to the right of the Themes drop-down.

Note: The Dashboard refresh is separate from the web browser (example: Internet Explorer®,
Firefox®, Chrome™, or Safari®) refresh. The Dashboard refresh only applies to the Dashboard
and its Widgets, not the entire web browser.
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Browser Client HTML Pages
Browser Client HTML Pages are used to display an external website (via a link) and an internal website
(that you design and code).

In the Browser Client, HTML Pages functionality is accessed using the Pages drop-down on the Browser
Client menu bar. From the Pages drop-down, Users can access the HTML Manager and most recently
used (MRU) pages.

Good to know:

• HTML Pages can be viewed and used in the Browser Client; however, HTML Pages are managed
(created, edited, deleted, etc.) and configured (security rights) only in the CSM Desktop Client and
CSM Administrator.

• The HTML Manager behaves differently in the Browser Client than it does in the CSM Desktop
Client. See Browser Client Managers for more information.
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Browser Client Reports
Browser Client Reports look and behave similarly to Reports in the Desktop Client. Reports can be
viewed and used in the Browser Client; however, Reports are managed (created, edited, deleted, etc.)
and configured in the CSM Desktop Client and CSM Administrator.

Reports can be run from:

• The Browser Client menu bar (run from the Report Manager or the list of Most Recently Used
(MRU) Reports).

• The Report Manager (accessed from the Browser Client menu bar).

• Specific links and Widgets on a Dashboard.

The Report Manager behaves differently in the Browser Client than it does in the CSM Desktop Client.
See Browser Client Managers for more information.
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Browser Client Visualizations
Browser Client Visualizations look and behave similarly to Visualizations in the Desktop Client. You can
view all your Visualizations using the Visualization Manager (Visualizations>Visualization Manager) or
view a record's Visualizations by clicking the Visualization icon (example: View impacted CIs on an
Incident Record).

In the Browser Client, Visualization functionality is accessed using the Visualizations drop-down menu on
the Browser Client menu bar. From the Visualizations drop-down, Users can access the Visualizations
Manager and configure Visualizations.

Good to know:

• Visualizations can be viewed and used in the Browser Client; however, Visualizations are managed
(created, edited, deleted, etc.) and configured (security rights and defaults) only in the CSM Desktop
Client and CSM Administrator.

• The Browser Client Visualization window provides much of the same functionality as the Desktop
Visualization window and includes the toolbar, Main pane, Aerial pane, and Legend; however, the
Browser Client Visualization window does not include a menu bar.

• The Visualization Manager behaves differently in the Browser Client than it does in the CSM
Desktop Client. See Browser Client Managers for more information.
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Browser Client Calendars
The CSM Browser Client has Calendar capabilities that are nearly in parity with the Calendars in the
Desktop Client. While there are some layout differences between the two (example: The three month
navigator is located to the left of the main Calendar pane in the Browser Client), the Browser Client
Calendar appears very similar to the Calendar in the CSM Desktop Client.

You can view the default Calendar by selecting a Calendar from the Calendars drop-down or view other
Calendars using the Calendar Manager (Calendars>Calendar Manager).

From the Calendars drop-down on the Browser Client menu bar, Users can access the default Calendar,
the Calendar Manager, and most recently used (MRU) Calendars.

Good to know:

• Calendars can be viewed and used in the Browser Client; however, Calendars are managed
(created, edited, deleted, etc.) and configured (security rights and defaults) only in the CSM Desktop
Client and CSM Administrator.

• The Calendar Manager behaves differently in the Browser Client than it does in the CSM Desktop
Client. See Browser Client Managers for more information.
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Browser Client Knowledge
Browser Client Knowledge functionality is limited to Knowledge Articles. Users can create Knowledge
Articles, search for Knowledge Articles, and use internal Knowledge sources to solve issues.

Managing and mapping Knowledge is currently unavailable in the CSM Browser Client.
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Browser Client Search for Knowledge from a
Record

Users can search Knowledge Articles from an open record and place found solutions within the record for
future reference.

To search for Knowledge from an open record:

1. Open the record for which you want to find a solution.

2. Click the Knowledge button on the toolbar.

3. Select the Source of the Knowledge Article (Known Errors, Open Incidents, Knowledge Articles, or
Attachments).

Note: These are internal sources for the Browser Client, meaning the search is limited to
Knowledge Articles within the system, whereas the Desktop Client can search outside
sources such as Google or Yahoo.

4. Specify a word or phrase to search.

Tip: Use terminology from the record in your search.

5. Click Search.

6. Select a Knowledge Article to view.

7. Click the Use Solution button to place the Knowledge Article information into the record.
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Browser Client Contact Manager, Table
Management, and CMDB

The Browser Client provides access to the following CSM tools:

• Contact Manager: Use this tool to view Customer records.

• Table Management interface: Use this tool to view Lookup Object values.

• CMDB interface: Use this tool to view Configuration Item (CI) records.

In the Browser Client, Tools are accessed using the Tools drop-down or from Related Item Pickers on
Business Object records.

Related Item Pickers are configurable, can be added to any Form, and include:

• The Customer Selector that provides access to the:
◦ Contact Manager to quickly log who initiated a record.

◦ Customer Record to quickly view detailed information about the Customer.

• The CMDB Selector that provides access to the:
◦ CI database to quickly log the affected asset.

◦ CI Record to quickly view detailed information about the affected asset.

Good to know:

• Lookup Object values can be viewed and used in the Browser Client; however, values are managed
(created, edited, deleted, etc.) and configured only in the CSM Desktop Client.

• Customer records and CI records can be viewed in their respective interfaces; however, records are
created and deleted using the options on the Browser Client menu bar.

• The Contact Manager, Table Management interface, and CMDB interface utilize a Grid interface.
Use the Grid capabilities (example: Print, export, run an Action, sort, filter, size, move/reorder, and
add/remove columns) to display only the data you want and in a way that is meaningful to you.
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Browser Client Good to Know
• The CSM Browser Client consumes a CSM license. Licensing controls how many Users can log into

CSM. CSM uses a concurrent or "floating" licensing model. This means that a fixed number of
licenses are shared among a group of Users/Customers, and that a fixed number of people can
simultaneously access the product. License codes determine the number of people who can log in
at any given time.

• Some features behave differently in the Browser Client than they do in the Desktop Client. See
Browser Client Features for more information.

• Browser Client Knowledge supports Knowledge Articles, Search, and Sources. However, Search
and Sources are limited to internal sources only for the Browser Client.

• While Dashboards cannot be created or edited in the Browser Client, they can be viewed and
Widgets can be drilled into to pull up Reports or metrics related to it. Browser Client Dashboards
reflect personal settings made in the Desktop Client and in CSM Administrator.

• Some Forms have a special browser view. This means some information in a Form is displayed
(such as client name), while other sensitive or secure information (such as social security number) is
blocked out. While this is predominantly the case with the CSM Portal and Mobile Clients, the
Browser Client can be configured to do this through the CSM Administrator.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For more
information, see Configure Browser and Mobile Device Security Rights.
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Using the Browser Client
When working with the Browser Client, you can:

• Log in to the Browser Client.

• Log a record.

• View and run Searches and access Queues.

• View and run One-Step Actions.

• Send E-mails.

• View Dashboards and Widgets.

• View HTML Pages.

• View and run Reports.

• View Visualizations.

• View Calendars.

• Access Knowledge Articles.

• Use tools: Contact Manager, Table Management interface, and CMDB interface.
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Log in to the Browser Client
Before accessing the Browser Client, the appropriate credentials must be assigned. Credentials are
managed on the User's Profile in CSM Administrator.

To log in to the Browser Client:

1. Provide the URL: http://server/CherwellClient where server is the location where CSM is installed
(either locally on the machine or on a specific server outside the local machine).

2. Provide the login credentials (User ID and Password). These should have been assigned by the
implementer or system administrator.

Note: If Windows/LDAP login is enabled, provide the Windows credentials used to log in to
the system.

3. Click Login.

If assigned to more than one CSM Role (and have not previously selected the Automatically Use
Selected Role check box), the Choose your Role window opens.

Note: A Role is a User/Customer's current function/responsibility in CSM, and controls how
data is presented in that person's CSM environment. For example, a Role determines which
Home Dashboard is displayed and how the Incident form looks (example: Which fields are
exposed, required, etc.). A Role is assigned to a Security Group and can be assigned to
more than one Security Group at a time. A User/Customer can access any of the Roles in
his Security Group, but can only log in using one Role at a time. Examples of Roles include
Service Desk Manager and Portal Customer.

4. Select the login Role for the session:
a. Role: Click the appropriate Role.

b. Always Use Selected Role: Select this check box to automatically use the selected Role at the
next log in. This bypasses the Role prompt.

5. Click Submit.
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Log a Record in the Browser Client
Browser Client records are very similar in appearance and functionality to Desktop Client records. For
more information, see Browser Client Forms.

To log a record in the CSM Browser Client:

1. Log in to the Browser Client.

2. On the Browser Client menu bar, click the New menu.

3. Select the type of record from the drop-down (example: New Incident). The record opens in the
main pane.

4. Complete using the appropriate workflow and save the record.
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Add and Remove Columns from a Grid in the
Browser Client

Use the Column Selector in the Browser Client to add or remove columns from the Grid.

1. Open a Grid using an applicable feature.
2. Click the Columns button on the Browser Client toolbar.

The Column Selector opens displaying the Business Object's relationships and associated fields.
Relationships and fields currently displayed in the Grid are indicated by a check mark. Close the
Column Selector at any time by clicking the Cancel button.

3. Add columns to the Grid by selecting one of the following:
◦ The check box next to one or more Relationships in the top level of the tree (example:

Incident Links Customer) to add all fields associated with the Relationship as columns in the
Grid.

◦ The check box next to one or more fields in the second level of the tree (example:
Department, Manager) to add only the field(s) you select as columns in the Grid.
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4. Remove columns from the Grid by deselecting one or more check boxes in either the top level or
second level of the tree.

5. Click the Submit button.
If you added columns, the associated field(s) display on the right side of the Grid and can be moved
anywhere in the Grid by dragging-and-dropping the column to the desired location.
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Export a Grid in the Browser Client
Export a Grid from the Browser Client using CSV and Excel formats.

1. Open a Grid using an applicable feature.
2. (Optional) Filter the Grid so the content is organized the way you want.
3. (Optional) Use the Column Chooser to edit Grid columns. When the Grid is exported, all columns in

the Grid are exported to the file.
4. Click the Export drop-down menu on the Browser Client toolbar.

Note: To export Grids, the User must have the appropriate Application Security Rights.

5. Select the format to use for export:
◦ CSV (.csv)
◦ Excel (.xlsx)

The file immediately begins to download. The download process varies based on the browser and
associated settings.

6. Save the file to your device.
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CSM Web Applications and Accessibility
To support Users with disabilities, many Browser Client and Portal features are accessible using a
keyword and screen reader.

For best results with keyboard navigation, use the Chrome web browser.

The Web Applications have been tested with NVDA (NonVisual Desktop Access), but other screen
readers may provide full or partial capabilities with CSM.
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Web Applications Keyboard Accessibility
Use the following keyboard commands to navigate the Browser Client and CSM Portal.

General Keyboard Commands

Key Action

Tab Move forward from one link or form control to the
next.

SHIFT+Tab Move backward through one link or form control.

Enter Activate the selected link or control.

Spacebar Select a record or option.

CTRL+Spacebar Clear the current selection. For multi-selections,
clears or selects while persisting previous selections.

Page Up and Page Down Scroll the page up or down.

Arrows Scroll through links and controls on a page.

ALT+Arrow-left Move to the previous page.

ALT+Arrow-right Move to the next page.

Form Keyboard Commands
Use the following keyboard commands when focus is on a record form or an element on that form.

Key Action

Enter Selects the highlighted item.

Home Selects the first item in a drop-down.

End Selects the last item in a drop-down.

Spacebar Selects a highlighted radio button or check box.

ALT+down arrow Opens a pop-up or a drop-down.

Esc or ALT+up arrow Closes a pop-up or drop-down.

Grid Toolbar and Header Keyboard Commands
Use the following keyboard commands when focus is on the Grid column header.

Key Action

Enter Sort the column.

Spacebar Select and clear items.
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Key Action

ALT+Down arrow Opens the filter menu.

Esc Closes the filter menu.

ALT+M Toggles the Multi-column Sort option.

Grid Item List Commands
Use the following commands when focus is on the Grid item list.

Key Action

ALT+W Applies focus to the Grid item list.

Enter Expand and collapse cells.

Space Select and clear cells.

CTRL+Spacebar Select cells, but persist previously selected cells.

Page Up and Page Down Navigate through multiple Grid pages.
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Accessibility Limitations
Cherwell Software strives to ensure that its applications are accessible to users with visual and auditory
impairments. There are cases, however, where accessibility may be limited.

For example:

• Keyboard commands are supported for English installations. Some keyboard commands and
shortcut keys may work in non-English languages, however.

• Accessibility capabilities may be limited when the Portal is presented in an external Web site using
an iFrame window.
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Configuring the Browser Client
Complete the following procedures to configure the CSM Browser Client. Configuration procedures are
completed in CSM Administrator.
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Configure Browser Application Settings (URLs,
Timeouts, RSS Feeds)

Use the Browser Settings window in CSM Administrator to configure the following Browser Application
settings:

• URLs: To the Browser Client and Portal.

• Session Timeout.

• RSS Feeds: Enable Feeds/Anonymous Feeds from the Cherwell Service.

• Security: Enable or disable embedded frames, detailed error information, linked Attachments
(Attachments via links instead of direct file attachment), and password auto-complete.

To configure Browser Application settings:

1. Open the Browser Settings window (CSM Administrator>Browser and Mobile>Browser Application
Settings).
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2. Configure URLs for the Cherwell Browser applications (Portal for Customers; Browser Client for
Users).

Note: These are used when the application needs to generate a URL for launching one of
the Browser applications (example: When sending out Approvals).

a. Portal (Customer browser): Specify the base URL for the Cherwell Portal (example: http://
MyServer/CherwellPortal).

b. Browser Client (User browser): Specify the base URL for the Cherwell Browser Client
(example: http://MyServer/CherwellClient).

3. Configure session timeouts:
a. Session Timeout: Specify the number of idle minutes the system should wait before timing

out inactive sessions.
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Note: If you change this from the default of 20 minutes, you also need to configure the
application pool in IIS to have a matching value (CSM cannot make this change directly
because of IIS security).

4. Enable RSS Feeds:

Note: CSM RSS Feeds allow Customers of an RSS reader to subscribe to CSM data (such
as newly created Incidents) based on a Search Group or other criteria. Note that for RSS
Feeds to operate, the Cherwell Web Service must be installed. RSS Feeds are disabled by
default because they could potentially provide inappropriate access to data.

a. Enable RSS Feeds from Cherwell Service: Select this check box to allow RSS Feeds.

b. Enable Anonymous RSS Feeds from Cherwell Service: Select this check box to allow
anonymous RSS Feeds. If not selected, the URL requesting RSS data must contain User
identification information. Anonymous Feeds allow data based on the rights of the CSM's
Anonymous Security Group.

5. Configure browser application security settings:
a. Do not allow the browser applications to be embedded in a frame: Select this check box to

disable browser applications from being embedded in a frame (example: Embedding a CSM
application within the frame of another web page).

b. Do not send detailed error information to client: Select this check box to keep the browser
applications from sending detailed error information when errors occur.

c. Disable linked attachments in the browser applications: Select this check box to disable linked
Attachments (Attachments created via links instead of direct attachment) in the browser
applications.

d. Disable password auto-complete on login page: Select this check box to disable auto-
complete for passwords during login. This requires Users and Customers to type their full
passwords every time they try to log in to the browser applications.

6. Click OK.6. 
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Define the Default Domain and Anonymous Login
Settings

By default, if using Windows or Active Directory, Users must specify the domain as part of the login
credentials (example: Applications\Bob). This is how CSM identifies the fact that Users are specifying
Windows/LDAP Credentials vs. internal Cherwell Credentials. However, if all Cherwell Users are generally
on the same domain, specify that as the default domain. The Cherwell Portal will automatically assume
that any credentials detailed without a specific domain are Customers of the default domain.

Note: This is the recommended and easiest way to specify a default domain for the CSM Browser
Client and Portal. In the event that Users want to use the web.config files to specify the default
domain, but the default domain has already been specified in CSM Administrator, the web.config
files will override the settings in CSM Administrator.

Use the General page in the Security Settings window (in CSM Administrator) to define the following
general system security settings for the Browser Client and Portal:

• Default domain.

• Anonymous login settings.

Configure the default domain and anonymous login settings:

1. In the CSM Administrator main window, click the Security category, and then click the Edit Security
Settings task.

2. Click the General page.

3. Specify a default domain for the network:
a. Default domain: Specify the default domain name for the network. This is used in any place

where a domain is needed but not otherwise provided, such as automatically assigning
credentials to Customers.

Tip: Click the Arrow button to have CSM auto-populate the name.

4. Define anonymous login options (required to allow use of the Browser/Portal Clients):
a. Allow Anonymous Login: Select this check box to allow Browser applications to operate.

b. Anonymous Security Group: Select the Security Group that should be used by Cherwell
Browser applications before any User/Customer has logged in. Cherwell Browser applications
need to be able to read basic setup from the system before logging in, and this is the Security
Group that will be used for such access. Also, for any Portal Sites that do not require login, this
is the Security Group that will specify what Customers will be allowed to access before they
log in.

Note: CSM provides an Anonymous Security Group named Anonymous Browser.

5. Click OK.5. 
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Specify a Default Domain for the Portal and
Browser Client in Web.config Files

The recommended way to specify a default domain for the Portal and CSM Browser Client is by using
CSM Administrator. However, Users can specify a default domain using web.config files. Doing so in the
web.config files will override any settings made in CSM Administrator.

To specify a default domain for either the Portal or Browser Client using web.config files, add the
appropriate value in the web.config file located in your Cherwell directory under Cherwell Browser
Applications\Portal for the Cherwell Portal and Cherwell Browser Applications\Browser Client\ for
the Browser Client. There are two keys that can be added to specify the default domain:

If the ForceDefaultDomain key is present, when the User/Customer types his login ID, one of the following
things will happen:

• If the User/Customer types an ID with no domain, the default domain will be prefixed, so "Bob" will
become "MyDomain\Bob"

• If the User/Customer types a domain\ID, the value will be left alone, so "TestDomain\Bob" will
remain "TestDomain\Bob"

• If the User/Customer types in a domain\ID where the domain is the value specified in
CherwellAuthPrefix, the domain will be removed, allowing the User/Customer to log in using
Cherwell Internal credentials, so "Cherwell\Bob" will become "Bob"

Note: CherwellAuthPrefix defaults to Cherwell if the domain is not set.

• If, for some reason, the ForceDefaultDomain and the CherwellAuthPrefix contain the same value, an
alternate value of CherwellInternal can be used for the internal domain, so "CherwellInternal\Bob"
will become "Bob."

Note: To use internal login credentials on a default domain, you must type CHERWELL\ in
front of the username (example: CHERWELL\Bob) in order to be able to log in.
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Configure Login, Authentication, and Inactivity
Settings for the Portal and Browser Client

By default, the Browser applications (Customer Portal and Browser Client) use the same login mode and
authentication settings as those configured for the Desktop Client; however, Users can define different
settings if needed.

To configure login, authentication, and inactivity settings for the Portal and Browser Client:

1. Open the Security Settings window (CSM Administrator>Security>Edit security settings).

2. Click the Browser Client or Portal Client page.

3. Clear the Use Same Settings as Windows Client check box.

4. Select the login modes to allow (Supported login modes area):

Note: Users can enable multiple login types so that if one authentication fails or the User/
Customer cancels the process, the next configured login method is invoked (SAML, then
external authentication server, then LDAP, then Windows, then Internal). Not all of these
options will necessarily appear in the system if they have not been configured.

Note: When using a secure login configuration (SAML, LDAP, or Windows), Cherwell
strongly recommends you activate the RedirectHttpToHttps flag in the Portal and Browser
Client web.config files for better security. The flag forces requests sent over HTTP protocol
to use HTTPS instead.

◦ Internal: Allows CSM authentication. CSM authenticates the CSM Login ID and Password
defined in the User Profile (CSM Administrator>Security>Edit Users) or Customer Credentials
(Customer>Portal Settings).

Note: To use internal login credentials on a default domain, Users must type CHERWELL\ in
front of the username (example: CHERWELL\Bob) in order to be able to log in.

◦ LDAP: Allows Directory Service authentication. CSM authenticates login credentials using a
Directory Service such as LDAP or Active Directory. Depending on configuration, User/
Customer data can be imported based on LDAP data. For more information, refer to the
Configuring the Integration with Directory Services documentation.

◦ SAML: Allows Security Assertion Markup Language (SAML) authentication. For more
information, refer to the SAML documentation.

◦ Windows: Allows Windows Authentication. CSM authenticates the Windows login credentials if
set in the User Profile (CSM Administrator>Security>Edit Users) or Customer Credentials
(Customer>Portal Settings). For more information about Windows Authentication, refer to the
Windows Login documentation.

5. Configure general login options:
a. Validate Windows/LDAP credentials on server: If this check box is not selected, Windows

credentials are validated on the client, which is not as secure unless you have full control of
your network. If selected, the system will not be able to automatically log in the User/Customer
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without asking (that is, the person will have to type their credentials) but it is much more
secure. For this feature to work, the server must have access to the Windows Domain or
LDAP server.

Note: For best results, configure your server to use encrypted communication before
enabling this feature so that credentials are not passed to the server in a potentially
sniffable format.

b. Allow logging of authentication code (for troubleshooting): Select this check box to enable
logging of authentication calls in order to troubleshoot configuration (example: When
configuring LDAP setup). Then, use the Server Manager to enable logging in the Portal and
Browser Clients.

6. Configure external authentication server option:

Note: This makes use of the Cherwell Authentication Server, which must be installed on
your network such that it has access to your domain and is also callable by the Cherwell
Application Server. This is distinct from SAML, although shares some concepts.

a. Validate credentials via external authentication server: Select this check box to validate User/
Customer credentials against an external authentication server.

b. Require user to enter credentials: Select this check box to require Users/Customers to enter
their credentials each time they log in.

Note: If this check box is not selected, and Users/Customers are on the same domain
as the Cherwell Authentication Server, then the User’s/Customer's current Windows
credentials will be used to determine the person's identity. Otherwise, the User/
Customer will need to provide his Windows domain/user ID and password into the
login window.

c. Authentication server Uniform Resource Identifier (URI): Specify the URI (location) of the
external authentication server.

Note: Both Client applications and the Cherwell Application Server must have access
to this URL.

7. Click OK.7. 
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Prevent Browsing HTTP from HTTPS
Browse HTTP from HTTPS is a vulnerability allowing HTTPS pages to be accessed via HTTP, thus
disclosing potentially sensitive information. We strongly suggest editing web.config files to enforce
redirecting HTTP requests to HTTPS.

1. Edit the web.config file for the Portal and/or the WebClient.
◦ For the Portal, edit the WebConfig file in C:\Program Files (x86)\Cherwell Browser

Applications\Portal
◦ For the Web Client, edit the WebConfig file inC:\Program Files (x86)\Cherwell Browser

Applications\BrowserClient
2. Under the AppSetting section, uncomment the following Key:

·add key="RedirectHttpToHttps" value="True" />

3. Reset IIS.
4. Review the configuration of any applications you have installed to ensure proper permissions are in

place to prohibit forceful browsing of HTTPS resources.
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Configure Anonymous Login Settings for the
Cherwell Browser Applications

Use the Security Settings General page to define the anonymous login settings for the Browser Clients.

To configure anonymous login settings:

1. Open the Security Settings window (CSM Administrator>Security>Edit security settings).

2. Click the General page.

3. Configure anonymous login options (required to allow the use of the Browser/Portal Clients and
Mobile applications):

a. Allow Anonymous Login: Select this check box to allow Browser applications to operate.

b. Anonymous Security Group: Select the Security Group that should be used by CSM Browser
applications before any User/Customer has logged in. CSM Browser applications need to be
able to read basic setup from the system before logging in, and this is the Security Group that
will be used for such access. Also, for any Portal Sites that do not require login, this is the
Security Group that will specify what Customers will be allowed to access before they log in.

Note: CSM provides an Anonymous Security Group named Anonymous Browser.

4. Click OK.4. 
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Configure Browser Client (User) Login Credentials
CSM uses a User's login credentials to log them into the Browser Client. Login credentials are stored in
the User Profile. This must be configured through CSM Administrator and cannot be done from the
Browser Client.
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Configure Miscellaneous Settings for Web
Applications

You can use web.config files to configure certain settings for the CSM web applications, including the
Browser Client, Portal, and, in some cases, the Cherwell REST API.

These web.config files can be found in the Cherwell directory on the server where you installed the web
applications. For example, the web.config file for the Portal is located in Cherwell Browser
Applications\Portal; for the Browser Client, the web.config file is located in Cherwell Browser
Applications\Browser Client.

For best results, restart Internet Information Services (IIS) after you modify a web.config file.

Change Prompt Time-out Period
Prompts generated by a One-Step, Expression, or Stored Search remain open in the web applications for
2 minutes by default. If users do not respond to the Prompt within that time frame, the Prompt closes.

To change the default time-out period, modify the following key in the web.config file:

<add key="UIInteractionTimeoutInSeconds" value="number of seconds"/>
      

Disable Label Resizing
While not recommended, to disable the resizing of labels that are set to dynamically auto-size in the
Browser Client, add the following key to <appSettings> section of the web.config file:

<add key="AutoSizeLabels" value="False"/>

Enable Lookup Button for Business Objects
By default, the Lookup button will enable only on Fields that support lookups. To enable the Lookup
button whenever editing a Business Object, add the following key to <appSettings> section of the
web.config file:

<add key="LookupAlwaysEnabled" value="True"/>

Disable Scripts in Reports
By default, Users can run a Report that contains scripts if they have rights to run the Report. You can
disable scripts from running in all Reports, however. This prevents may cause errors when Users run
Reports that contain scripts, but may improve security.
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By default, scripts are enabled for Reports.

To disable scripts in all Reports, change the value in the following key to "False":

<add key="AllowScriptsInReports" value ="true"/>

Execute Embedded HTML and Script
While not recommended, to allow HTML and script embedded in labels to be executed in the Browser
Client, add the following key to <appSettings> section of the web.config file:

<add key = "AllowUnsafeLabels" value="True" />

<add key="AuthLogFile" value="c:\temp\webauthlog.log"/>

HTTPS-Only Cookies
In production environments, it is strongly recommended that sensitive cookies (like those used to maintain
your session) be marked as "Secure," meaning they will only be transferred with requests that are made
over HTTPS, and HTTP-only, meaning they will not be accessible to Javascript running in the browser.

In order to take advantage of this configuration, perform the following steps:

1. Ensure the web application is running on an IIS instance that listens on both :80 (HTTP) and :443
(HTTPS).

2. Ensure IIS (or a web.config file, or some other handler) is set up to automatically redirect http://
hostname/path to https://hostname/path.

3. Add the following line to these web.config files:
◦ C:\Program Files (x86)\Cherwell Browser Applications\Portal

◦ C:\Program Files (x86)\Cherwell Browser Applications\CherwellClient

◦ C:\Program Files (x86)\Cherwell Browser Applications\CherwellService

<httpCookies
httpOnlyCookies="true"
requireSSL="true" />

For more details, see https://msdn.microsoft.com/en-us/library/ms228262(v=vs.100).aspx.

In-line Browser Display Extensions
To specify other in-line browser display extensions that should open inside of a browser window, add the
following key to <appSettings> section of the web.config file:
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<add key="InlineBrowserDisplayExtensions" value=".pdf,.xml"/>

Note: Browsers that are not Internet Explorer (ex: Chrome™, Mozilla Firefox®, etc.) handle in-line
browser display extensions more automatically, but Internet Explorer requires this to be set. PDF
and XML files are handled this way by default.
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Troubleshoot the CSM Web Applications
If the CSM Web Applications (Browser Client, Portal, Web-Forms) are not working, use the following
steps to troubleshoot:

1. Make sure web.config is pointing to the correct connection (the default is Cherwell Browser):
a. Open the web.config file. By default, it is installed to: C:\Program Files\Cherwell Browser

Applications\"App"\web.config).

b. Make sure the value is "[Common]Cherwell Browser".
◦ For Portal and Browser Client, the XML is at the bottom and looks like this:

<appSettings>

<add key="TrebuchetDataSource" value="[Common]Cherwell Browser"/>

</appSettings>

◦ For Web Forms, the XML is at the top and looks like this:

<add key="TrebuchetDataSource" value="[Common]Cherwell Browser"/>

2. Make sure Cherwell Browser connection is using SQL Authentication or domain account
permissions have been set up appropriately:

a. If SQL is installed on same machine as IIS, Users can give the IUSR_<machineName>
account rights to the SQL server database.

b. If SQL is not installed on the same machine as IIS, Users have to create a domain account,
give that account rights to the SQL server database and also set up the application in IIS to
use that account. In addition, Users must give that account rights to the directory (and
subdirectories) where the Browser applications are installed.

3. Make sure IIS is set up for Anonymous Access. If desired, enable Integrated Windows
Authentication:

a. Go into IIS. On the left is the Internet Information Services tree. Expand the Web Sites node
and then the Default Web Site node underneath. Find the folder for the Browser application.

◦ In IIS-7 (Windows Server 2008), click the application in the left-hand pane, then double-
click Authentication in the IIS section of the features view on the right. If Anonymous
Authentication is not enabled, select it, then click Enable in the far right Actions pane. Do
the same thing for Windows Authentication if desired. Note that, if Windows
Authentication does not appear, you might need to go the Server Manager to install the
feature.

4. Consider the Browser being used (only if you are using Windows Authentication):
◦ Firefox cannot pass Windows credentials properly unless you install their plug-in. Try Internet

Explorer and see if this works.

5. Make sure the right version of ASP.NET is registered in the Windows Registry. The Portal and
Browser Client both require .NET 4.x. Web Forms and the Web Service require .NET 3.5.
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Troubleshoot Uploading Attachments
If Users are having trouble uploading attachments, make sure that they have rights to the Attachments
directory.

1. Go into IIS and find the Attachments directory under the Self-Service virtual directory.

2. Right-click and select Properties.

3. Go to the Directory Security tab.

4. Press the Edit button in the Anonymous Access box. Ensure that User is set up.

Note: Users might also need rights to the actual directory on the hard drive.
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Troubleshoot Grids in Internet Explorer
In some older versions fo Internet Explorer, Grids sometimes do not align properly after sorting the Grid
columns. In order to correct this, Users must disable the Compatibility View setting in Internet Explorer.

To disable Compatibility View:

1. Open Internet Explorer.

2. Click Tools to open the Tools menu, and then click Compatibility View Settings.

3. If the CSM Browser Client is displayed in the list of sites to display in Compatibility mode, remove it.

4. Users can also disable Compatibility View by clicking the Compatibility View button  in the web
address bar.
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Portal
The CSM Customer Portal is a highly configurable web application that enables Customers to securely
and conveniently access their CSM data (example: Incidents, company news, documents, the Service
Catalog, etc.) using a browser. A Portal supports multiple sites (for different types of Users), and also
allows managers to access their Team’s data.
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About Customer Portals
3-Minute Video: Tour the New Out-of-the-Box Portal.

Using a Portal, Customers can:

• Access a Service Catalog.

• Log Incidents and Service Requests.

• Complete common self-service functions (ex: Reset a password).

• Access Knowledge Articles.

• Access a Document Repository, if configured.

• Monitor important metrics via a Dashboard.

A Portal comprises one or more configurable Portal Sites, each of which can display completely different
information. For example, there might be a primary IT Site, but also different Sites for other departments
or functions. Any particular Site can be made up of a number of Site Items.

To help get your system started, CSM provides an OOTB IT Portal Site. The Site is built using OOTB Site
Items, such as an OOTB Service Catalog, forms specific to the Portal, Dashboards specific to the service
desk, and predefined properties (header/footer, menu bar, etc.). Implement and use the OOTB IT Portal
Site as-is, modify it, or create new Sites to meet the needs of your organization.
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Portal Sites
A Portal Site is a collection of self-service information in a CSM Portal that is dedicated to a topic or
function. A Portal can display one or more Sites.

For example, it might display:

• A company support Site (single site Portal).

• A Site for each department (IT, HR, Support. etc.).

• A Site for each locale (US, Germany, Chile, etc.), although a single Site can be configured to be
available in multiple languages.

A Portal Site is highly configurable and can be tailored to meet branding and layout needs. The Site can
display an Application Bar (Login, Site Selector, etc.), an informative banner/footer, a menu bar, a Search
Control, and a Startup Item (A Dashboard).

1. Banner: Displays Site and background image, title, subtitle, and baseline text.

2. Application Bar: Displays the Language Selector, Site Selector, login menu, and CSM logo
(provides information about Cherwell Software when selected).

3. Menu Bar: Lists the Site Items and/or supporting Actions. Click a Site Item to display its contents in
the main pane or its list of supporting Actions. The Portal menu bar collapses into a hamburger
menu on mobile screens and browser windows sized below 768 pixels.

4. Search Control: Searches the Portal.
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5. Main Pane: Displays the Startup Item, which could be a Dashboard, a Report, a list of records
(Search Group), the record currently being edited, etc.
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Site Items
The following items can be included on a Portal Site:

• Actions (including powerful create options and interactive One-Step Actions): Use on a Site's menu
bar to support Site Items (Create Incident or Display Document Repository) and enhance
navigation. Actions can also be used on Dashboards and HTML pages.

• Action Catalogs: Display a self-building and dynamic catalog of Actions that empower Customers
to help themselves (example: Create a Service Catalog that displays all your services with Actions
to create Incidents and Service Requests).

• Calendars: Displays time-sensitive Business Object data in a Calendar format.

• Dashboards and Widgets: Provide custom, insightful control panels capable of executing
commands and providing real-time, at-a-glance information. For example, a Customer-specific
Dashboard complete with a Twitter Feed, a list of announcements, and a list of Open/Closed
Incidents.

• Document Repositories: Provide a collection of resourceful documents, such as Knowledge
Articles, that encourage Customers to resolve their own issues.

• Forms/records: Allow Customers to expedite service by creating, viewing, and editing their own
records, such as Incidents and Service Requests, and possibly other Customer's records.

• Grids: Allow Customers view CSM data from a Business Object in a format that can be sorted and
exported.

• HTML Pages: Display a system administrator-designed HTML-coded page or host a web page from
an external site.

• Knowledge: Search for Knowledge Articles (KAs) using a Portal Site's configured Search Control.
When using a KA in the Portal, Customers can vote on Article popularity by clicking the Like button
and add feedback by clicking the Add a Comment link.

• Reports: Provide metrics of your record data in a formatted and organized presentation.

• Searching: Offers searching so that Customers can easily locate information about the Portal. Use
CSM's Out-of-the-Box (OOTB) Search Control or create your own Search Widget.

• Service Cart: Provides an e-commerce tool that Customers can use to add multiple Services to a
single order, and then temporarily hold the Services until they are ready to submit their order.

• Visualizations: Display a visual map of linked records, Customers, vendors, etc.

Note: HTML pages are unique to the Portal. The other items are commonly used throughout
CSM.

When a Customer first accesses a Site, a default Startup Item is displayed; this can be an Action Catalog
(special Widget), a Dashboard, a Document Repository, an HTML page, a Report, or a Search Group
(used to display a list of records). A Customer can access other Site Items using the Site menu bar. The
Startup Item can also be accessed when Users click the optional title logo/text or optional Home menu bar
button.
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Different Startup Items can be displayed upon login so information can be securely and appropriately
filtered based on credentials. For example, display a Service Catalog to Customers who are not logged in
and then display a Dashboard complete with a Customer's Open Incidents for a Customer who does log
in.

To help build and manage the Portal and Sites, CSM provides the Site Manager (manage Sites at a high-
level), the Site Wizard (create a cursory Site), and the Site Editor and Site Properties window (edit/refine
the way the Site/Site Items look and behave). CSM also provides numerous CSM Item Managers that
allow you to create Site Items, such as Dashboards, HTML pages, Document Repositories, etc.
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About Portal Actions
An Action is an activity that can be initiated manually (from a button, link, menu bar item, or Widget) or
automatically (from an Automation Process, One-Step™, or E-mail Monitor) to execute a command
(example: Print) or display/run a CSM Item (example: Display a Dashboard or run a Search).

CSM provides several customizable Actions that can be added to/executed from the Portal menu bar, a
Dashboard, or an HTML page.

Examples include:

• Display Create commands for the Business Objects used on the Portal Site (example: Create
Incident).

• Display common Searches (example: Search My Open Incidents).

• Display a Home button on the Portal menu bar to take Customers back to the Startup Item.

• Display or run a CSM Item (example: Action Catalog, Report, Document Repository, etc.).

Some Actions are automatically added to the menu bar when creating a Site using the Site Wizard. For
example, a menu bar Item can be added for each Business Object associated with the Site and a
Document Repository Action is added if there is a Document Repository.

Manually add Actions or edit existing Actions by defining menu bar properties for a Site.

Manually add the following Actions:

• One-Step Action: Runs a One-Step Action Action, which runs one or more other Actions:
◦ Create/update/delete a Business Object.

◦ Excel merge.

◦ Execute a command.

◦ Go to a Field.

◦ Go to a record.

◦ Go to Action (branching).

◦ Launch a URL.

◦ Link/Unlink Business Objects.

◦ Print.

◦ Run another One-Step Action.

◦ Run a program.

◦ Run a Report.

◦ Send a Tweet.

◦ Send an e-mail.

◦ Show a Pop-Up.

◦ Step through children.
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◦ Transfer Attachments.

◦ Transfer Related Business Objects.

◦ Update a Variable or Stored Value.

◦ Web service call.

◦ Write to a file.

◦ Work with a Queue.

• Command: Runs a system command applicable to the Portal. Categories include:
◦ Managers: Adds a command to launch a CSM Item Manager so that a Customer can choose a

CSM Item (Action Catalog, Dashboard, Document Repository, One-Step Action, HTML page,
Report, or Search) to open/run (for example, Add the Report Manager to the Site menu bar so
that Customers can choose to run an available Report). Note: Recent Items lists must be
placed inside folders (they cannot be at the top level of the menu bar), and it is recommend
that they be placed as the last item in the folder.

◦ (Other) Business Object Search: Provides common Site Searches (for example, Business
Object to search, how the results should be sorted, whether to limit to the current Customer,
limit to Open or Closed records, etc.).

◦ (Other) Create Business Object: Creates a new Business Object (record) but with several
powerful options, such as a One-Step Action to run as part of the creation process and
whether a custom Form should be displayed (which can be different than the Out-of-the-Box
(OOTB) Form used for viewing a Business Object).

◦ (Other) Home: Takes the Customer to the Startup Item (Dashboard, HTML page, etc.).

Note: This command must be placed in a folder.

• Dashboard: Displays a Dashboard.

• Report: Runs a Report.

• Search: Runs a Search Group.

• Page: Displays an HTML page.

• Doc Repository: Displays a Document Repository.

• Action Catalog: Displays an Action Catalog (Widget).
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About Portal Action Catalogs
An Action Catalog is a dynamic catalog of Actions that empowers Users and Customers to help
themselves (example: Create a Service Catalog that displays all your Services with Actions to create
Incidents and Service Requests).

When a Customer clicks a hyperlink, an Action executes (example: Request Account creates an Incident
record and categorizes it as a Request). The Action Catalog's theme, such as Cherwell Next, controls the
fonts, colors, block layout, etc.

Note: A Service Catalog is built using the Action Catalog Widget, which can be used on a
Dashboard or as a stand-alone Widget in the Portal.
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About Portal Calendars
A Calendar allows you view time-sensitive Business Object data in a natural format that can be shared
with Teams or an organization.

The CSM Portal has Calendar capabilities that are very similar to those in the Browser Client Calendar.
Examples of Portal Calendars include the IT Calendar, Task Calendar, and Event Calendar.

When working with Calendars In the Portal, Users can:

• View a Calendar by clicking IT Calendar on the menu bar.

• Change the Calendar View.

In the Portal, Calendar functionality is accessed using the IT Calendars text on the Portal menu bar if you
designed the Portal to include it.
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About Portal Dashboards
A Portal Dashboard is a custom, interactive, and insightful console that is optimized to provide helpful at-
a-glance self-service information and navigation for Customers accessing a Portal Site.

Like all CSM Dashboards, a Portal Dashboard uses configurable Widgets to display critical metrics,
analyze and predict trends, drill down into data, initiate commands and Actions, facilitate navigation, or
show a sampling of information relevant to Customers.

Examples of Portal Dashboards include:

• A not logged-in Portal Dashboard, intended for anonymous Customers, that presents general
information and data, such as a welcome information, a community discussion board, and service
desk hours.

• A logged-in Portal Dashboard, intended for logged-in Customers, that displays a list of open records
(by Customer and organization), facilitates navigation, and helps Customers with self-service
operations (ex: Logging Incidents, locating Knowledge Articles and FAQs, etc.).

• A department Dashboard, intended for Customers in a specific department (ex: HR, Facilities,
Finance, etc.), that presents department-specific records and metrics, a discussion board, or a
Twitter Feed.

CSM provides several Out-of-the-Box (OOTB) IT Portal Dashboards, which are used on the OOTB IT
Portal Site. Use these OOTB Dashboards as-is, modify them, or create new Dashboards using the
Dashboard Manager and Dashboard Editor.

Note: For more information about Dashboards and Widgets (including how to create them), refer
to the Dashboards documentation and the Widgets documentation.
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About Portal Widgets
A Widget is a mechanism that displays information about a Dashboard or Portal Site (ex: Chart, Gauge,
Button, etc.). Examples of Portal Widgets include:

1. Search Results List Widget

2. Chart Widget

3. Action Widgets (links or commands)

CSM provides multiple of OOTB Widgets designed to display data on a Dashboard or Portal Site.
Use these OOTB Widgets as-is, edit them, or create your own using the Widget Manager.
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About Portal Forms
CSM allows you to create several different types of Forms for each Business Object, including:

• Regular Forms: Main Form or Forms for the Business Object. By default, each Business Object
has one Default regular Form; however, you can create as many as you need (example: Create an
alternate Form with only specific details, create a specifics Form to data relevant to a categorization
such as Printer Incident, or create a Master container Form that toggles between two smaller
Embedded Forms. Typically, a regular Form is intended for detailed logging activities in the Desktop
and Browser Client. Example Forms include:

◦ Incident

◦ Problem

◦ Change Request

◦ Journal

◦ Task

• Portal Forms: A Regular Form designed specifically for the Customer Portal to provide self-service
record logging capabilities, such as an abbreviated Incident Form. Typically, Portal Forms are much
simpler than the default Form used in the Desktop/Browser Client.
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About Portal Grids
Grids in the Browser Client and Portal look very similar to Desktop Client Grids.

Portal Grids include the following features:

• Grid Menu Bar: Displays actions available for the Grid, including navigation, Actions, and available
columns.

• Title: Grid title that might or might not match the name of the Business Object that the Grid
represents. Also, a Business Object might have multiple Grids, so each might have its own name.

• Sort icon: Indicates the column currently sorting the Grid, and if it is in ascending or descending
order. Click the icon to toggle sorting. Click another column heading to sort by that column.

• Filter icon: Indicates the column data can be filtered. Click the icon to show filtering options
(possible filter values appear in the column's Filter drop-down).

• Grid item: Each item within a Grid contains its own line of information. Clicking the item opens the
record in the Main Pane.

For more information on working with Grids in the Portal, refer to Browser Client Grids.
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About HTML Pages
A CSM HTML Page is an HTML-coded web-like page used to display information on a CSM Customer
Portal Site or in the CSM Browser Client.

HTML Pages can be:

• Internal HTML Pages: HTML pages that Users design and code. Users can insert CSM commands
directly into the page, as well as CSM Images, Tokens, Stored Values, etc.

• External HTML Pages: Existing websites. Users supply the URL.

Use an HTML Page to display:

• A company website as Startup Item on a Portal Site.

• A hardware website or forum on a Portal Site (add an Action to a Site menu bar to display an HTML
page).

• A hard-coded HTML Page that Users design directly in the Browser Client.

CSM provides several OOTB HTML Pages. Use these OOTB HTML Pages as-is, edit them, or create
new HTML Pages using the HTML Page Manager. CSM also provides the HTML Page Editor to help
design and code your own Internal HTML Page.

Note: The HTML Page Editor is useful for building pages. For more advanced options, it is
assumed that Users have a working knowledge of HTML and possibly CSS.
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About Portal Knowledge
CSM consolidates multiple Knowledge Sources into a single, powerful Knowledge Base so that Users can
find relevant information quickly without the use of additional resources. Depending on the configuration
of your system, Customers might also have access to Knowledge through the Portal so that they can
independently solve issues.

CSM Knowledge can come from many different Knowledge Sources, including:

• Knowledge Articles (KAs): CSM Business Object dedicated to Knowledge. Use to share identified
solutions with Users and Customers. Note that KAs can also be imported from third-party
Knowledge providers (ex: KnowledgeBroker).

• Business Object records: Closed Incidents or Problems (Known Errors), or any other appropriate
Business Objects.

• Attachments: Imported internal or external documentation.

• Web: Adobe®, Google®, Microsoft TechNet®, Twitter®, Yahoo!®, YouTube®, etc.

By default, only members of the Portal Workgroup Manager Security Group can create Knowledge
Articles in the Portal.
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In the Portal, Customers can search for Knowledge Articles using a Portal Site's configured Search
Control or using the Knowledge Article Dashboard. When on a KA in the Portal, Customers can vote on
Article popularity by clicking the Like this Article link, note whether or not it resolved their issue by clicking
Yes or No, and add feedback by clicking the Add Comment link.
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About Portal Reports
Portal Reports behave similarly to Reports in the Browser Client. In the Portal, Reports can be run from
Specific links and Widgets in a Dashboard (if configured in CSM Administrator).
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About Portal Searching
CSM provides multiple search tools to help efficiently and thoroughly search and filter CSM data, locating
one record or a set or records. Searching tools for the Portal include:

1. Quick Search: A Quick Search is a simple query that quickly finds all records containing a specific
word or phrase (ex: Show all records whose description contains the word "phone"). Search options,
such as record type, status, etc., are typically predefined to simplify the search, and vary depending
on the purpose and location of the search. Quick Search is a Full-Text Search, so it searches all
fields that have Full-Text search enabled (even those that are not specified) and finds similar words,
as well. In the Portal, run a Quick Search using the CSM Search Control.

2. Search Groups: A Search Group is a saved search that finds all records meeting commonly-defined
criteria (ex: Find all My Open Incidents). Search Groups are meant to be reused and can be
accessed from multiple places in CSM.

3. Knowledge Search: A Knowledge Search is a search that runs against the Cherwell Knowledge
Base to quickly find solutions (ex: Find information relating to Account Management). Knowledge
Searches can also treat existing records in CSM as Knowledge Sources. On the Out-of-the-Box
(OOTB) IT Portal Site, the Find Help Dashboard contains an Action link that opens the OOTB IT
Portal Site Knowledge Article Dashboard. This Dashboard displays a Knowledge Search bar as well
as the Most Popular Knowledge Articles.
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CSM provides an OOTB Quick Search, an OOTB Search Control, and a variety of OOTB Search
Groups. Use these Search features as-is, or modify them to meet the needs of your organization.
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About the Service Catalog
The OOTB Service Catalog displays Service Catalog items with an icon (optional), title, and description in
card format. The number of columns adjust according to the size of the User's screen.

The following services are in the OOTB Service Catalog:

• Account Management: Pertains to network access and passwords.

• Conferencing/Presentation: Encompasses conference setup, web sharing, projectors, and more.

• Desktop Management: Covers end-user computer equipment and OS, anti-virus, and
miscellaneous software.

• E-mail/Calendaring: Contains e-mail and calendaring software and account management.

• Employee Support: Used primarily by HR and hiring managers to set up new employees, update
their information, or request an employee separation task.

• Enterprise Apps: Contains options for business software used by the organization.

• IT Service Desk: Used primarily by an IT department to manage technology systems in the
organization.

• Network Services: Covers the network itself, both wired and wireless. It includes file sharing and
backup/restore services.

• Printing: Covers local desktop and shared network printers. Users can request access to network
resources, request toner/ink, or request a local printer of their own, pending approval.

• Telephony/Fax: Covers telephony equipment (desktop and mobile) and fax machines.

• Web Services: Includes external (Internet) and internal (Intranet) requests.

The OOTB Service Catalog has a search feature that produces a list of suggested matches after typing
three characters into the search box. You can search on the title and description of Service Catalog items.
The drop-down menu of suggested results will show up to five suggestions. Click the More... link to view
additional suggestions. Select the Search button or hit the Enter key to view all search results.
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The Cards with Search style was introduced to the OOTB Service Catalog in CSM 9.2.0. If you upgraded
from a version of CSM than 9.2.0, you can implement the Cards with Search styling.

Note: When a user's screen size is small enough that only one column of cards is displayed, the
card icon will be hidden.
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Implementing the OOTB Service Catalog
The Cards with Search style was introduced to the OOTB Service Catalog in CSM 9.2.0. If you upgraded
from a version of CSM prior to 9.2.0, you can implement the Cards with Search theme two ways:

• Edit the existing Service Catalog Widget

• Create a new Widget to act as your Service Catalog
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Implementing the OOTB Service Catalog (Using an
Existing Service Catalog Widget)

Good to Know:

• The OOTB Service Catalog Widget is a stand-alone Widget; it does not work if embedded in a
Dashboard.

• Images associated with catalog items should be sized to 64x64 pixels for best results. CSM will
resize larger or smaller images to fit a 64x64 pixel container.

• If you preview the Cards with Search style, you will see a static example of the layout, rather than a
true preview of your live data.

To update an existing Service Catalog to take advantage of the Cards with Search style introduced in the
9.2.0 OOTB Service Catalog, perform the following steps:

1. Go to the Widget Manager, right-click Service Catalog, and select Edit. In the Display page, select
Cards with Search from the Style drop-down.

2. If necessary, add a description field in each lookup table, then add the field to the associated form.
3. Select the Show Image next to each command checkbox.

a. Choose Field with Image to select a source for the image. The fields available in the drop-
down are related to the Action Business Object selected on the Actions page.

b. Choose Expression to build an expression to provide an image.
4. Optional for Advanced Users: To edit primary and interactive text colors, use the Definition Editor.

Select WidgetActionCatalogStyleDef from the Def Type drop-down list. Inside the <Css> element,
the Primary (#0056B8) and Interactive (#034470) colors can be changed to any CSS color (hex
code, RGB value, or a valid color name). There are multiple instances of the Primary and Interactive
colors in the CSS block.

Note: To use card images on a single-level Service Catalog, ensure the Action Business Object
you choose has a field that stores images.
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Implementing the OOTB Service Catalog (by
Creating a New Service Catalog Widget)

To create new Service Catalog using the Cards with Search style introduced in the 9.2.0 OOTB Service
Catalog, perform the following steps:

Create a New Service Catalog Widget

1. In CSM Administrator, create a new Blueprint.
2. Open the Widget Manager and create a new Action Catalog Widget.
3. In the Widget dialog, select the Display page. Choose Cards with Search from the Style drop-down

menu.
4. The image on each parent-level card will show up as either custom images or pre-9.2.0 OOTB

images. In the Groups page, select the Display Options button for the top-level Group.
5. Select the Show image next to each item checkbox.
6. Select the Field with Image radio button, then select Linked Image from the drop-down menu.
7. Complete the rest of the necessary fields to complete the Service Catalog Widget.

Map Description Fields

8. Important: The Incident Category and Incident SubCategory lookup tables also need a8. 
description field to take advantage of the Cards with Search theme. The title and description
text in each parent-level card are mapped to the description fields in the Service Major
Business Object. The child-level cards are mapped to description fields in the Incident
Category and Incident SubCategory Lookup Tables.
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If your database does not have a description field in those Lookup Tables, perform these substeps:
a. Add description fields to the Incident Category and Incident SubCategory Lookup Tables.
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b. Add the description field to the associated forms.
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Add New Widget to the Portal menu

9. Open the Site Manager.
10. Right-click the Portal site you wish to add the new Service Catalog Widget to and select Edit.

a. Select the Menu page.
b. Click the Add action down arrow
c. Select Add Action Catalog action...

The Widget Manager opens.
11. Select the new Widget.
12. Optional for Advanced Users: To edit primary and interactive text colors, use the Definition Editor.

Select WidgetActionCatalogStyleDef from the Def Type drop-down list. Inside the <Css> element,
the Primary (#0056B8) and Interactive (#034470) colors can be changed to any CSS color (hex
code, RGB value, or a valid color name). There are multiple instances of the Primary and Interactive
colors in the CSS block.

Note: The OOTB Service Catalog Widget is a stand-alone Widget; it does not work if embedded
in a Dashboard.

Note: Images associated with catalog items should be sized to 64x64 pixels for best results. CSM
will resize larger or smaller images to fit a 64x64 pixel container.

Note: If you preview the Cards with Search style, you will see a static example of the layout,
rather than a true preview of your live data.
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About Service Carts
A Service Cart is an e-commerce tool that allows Customers to add multiple Service Requests to a single
order, and then temporarily hold the items until they are ready to submit the full order. When the order is
submitted, each Service Request automatically creates associated Tasks based on related Service
Catalog Template Work Units. Technicians fulfill the Service Requests in CSM, and Customers view and
track the Service Requests (and Service Request history) on the My Service Orders page of the
Customer Portal.

CSM Provides an OOTB Service Cart as a Major Business Object for Customers to use in the OOTB IT
Portal.

Note: Service Cart can be used to support Multi-Sourcing Service Integration (MSI) and Service
Integration and Management (SIAM). For more information, see The Relationship between CSM
and Multi-Sourcing Service Integration and Service Integration and Management.

CSM 9.4.0 Client Suite 158

CSM 9.4.0 Client Suite

https://help.cherwell.com/csh?topicname=ootb_it_portal_sites
https://help.cherwell.com/csh?topicname=ootb_it_portal_sites
https://help.cherwell.com/csh?topicname=the_relationship_between_csm_and_siam
https://help.cherwell.com/csh?topicname=the_relationship_between_csm_and_siam


About Portal Visualizations
A Visualization is an interactive graphical representation of related data, represented as a relationship
chain with colored nodes (boxes) and links (arrows). Defined alerts can also be added to indicate potential
risk. Portal Visualizations look and behave similarly to Visualizations in the Browser Client. Examples
include:

• Configuration maps (records that are linked using a common factor).

• Organization charts.

In the Portal, Users can:

• View a Visualization using the Visualization button on the menu bar.

Note: In order to open the Visualization in the Portal, the Visualization feature must be
added to the Out-of-the-Box (OOTB) IT Portal Site menu bar.

Good to know:

• Actions, Dashboards, Visualizations, Calendars, Widgets, and Searches can be viewed, accessed,
or run in the Portal; however, they are managed (created, edited, deleted, etc.) and configured
(security rights and defaults) only in the CSM Desktop Client and CSM Administrator.

• The Portal Visualization window provides much of the same functionality as the Desktop
Visualization window and includes the toolbar, Main pane, Aerial pane, and Legend; however, the
Portal Visualization window does not include a menu bar.

CSM 9.4.0 Client Suite 159

CSM 9.4.0 Client Suite



OOTB IT Portal Sites
CSM provides an Out-of-the-Box (OOTB) IT Portal Site to get started. The Site is built using OOTB Site
Items and predefined properties (below). We recommend that you implement the OOTB Site so that you
can explore the features, and then modify it or create new Sites to meet the needs of your organization.
OOTB Site Items include:

• Home Dashboard: Directs Customers to log and/or view Incidents and Service Requests, find help
by browsing Knowledge Articles and FAQs, and manage their devices through Service Requests.
Also displays live metrics (global and personal) and a live Discussion Board.

Note: CSM also provides a not logged-in Dashboard for anonymous Customers. This
Dashboard is simple and provides access to only a few self-service operations (ex:
Resetting a password).

• Service Catalog: Displays all available Services in a dynamic card format. See more information
about the OOTB Service Catalog.

• Metrics: Displays detailed metrics for the Customer (My Items), department (Department Items),
and records (Status and Problems). Metrics are displayed via Dashboards.

• Portal-specific Incident, Change Request, and Knowledge Article Forms: Simple Forms help
Customers log and manage their own records.

OOTB IT Portal Site properties include:

• General properties: Defines the name (IT) and associated Document Repository (Default Portal
Documents).

• Display properties: Defines the Startup Item to display when first accessed (a Dashboard named
Portal (not logged in)) and the alternate Startup Dashboard to display upon login (Portal Default).
Also defines the Theme and Search Control (both are OOTB).

• Banner properties: Defines the title and subtitle, as well as the colors.

• Footer properties: No footer is used.

• Menu bar properties: Defines which items to display on the menu bar (Home, Service Catalog, My
Devices, IT Calendar, Charts and Items, and Service Orders). Reset Password is a conditional
menu bar item, and displays only when the Portal (not logged in) Dashboard is active. The Bomgar
Chat Request menu item is also conditional and displays only when Bomgar is enabled.

• Localization properties: For the localized content czar, localize sites are available for Spanish,
French, German, and Brazilian Portuguese.
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Portal Good to Know
• A Portal Site is a collection of self-service information in a CSM Portal that is dedicated to a topic or

function.

• The Portal is personal (you can display different Views for different Customers).

• The Portal allows Anonymous access (Customer is not required to log in), though access to data is
limited.

• If a Portal Site requires a log in, Customers must have Portal login credentials, which means they
must have a Customer Record with defined credentials and security rights.

• Content can be real-time or static and is organized using a set of highly configurable Sites that you
create for your Customers.

• A Portal Site can contain any number of Site Items, including Business Objects/records (Customers
can create and edit records), Actions (including powerful create options and interactive One-Step
Actions), Action Catalogs, Dashboard and Widgets, Document Repositories, HTML pages, Reports,
Search Groups, and Searching.

• When a Customer first accesses a Site, a default Startup Item is displayed; this can be an Action
Catalog (special Widget), a Dashboard, a Document Repository, an HTML page, a Report, or a
Search Group (used to display a list of records). A Customer can access other Site Items using the
Site menu bar.

• To help getting the system started, CSM provides an OOTB IT Portal Site. This OOTB IT Portal Site
is built using OOTB Site Items (example: An OOTB Service Catalog, Portal-specific forms, service
desk-specific Dashboards, an OOTB Document Repository, etc.) and predefined properties (Startup
Item, alternate Startup Item, header/footer, menu bar, etc.). Implement and use this OOTB IT Portal
Site as-is, tailor it, or create new Sites to meet the needs of your organization.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For more
information, see Configure Portal Security Rights.
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Using a Portal
When working with Portals, Users and Customers can:
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Log in to a Portal
While Users and Customers can reach the Portal without logging in if allowed, functionality is limited until
a login is complete.

To log in to a Portal:

1. Provide: http://server/CherwellPortal where server is the location where CSM Browser
applications are installed.

This opens the default Site chosen by the system administrator.

Tip: To navigate to a specific Site, specify the Site in the URL (ex: http://server/CherwellPortal/
Marketing).

2. Depending on the design of the Portal, the User might need to click the Login link to log in to the
Portal Site. Consider that not all Portals and Sites require login.

3. Provide login credentials (User Name and Password).

Note: If Windows/LDAP login was enabled, provide the Windows credentials.

4. Click Login.
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Navigate to a Site
If a Portal contains multiple Sites, site options display in the Site Selector, which is located in the Portal
application bar. The list of Sites varies depending on whether or not you are logged in, which Sites the
system administrator has chosen to expose using the Site Selector, and your security rights.

You can also navigate to a Site directly by name using the URL http://server/CherwellPortal/SiteName
where server is the server where the CSM Browser Applications are installed and SiteName is the name
of the Site you want to visit. If you enter an invalid value or you omit the SiteName, you are taken to the
default Site.
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Log a Portal Record
The CSM Portal allows you to easily log Incidents and Requests using the Service Catalog. There are two
types of records you can log using the CSM Portal:

• Incident: An Incident is an unplanned interruption to a Service or a reduction in the quality of a
Service (ex: Something is not working).

• Request: A Service Request is a request for information, advice, a Standard Change, or access to a
Service (ex: Installation of new software). The Request form in the Portal will contain different fields
depending upon the type of service requested (ex: New Device vs. Network Request).

In the Portal, Incidents and Service Requests (often called Requests) are stored together in the Incident
Business Object. The Categorization (Service/Category/Subcategory) identifies the record as either an
Incident or Request and is decided by the Service chosen in the Service Catalog. You can also log an
Incident or Request using the Affects Me Too link on a Problem logged by another Customer or User.
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Log a Portal Incident
Customers can log an Incident from either the Service Catalog or a Configuration Item Form and they can
log a Service Request directly from the Service Catalog.

To log an Incident or Request from the Service Catalog:

1. In the Service Catalog, click Submit Incident or Request in the appropriate tile.

2. Complete the Incident Form.

Note: There is a Rich Text Editor available for this section.

3. Click the Submit button.

A window opens to notify you of the Incident ID number.

4. View the new Incident or Request by doing one of the following:
◦ Click the My Open Tickets tile to view the open Incident or Request in the My Incidents and

Open Requests section.

◦ Click the number next to Incident Tickets or Service Requests in the My Items section.
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Affects Me Too
Affects Me Too functionality is a way to log an Incident or Request that links to a similar, pre-existing
Problem in the Portal. When the Affects Me Too link displays on a Problem, a new Incident or Request
can be created with a unique ID number simply by clicking on the link.
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Navigate the Portal Site Discussion Board
The Portal Discussion Board (called Announcements from the Service Desk) provides a collaborative
environment for Customers (either internal or external employees) to share information in real-time. As a
Widget called, the Discussion Board can be customized using the Widget Manager.

On the Portal Discussion Board, Users can View a Discussion Topic.
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View a Discussion Topic
To view a discussion in the Discussion Board:

1. On the home page, click a discussion link in the Announcements from the Service Desk section.

The Discussion topic opens.

On the Discussion topic page, Users can:

• View the Message (a more detailed explanation of the problem/concern/announcement).

• Read the responses from other Customers and Users.

• Add a Comment.

• See who posted the discussion.

• Like the topic by clicking theLike this Discussion link to let other Customers and Users know if the
discussion was helpful or informative.
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Create a New Discussion Topic
To create a new discussion in the Discussion Board:

1. Click Charts and Items and then select My Items to open the My Items Dashboard.

2. Click the New Discussion link in the My Discussion Topics section. The Discussion Topic page
opens.

3. Specify the Subject.
4. Detail the question or concern in the Message field.

5. Click the Save button.
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Add a Comment
To add a comment from the Discussion Topic page:

1. Open an existing Discussion topic.

2. Click the Add a Comment link.

The Comment prompt opens.

3. Provide a comment.

4. Click OK.4. 
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Navigate Portal Knowledge Articles
Customers and technicians can access Knowledge Articles (How To Articles) to help solve issues without
having to log Incidents. Find Knowledge Articles in the Portal:

• Using the Search Control.

• Using the Search Knowledge Base search bar on the Out-of-the-Box (OOTB) Portal home page.

• Using the OOTB Knowledge Article Dashboard. Open the Dashboard by clicking Charts and
Items>Knowledge Articles on the menu bar.

From a Knowledge Article, Users can:

• Read through the Article Content.

• Allow technicians and other Customers to know if an Article resolved your issue:
◦ Click Yes if the Article helped.

◦ Click No if the Article did not help. The Incident is logged and a new window opens with the
Incident ID.

• Add a Comment by clicking the Add Comment link.

Customers can view or hide comments using the vertical splitter bar.

• Vote on the Knowledge Article by clicking the Like this Article link to let other Customers and Users
know that the Article was helpful or informative.
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Create a Knowledge Article in the Portal
Only members of the Portal Workgroup Manager Security Group have the rights to create new Knowledge
Articles in the Portal by default.

To create a new Knowledge Article in the Portal:

1. In the OOTB IT Portal Site, open the Knowledge Article Dashboard by clicking Charts and
Items>Knowledge Articles on the menu bar.

2. Click the Create a Knowledge Article link in the Search Knowledge Articles section. If the link is
not visible, review your Security Rights.

3. Select an Article Type.

4. Provide a Title and the Article Content.
5. Click Save.
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Designing a Portal
Portal design is important. Before creating a Portal:

• Answer some questions about audience, scope, and purpose.

• Review some Portal design tips.

• Consider how CSM features, such as Security and Site Items play into design.

• Start with the OOTB IT Portal Site for design ideas.
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Portal Design Worksheet
Before creating a Portal, you should ask yourself some basic questions to help drive the design.

 Question Consideration

1. Who is your audience (in other words, who are your Customers)?

a. Are your Customers internal
employees? External? Both?

• Portal login credentials.

• Anonymous login/Security Groups.

b.

Are your Customers
experienced? IT personnel who
can complete tasks by
themselves? Novice Customers
who need guidance? Both?

• Number of Sites (single Site or one for each expertise
level).

• Site Item and navigation design (simple or sophisticated).

• Portal Views (personalize and secure what Customers
see).

• Automation (Add One-Step Actions/Actions to simplify
tasks).

 

Tip: Expose Customers only to the information they need.

c.

Do your Customers have
different interests (different
Teams/different responsibilities
(ex: General Status for
Managers, Requesters of IT,
etc.)

d. Are your Customers
International? • Localization.

2. What will your Customers need to do in the Portal?

a.

Will your Customers view/
monitor data (Reports,
Dashboards)? Interact with data
(Action Catalog/create Incident
or Service Request)? Both?

• Add data-driven Site Items (Reports, Dashboards,
Document Repositories, etc.) or action-driven Site Items
(Actions to create/edit records, run One-Step Actions,
launch CSM Managers, etc.).

• Security Groups/security rights (View, Create, Delete).

• record ownership.

• License consumption.

b

What activities do your
Customers need on a Site (ex:
run a Report, create an Incident,
access documents (Doc
Repository), etc.?

• Create Site Items that deliver what Customers need most.

• Make information easy to find (Startup Item should be
informative).
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 Question Consideration

c. Will your Customers need
searching capabilities?

• Display a Search Control.

• Display Search Groups to automate Common searches.

• Add an Action to display the Search Manager (allows
custom Searches).

d. Will your Customers need to
access documents? • Display a Document Repository.

e. Will your Customers need to
access other websites? • Display an External HTML page or an External Site.

3. Will your Customers need access to data other than their own?

a.
Will your Customers need to
view/edit other Customers'
records?

• Record ownership.

• License consumption.

4. Will different Customers need different Security?

a. Will you allow Customers to
access data without logging in?

• Anonymous login/Security Groups.

• Different Startup Items for logged-in/anonymous
Customers.

b. Will you require a login? • Customers will need Portal login credentials.

c.
Will some Customers need
view-only rights? Will some
need edit rights?

• Anonymous login/Security Groups.

Note: For more information about considerations
and some helpful design tips, see Portal Design
Considerations and Portal Design Tips. For more
information about Security (Security Groups,
license consumption, scope, etc.) refer to the
Security documentation. For more information
about Site Items (including how to create each),
see their respective documentation.
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Portal Design Tips
The following are some tips to help design a Portal that meets the needs of your Service Desk and your
Customers:

• Make it easy to find: Layout and navigation are important. Strategically place important information
or commonly-accessed Services in obvious places. Use tables, bullets, columns, and headings to
elegantly organize information into logical and clearly-labeled groupings. Enhance navigation by
using an intuitive menu bar, Actions, links, etc.

• Make it easy to use: Keep it simple. Simplify Forms and Service Catalogs so that Customers are
only exposed to the information they need. Use Customer-friendly language so that Customers feel
comfortable with the content. Automate common tasks using One-Step Actions/Actions and
templates.

• Make it personal: The Portal is highly customizable so make each Customer's experience relevant
and personal. Create custom Dashboards and Forms, expose only relevant Services and
Knowledge Articles, dazzle Customers with meaningful graphics, colors, logos, etc.

• Make it enticing: Do not underestimate the visual experience. Employ visual elements, such as
graphics, symbols, and colors, to convey information and embellish the aesthetic. Use consistent,
browser-friendly fonts and colors (or themes) to ensure stability and cohesion.

• Make the Startup Items count: Your Startup Items set the tone for your Portal and Sites. Select an
Out-of-the-Box (OOTB) IT Portal Site that effectively introduces your Portal. Designate a Site
Startup Item that immediately communicates the purpose of your Site and provides clear access to
common Actions. For example, select an Action Catalog that clearly communicate your Service
offerings or a Dashboard that provides status, common Actions, and links.

• Proactively share: Post Advisories and Bulletins (Known Errors, outages, solutions, etc.) to help
avoid potential issues. Set expectations by communicating your Services and policies to avoid
confusion and misunderstandings.
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Portal Design Considerations
Consider the following when designing your Portal:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Customer Security Groups: Users (Service Desk professionals working in CSM) and Customers
(End-Users using the CSM Portal to conduct self-service activities) perform different functions in
CSM and, therefore, require different security. For more information, see User and Customer
Security Groups.

• Security rights: Security rights control access to CSM functionality and data. For example, to
create a Dashboard, you must have security rights to access the Dashboard Manager (functionality).
To view, add, edit, or delete the Description Field in an Incident record, you must have security rights
to access the Incident Business Object and the Description field (data). For more information, refer
to Security Rights in the Security documentation.

• Anonymous Access (allow Customers to access Portal data without logging in): CSM
provides an Anonymous Security Group for Customers who need to access the Portal without
logging in. The Portal Client uses this Anonymous Security Group to define security rights for those
anonymous Customers. For more information, refer to Anonymous Security Group in the Security
documentation.

• Portal Views: Use a Portal Form View to create Customer-specific versions of your Forms. A Portal
View allows you to expose data to Customers in a more secure and Customer-friendly way. For
more information, refer to Form Views in the Forms documentation.

• Record ownership: Access to records is controlled through record ownership. Typically, a
Customer owns and can access her own records. However, record ownership rights can be
extended to managers, Workgroups, and Workgroup managers so that Customers can update
records that are owned by another Customer. For more information, refer to Record Ownership in
the Security documentation.

• License consumption: A Customer can view, create, and edit her own records without consuming
a license. With security rights, a Customer can also view, and in some cases, edit (through a One-
Step Action) another Customer's records without consuming a license. For more information, see
Portal License Consumption.

• Site scope: CSM provides a Site scope, which allows you to limit CSM Items (Dashboards,
Reports, One-Step Actions, etc.) to a specific Portal Site. For more information, refer to Scope in the
Security documentation.

• Startup Site Items: Each Site has a designated Startup Item (ex: a Dashboard) which is displayed
by default when the Site is first accessed. If desired, a different Startup Item can be displayed upon
login so that information can be more securely or appropriately filtered based on credentials. For
more information, see Site Items.

• External Sites: The Portal can link to external websites using a simple link to a URL. For more
information, see External Portal Sites.
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Portal License Consumption
A Customer can view, create, and edit their own records without consuming a license. With security rights,
a Customer can also view, and in some cases, use a One-Step Action to edit another Customer's records
without consuming a license.

CSM notifies the Customer when a concurrent license is necessary. If the Customer does not have rights
to consume a license, they will be told that they cannot edit the record.

Note: A Site can be configured to always use a license. This might be done for a management-
focused Site where it is assumed that all work is done against other Customer's records).

Portal License consumption rules:

• A Customer logging in to CSM through the Portal to view/edit their own records (they are the
Customer Record owner, meaning they are the Requester/Initiator and is associated with the record)
does not consume one of the concurrent licenses.

• A Customer logging in to CSM through the Portal to access someone else's records (they are not
the Requester but has been granted access rights) does not consume a license to view the record
but does consume a license to edit a record.

• A Customer can run some One-Step Actions without consuming a license:
◦ One-Step Actions Actions that do not alter data can be run without consuming a license (ex:

Send an e-mail).

◦ One-Step Actions Actions that do alter data can be run against records owned by the
Requester without consuming a license.

◦ One-Step Actions Actions that alter data generally consume a license when run against a
record owned by someone other than the Requester. However, there are a handful of
situations where a One-Step Action is allowed to change another Requester’s record without
consuming a license:

◦ Creating a journal entry: For example, allowing a Customer to provide feedback on an
Incident or Knowledge Article even if they are not an owner/requester.

◦ Rating a record: Toggling a logical field or incrementing the count in a numeric field (ex:
Allowing a Customer to vote on whether or not they liked a Knowledge Article). The Field
must be appropriately configured by the administrator to hold a rating value.

Note: For more information about licensing, refer to License Consumption in the
Security documentation.
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External Portal Sites
The Portal can link to external websites using a simple link to a URL. This helps make all of your
Customer-facing Sites feel more integrated because CSM and non-CSM Sites show up next to one-
another. For example, incorporate your organization's website or a department's website into the Portal,
or add a website that supports your hardware.
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Portal Site Design Ideas
CSM provides an OOTB IT Portal Site to get started. This OOTB IT Portal Site is built using OOTB Site
Items (Dashboards, Forms, etc.) and predefined properties (Startup item, header/footer, menu bar, etc.).
You can use this OOTB IT Portal Site as-is, or tailor it to meet the needs of your organization. Design
ideas include:

• Edit the site display for logged-in and not logged-in modes.

• Edit the banner.

• Edit display options for the footer.

• Display your organization logo in the banner and/or footer.

• Display organization Business Hours.
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Implementing a Portal
Complete the following steps to implement the OOTB IT Portal Site:

1. Review the OOTB IT Portal Site. Understand the OOTB Site Items (Dashboards, the Service
Catalog, the Discussion Board, the Document Repository, etc.) and the OOTB properties (header/
footer, menu bar, etc.).

2. Configure required Portal settings:
a. Configure the Portal URL.

b. Set the default domain in CSM Administrator.

c. Create Portal login credentials (for a Customer). Typically, this is done as part of the Security
setup.

Note: CSM provides other default settings (ex: Anonymous login, password
enforcement rules, etc.); you can change these, if needed, but it is not required.

3. (Optional) Explore Portal Site design ideas.

4. (Optional) Create a custom Portal.
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Steps to Implement the OOTB IT Portal
Complete the following steps to implement the OOTB IT Portal Site:

1. Review the OOTB IT Portal Site. Understand the OOTB Site Items (Dashboards, the Service
Catalog, the Discussion Board, the Document Repository, etc.) and the OOTB properties (header/
footer, menu bar, etc.).

2. Configure required Portal settings:
a. Configure the Portal URL.

b. Set the default domain in CSM Administrator.

c. Create Portal login credentials (for a Customer). Typically, this is done as part of the Security
setup.

Note: CSM provides other default settings (example: Anonymous login, password
enforcements rules, etc.); you can change these, if needed, but it is not required.

Note: If you want to use internal credentials on a default domain, you must type
CHERWELL\ in front of the username (example: CHERWELL\Bob) in order to log in.

3. (Optional) Explore Portal Site design ideas.
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Create a Custom Portal
CSM is shipped with an Out-of-the-Box (OOTB) IT Portal Site, complete with Portal-specific Forms,
Dashboards, etc. We recommend starting with this design, and then tailor it. However, Users can create a
Portal from scratch, if needed.

To create a custom Portal:

1. Design the Portal (Site items, navigation, security, etc.)

2. Create the Site Items to include on each Site. Users can include the following:
◦ Business Objects/records

◦ Actions

◦ Action Catalogs

◦ Dashboards and Widgets

◦ Document Repositories

◦ HTML Pages

◦ Reports

◦ Search Groups

◦ Searching (rich searching, combined searches and results)

Note: For more information about how to create each item, see their perspective
documentation.

3. Run the Site Wizard to create one or more cursory Sites: Create cursory layout and characteristics
for the Site (title, Business Object associations, display, and Document Repository association).

4. Refine/edit Sites using the Site Editor and Site Properties window: Refine the way the Site/Site
Items look and behave.

5. Configure the Portal (settings, login credentials, password enforcement rules, etc.).
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Building/Managing a Portal
Portals are highly configurable. When you create your Portal, you decide how many Sites to create, which
Site displays by default, how each Site looks, which Site Items are displayed on each Site, and who can
access each Site/Item.

To help create/manage your Portal, CSM provides the:

• Site Manager: Helps manage Sites.

• Site Wizard: Walks through the steps to create a cursory Site.

• Site Editor and Site Properties window: Help edit/refine the way Site/Site Items look and behave.
They can also help localize your Site or define custom documentation settings for a Site.

• CSM Item Managers: Help manage Site Items, such as Dashboards, HTML pages, Document
Repositories, etc.

Note: Good design is important. Before creating a Portal, see Designing a Portal.
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Site Manager
Use the Site Manager to complete general CSM Item Manager operations for Sites. You can also mark a
Site as the default Site for the Portal.

1. Menu bar:

Displays a row of drop-down menus available in the Manager.

2. Toolbar:

Displays a row of buttons for operations available in the Manager.

3. Search Control:

Displays a search box to find specific words or phrases in the Manager.

4. Manager tree:

Displays items in a hierarchical tree, organized by scope, and subfolder if applicable. Also lists any
Searches run during the session.
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5. Main Pane:

Displays items by View (Icon, List, or Details (Grid) and lists search results when a Search is run.
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Open the Site Manager
To open the Site Manager:

• From the Blueprint Editor menu bar in CSM Administrator, click Managers>Site Manager.
• In the CSM Administrator main window, click the Browser and Mobile category, and then click the

Site Manager task.
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Create a Site
The Site Wizard helps you create a basic working Portal. The Site Editor/Site Properties window helps
you add refinement. You can forgo refinement, if needed, or you can click Finish at any time in the Wizard
and go straight to refining.

To create a Site:

1. Run the Site Wizard to create a cursory Site: Create cursory layout and characteristics for your Site
(title, Business Object associations, display, and Document Repository association).

2. Refine/edit your Site using the Site Editor and Site Properties window: Refine the way your Site/Site
Items look and behave.

a. Define general properties for the Site: Define the name and title, login requirements, record
ownership, the Business Object/record associations (which Business Objects/records the
Customers can interact with), and the Document Repository association.

b. Define display properties for the Site: Define appearance (color/theme), Startup Site Items,
and search capabilities.

c. Define Banner properties for the Site: Define what the Site Banner looks like (background
color and image, and Banner image) and what text displays on it (title, subtitle, and baseline).

d. Define Footer properties for the Site: Define what the Site Footer looks like (background color
and image, and Footer image) and what text displays on it (title, subtitle, and baseline).

e. Define menu properties for the Site: Define which Site Items display on the Site menu bar, and
which Actions a Customer can initiate from each.

f. Define Localization properties for the Site: Define translation options.
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Create a Site Using the Site Wizard
To create a Site using the Site Wizard:

1. Open the Site Manager.

2. Click the Create New button, and then select Site.

Note: To create an External Site, one that simply displays an existing website, select
External Site. The External Site window opens to provide the URL and other options.

Click Next.

3. Define basic properties for the Site:

a. Specify a title for the Site that displays in the Banner.a. 

The Name and Description initially include text that you can refine later. The Name becomes
part of the URL for referencing this Site in a browser. The Description is shown in the Site
Selector when Customers switch between Sites.

b. Select a Theme (set of fonts, colors, and options) to be used by different elements. Using ab. 
Theme simplifies the cohesive look. You can change the Theme at any time, which
automatically updates the various elements.

If the Theme is changed, refresh the browser to view the changes.

c. Click Banner image to launch the Image Manager, and then select an image to display on thec. 
Site Banner. You can select an existing image or import a new image.

4. Click Next.
5. Select the Business Objects/records to include on the Site:

Note: These are the Business Objects with which you want your Customers to interact. For
example, if you want Customers to be able to view or create Incident records, select the
Incident Business Object.

a. Click Add to include Business Objects/records on the Site.

Tip: Use the up and down arrows   to order the Business Objects on the Site
menu bar and to indicate the relative importance of a Business Object on the Site.
Click Remove to remove a selected Business Object from the Site.

b. Select the Add newly associated objects to site menu check box to automatically add the
associated Business Object to the Site's menu bar.

Note: When you add a Business Object to the Site's menu bar, CSM adds a Business
Object menu option and some Out-of-the-Box (OOTB) Business Object Actions. For
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example, if you add Incident to the menu bar, CSM adds an Action to create a new
Incident, as well as Actions to launch some Incident searches (My Open, Closed, and
Recent Incidents). You can use these Actions, modify them, or create your own when
you define the menu properties.

6. Click Next.
7. Select the Document Repository to include on the Site:

Tip: You can use multiple Document Repositories on a single Site. Within the Site Editor,
you can add an Action to display another Document Repository on the Site menu bar.

◦ Select Create new document repository named to create a new Document Repository for
this Site. Then, name the Document Repository (or leave the auto-generated name).

◦ Select Associate an existing document repository to use an existing Document Repository

for the Site. Click the Ellipses  to open the Document Repository Manager, and then
select an existing Document Repository or create a new Document Repository.

◦ Select Do not associate a document repository to forgo using a Document Repository on
the Site.

Click Next.

8. Select a Startup Site Item from the following:

a. Select Dashboard to display a Dashboard on startup. Click the Ellipses  to open thea. 
Dashboard Manager, and then select an existing Dashboard or create a new Dashboard.

b. Select Page to display an HTML page on startup. Click the Ellipses  to open the HTML
Page Manager, and then select an existing HTML page or create a new internal or external
HTML page.

c. Select Other to display an Action Catalog Widget, a Document Repository, a Report, or a

Search Group on startup. Click the item's Ellipses  to open the Action Manager, and then
select an existing item.

d. Select The site requires the user to log check box to require Customers to log into the Site.
If you do not require a login, you can specify a different Startup Item for when the Customer
finally does log in.

Note: A license is consumed when a Customer logs in.

9. Click Finish.9. 
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Refine/Edit a Site
Use the Site Editor and Site Properties window (both accessed from within the Site Manager) to edit a
Portal Site and its Site Items.
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Define General Properties for a Site
Use the General Properties page to edit basic Site features that may have initially been defined in the Site
Wizard. Edit and customize the Site title, login requirements, document repository association, and
Business Object association.

To define General properties for a Site:

1. Open a Site in the Site Editor (CSM Administrator > Browser and Mobile > Site Manager >
Portal Site Name)

2. Click the General page.

3. Define general properties for the Site:
a. Title: Provide a title to display in the Portal UI. The Site title and Banner title were intially

created in the Site Wizard, but can be edited here.

b. Description: Provide a description to display in the Portal UI.

4. Define access options for the Site:
a. Show in Site Selectors: Select this check box to include the Site name in the Site Selector

drop-down. The Site Selector is located on the Site Application Bar in the Portal Main Page.

b. Require login for access to site: Select this check box to require Users to login to the Site.

c. Acquire a license at login (so editing other Users' records will not require a prompt): Select this
check box to acquire a license for the User upon login.

d. Acquire a license on edit (suppress prompt): Select this check box to acquire a license for the
User upon editing another User's record while suppressing the prompt to acquire the license
(example: A Site intended for managers that are editing other User records).

5. Select Business Objects to associate with the Site:
a. Click the Add button.

b. Select a Business Object from the list. Choose Business Objects for Users to interact with
(example: If a User needs to view or create Incident records from the Site, select the Incident
Business Object).

c. Repeat Steps A and B for all desired Business Objects.

d. Add newly associated objects to site menu: Select the check box to automatically add
associated Business Objects to the Site's menu bar.

6. Select a Document Repository to include on the Site.
a. Select the Associate an Existing Document Repository checkbox.

b. Click the Ellipses button. The Document Repository Manager opens.

c. Select an existing Document Repository or create a new Document Repository.

d. Click OK to close the Document Repository Manager.

7. Click OK to close the Site Editor.
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Define Display Properties for a Site
Use the Display Properties page to further customize your Site by refining startup Site items, login
options, search capabilities, browser tab images, and custom documentation. The Display page can also
be used to further refine the Site's appearance and Theme.

Define General Appearance Properties
Refine your Site's appearance and Theme by completing the following steps:

1. Open a Site in the Site Editor (CSM Administrator > Browser and Mobile > Site Manager >
Portal Site Name)

2. Select the Display page.

3. In the Appearance section, define the following:
a. Theme: Select a Theme from the drop-down to define sets of colors, styles, and fonts for the

Site.

b. Background: Select a color from the drop-down to define the Site's background color. It is
recommended to use From Theme as the background color.

c. Show Site Selector on application bar: Select this check box to display the Site Selector drop-
down on the Portal Application Bar.

d. Keep menu visible when scrolling: Select an option from the drop-down to define whether the
Site menu bar should remain visible or not while scrolling.

4. Click OK.

Define Startup Site Items
Define items that appear on Site startup, as well as items that appear after a User has logged in by
completing the following steps:

1. Open a Site in the Site Editor (CSM Administrator > Browser and Mobile > Site Manager >
Portal Site Name)

2. Select the Display page.

3. In the Startup section, define the following:
a. Show on startup: Click the Ellipses button to select a Site Item to display when a User initially

accesses the Site. Options for the Site Items include Widgets, Dashboards, Reports, HTML
pages, or Search Groups.

b. Show on login: Select this check box to display a different Site Item if/when the Use logs in.
Then, select the Site Item to display by clicking the Ellipses button.

c. Define Custom Documentation Settings for a Site.

d. View: Select a View option from the drop-down. View options control the behavior and
appearance of Business Objects within the Site. Options include:

◦ Role-based: Based on the default Role associated with the User's Security Group.
Different Users see different Business Object Forms based on security.
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◦ Portal Default: Provides the OOTB Portal View for Business Objects within the Site.

◦ Portal Secondary: A View option for smaller, secondary Sites that may supplement or
support your main Site.

◦ Default: The Default Site View is not recommended because it also displays technician
forms, which are not relevant for Site Users.

e. Login options: Click the Login Options button to customize login text, avatar appearance, or
include custom URLs.

4. Click OK.

Define Login Options
Customize what Users see on login by completing the following steps:

1. Open a Site in the Site Editor (CSM Administrator > Browser and Mobile > Site Manager >
Portal Site Name)

2. Select the Display page.

3. Select the Login Options button to define the following:
a. Text to display on login dialog: Provide a message to display on login.

b. Show privacy link in login dialog: Select this check box to display a link to a Privacy statement,
then provide text for the link and the URL to the Privacy document.

c. Custom avatar image: Click the Image button to open the Image Manager, then select default
images to display for a non-logged-in Customer and a Customer without an assigned avatar.

d. Redirect User on Logout: Select this check box to automatically redirect Customers to a
specified URL when they log out of the Portal. Then, provide the URL where you want them to
be redirected (example: http://www.cherwell.com), or click the Browse button and select a
website where Customers will be redirected after logging out of the Portal.

4. Click OK.

Define Search Control Options
The search bar is located below the Site menu bar, to customize Search Control Options, complete the
following steps:

1. Open a Site in the Site Editor (CSM Administrator > Browser and Mobile > Site Manager >
Portal Site Name)

2. Select the Display page.

3. In the Search area, select a Search Option radio button:
a. Use default: Select this radio button to use the OOTB CSM Search Control options that are

based on the list of Associated Business Objects from the General page.

b. Use search widget: Select this radio button to use a custom Search Widget. Click the Ellipses
button to open the Widget Manager and select a Widget.
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c. No search: Select this radio button to omit searching from this Site by removing the no Search
Control. However, you can still create Search Widgets and place them on Dashboards to allow
for target searching.

4. Require login before showing search results (excluding Dashboards): Select this check box to
require a User to login before performing a search. If a Search is performed without requiring the
User to login, the Search results are based on security rights of the Anonymous Security Group.

5. Click OK.

Define Browser Tab Properties
To add a custom image to your Site's browser tab:

1. Open a Site in the Site Editor (CSM Administrator > Browser and Mobile > Site Manager >
Portal Site Name)

2. Select the Display page.

3. Select the Use Favicon check box.

4. Click the Ellipses button. The Image Manager opens.

5. Upload a new image or choose an existing image:
a. Click the New button to upload a new image (example: your company logo).

Note: Favicon images have a size limit of 512K. An error message appears if the
uploaded image is too large.

b. Select an existing image from the Image Manager. The name of the selected image populates
the Favicon field.

6. Click OK to close the Image Manager.

7. Click OK to close the Site Properties page. The selected image is now visible in the tab of browser
windows.

Disable or Enable Custom Portal Documentation
By default, the Portal links Users to the default Cherwell online documentation system. Due to the highly
configurable nature of the Portal, a customer may wish to disable this feature, or link to a custom online
documentation system.

To disable default Portal documentation:

1. In the CSM Administrator Client, click Browser and Mobile > Site Manager.
2. Select the desired Portal (example: IT Service Desk).

3. Click the Edit button. The Site Properties page opens.

4. Select the Display page.

5. Uncheck the Show help button checkbox to remove the default help button from the Portal.

6. Click OK.
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To enable custom Portal documentation:

1. In the CSM Administrator Client, click Browser and Mobile > Site Manager.
2. Select the desired Portal (example: IT Service Desk).

3. Click the Edit button. The Site Properties page opens.

4. Select the Display page.

5. Select the Use custom URL radio button.

6. Provide an alternate URL in the Help URL field (example: a link to an internal documentation
system or training documents). This URL replaces the default Cherwell online documentation
system URL.

Important: The URL must be a full URL (example: https://www.sample.com) and not a
partial URL (example: sample.com).

7. Click OK.
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Define Banner Properties for a Site
Use the Banner Properties page to edit the Site Banner. Some aspects of the Banner may have initially
been defined in the Site Wizard. Edit and customize the Banner size, color, fonts, and associated images.

To define Banner properties for a Site:

1. Open a Site in the Site Editor (CSM Administrator > Browser and Mobile > Site Manager >
Portal Site Name)

2. Click the Banner page.

3. Select the Show Header checkbox to display a Banner at the top of the Site.

4. Define a Banner background by doing one of the following:
◦ Click the Color Selector button to select a background Banner color.

◦ Click the Image button to select an image to use as the Banner background.

5. Define a Banner image (example: your company's logo):
a. Click the Browse button. The Image Manager opens.

b. Select an image.

c. Click OK.

d. Provide pixel dimensions for the image in the Size field.

e. Click the Align drop down to edit the alignment of the image within the Site Banner.

6. Provide a Title for the Site in the title field.

7. Click the Image Selector button in the Title area to change the color of the title.

8. Provide a Subtitle for the Site in the subtitle field.

9. Click the Image Selector button in the Subtitle area to change the color of the subtitle.

10. (Optional): Provide any additional text for the Site Banner in the Baseline Text field (example:
copyright notices).

11. Define a Hamburger Menu image (example: your company's logo):
a. Click the Browse button. The Image Manager opens.

b. Select an image.

c. Click OK. The selected image appears in the Hamburger Menu image preview field.

Note: CSM automatically scales images to a height of 25 pixels. The hamburger menu
bar replaces the Portal menu bar on mobile screens and browser windows sized below
768 pixels.

12. (Optional): Select the Fixed Height check box to make the Banner a fixed, specified height. If
unchecked, the Banner resizes to accommodate selected text, images, and margins.

13. (Optional): Select the Extend Banner fo Application Bar check box to automatically resize the
Banner based on the Site's Application Bar.

14. Click the Margins button to define top, bottom, right, and left margins around Site text.
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15. Click OK.15. 
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Define Footer Properties for a Site
Use the Footer Properties page to define background color, images, text, font, and Footer size.

The Site Footer is located at the bottom of the Site, and can provide additional general information (such
as a copyright notice) or aesthetic value. Use a Site's Footer Properties page to define:

• What the Footer looks like (background color and image, and Footer image).

• What and how text displays on the Footer (title, subtitle, and baseline text, fonts, and colors).

• The Footer's height and position (relative to a margin).

To define Footer properties for a Site:

1. Open a Site in the Site Editor (CSM Administrator > Browser and Mobile > Site Manager >
Portal Site Name)

2. Click the Footer page.

3. Select the Show Footer check box to display a Footer at the bottom of the Site.

4. Define a Footer background by doing one of the following:
◦ Click the Color Selector button to select a background Banner color.

◦ Click the Image button to select an image to use as the Banner background.

5. Define a Footer image (example: your company's logo):
a. Click the Browse button. The image manager opens.

b. Select an image.

c. Click OK.

d. Provide pixel dimensions for the image in the Size field.

e. Click the Align drop down to edit the alignment of the image within the Site Banner.

6. Provide a Title for the Site Footer in the title field.

7. Click the Image Selector button in the Title area to change the color of the title.

8. Provide a Subtitle for the Site in the subtitle field.

9. Click the Image Selector button in the Subtitle area to change the color of the subtitle.

10. (Optional): Provide any additional text for the Site Footer in the Baseline Text field (example:
copyright notices).

11. (Optional): Select the Fixed Height check box to make the Footer a fixed, specified height. If
unchecked, the Footer resizes to accommodate selected text, images, and margins.

12. Click the Margins button to define top, bottom, right, and left margins around Site text.

13. Click OK.13. 
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Define Menu Bar Properties for a Portal Site
Use the Site Menu Properties page to define menu items, Actions, tooltips, Expressions, and Security
options for the Site menu bar.

The Site menu bar is located below the Banner and lists the Site Items, as well as any Actions that
support the items. Use a Site's Menu Properties page to define:

• Which Site Items display (as menu items) on the Site menu bar.

• Which Action the menu item initiates: Displays a Dashboard, Service Catalog, or Document
Repository; runs a report, display a record, etc.

• The Help text that displays on the menu item's tooltip.

• Expressions for showing/hiding and enabling/disabling menu items.

• Security options for showing/hiding and enabling/disabling menu items: For example, Always show,
show only for Anonymous (not logged-in Customers), or show only for Logged-in Customers.

• Display options (separators) for groups of menu items.

Add Menu Items to Site Menu Bar
To add menu items and define menu item properties:

1. Open a Site in the Site Editor (CSM Administrator > Browser and Mobile > Site Manager >
Portal Site Name).

2. Click the Menu page.

3. Select the Show Menu check box to add a menu bar to the Site.

4. Click the Add Action button.

5. Select an Action to add to the menu bar. For more information, see Define Business Object Actions
or Refine/Edit a Site Reference.

6. Define general properties for selected Action:
a. Action name: Cannot be changed, displays the name of the selected Action.

b. Display text: Specify the text to display in the menu bar.

c. Select the Image Manager button.

d. Select an existing image or import a new image to represent the Action in the menu bar
(example: a house icon for Home).

e. Help text: Specify a tool tip to display when the cursor is on the menu item.

7. (Optional): Define an Expression to display in the menu bar:
a. Select the Visible check box. An Expression can still be imported if this check box is

unchecked. If so, the Expression still runs in the background and is not visible in the menu bar.

b. Select the Ellispes button to import an existing expression or select the Custom Expression
button to create a new expression. Imported expressions populate the Visible Expression
drop-down.

8. (Optional): Define an Expression to enable or disable an item in the menu bar:
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a. Select the Enabled check box.

b. Select the Ellispes button to import an existing expression or select the Custom Expression
button to create a new expression. Imported expressions populate the Visible Expression
drop-down.

9. Select security options from the drop-down menus to define rights for displaying, enabling, or
disabling the menu item:

◦ Visible: Select whether menu items are visible for all Portal Customers (Always), only Logged-
In Portal Customers (Logged-in Only), or only Portal Customers who are not logged in
(Anonymous Only).

◦ Enabled: Select whether menu items are enabled for all Portal Customers (Always), only
Logged-In Portal Customers (Logged-in Only), or only Portal Customers who are not logged in
(Anonymous Only).

◦ Rights: Assign Portal rights to make menu items visible/enabled for a Customer Security
Group.

10. (Optional): Select the Begin Group check box to display a horizontal line before menu items on
sub-menus to separate the sub-menu from other items.

11. Repeat Steps 4-10 for all desired menu items. Selected menu items populate the left-hand Action
pane.

12. Click OK.

Related concepts
About Actions
Create Portal Login Credentials (for a Customer)
Refine/Edit a Site Reference
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Define Localization Properties for a Site
Use the Localization page to define custom Localization properties for different areas of the Site.

The Portal can be easily translated into other languages, even languages into which the main CSM
product has not been translated. To do so, you must:

• Translate platform strings that are used throughout the Portal. This includes error messages and
general display items.

• Translate each Site in the Portal. This includes the text for menu items and other commands.

• Specify custom options for each language, such as a custom Startup Item.

There are two methods for translating Portals into multiple languages:

1. Use Language Packs to translate string used by Sites. When you apply a Language Pack that
contains Portal strings, a Site Localization is automatically added to the Sites contained in the
Language Pack.

2. Use a Site's Localization page to export the Sites and Portal strings to an XML file that can be
translated, and then import the translated strings. The XML file will contain referenced values for
each string that can be displayed in the particular Portal, for example:

<Property Name="Header_TitleText">IT Self-Service</Property>

If this is edited to be in German:

<Property Name="Header_TitleText">Informationstechnologie</Property>

Defining Localization Properties for a Site
To define Localization properties for a Site:

1. Open a Site in the Site Editor (CSM Administrator > Browser and Mobile > Site Manager >
Portal Site Name).

2. Click the Localization page.

Note: If you have already defined translation properties for the culture, you can select it in
the list and click Export; otherwise move to the next step.

3. Define translation properties for the culture to which you want to translate:
a. Click the Add button.

The Site Localization Properties window opens, alphabetically listing the available cultures
(both the language/country and culture code are displayed to make it easy to find the correct
culture).

b. Language/country or culture code: Select a culture to which to translate using either drop-
down. The Name field automatically defaults to the language/country.
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c. Flag/icon: The image identifies the culture by flag. This will be displayed next to the language
in the Language Selector on the Site Application Bar. Click the icon to change it, if needed.

d. View: If you have a custom View defined for the language, select the view here. If the option is
left as Role-based, then if there is a view associated with a selected view that has an
appropriately assigned language, that Role/View will automatically be used:

e. Site Overrides: Select Startup Site Items for the translated Site if you have a custom-translated
item (such as a translated Dashboard or HTML Page). If you do not select anything here, the
Startup Item will be the same as for the OOTB Site.

f. Define login options for the translated Site. If you want to have alternative text or a Privacy
Link on the login window, you can enter it by clicking the Login Options button:

g. Click OK.g. 

The culture is added to the list and OOTB language options now display in the window.

4. Export all the Portal strings into an XML file that can be translated:
a. Select the Localization/culture to export.

b. Click the Export button.
The Export window opens.

c. Click the Browse button to select a destination for the exported strings file (Cherwell
Localization Definitions go into files with the .cld extension).

Note: The following check boxes are only relevant when exporting a previously-
translated Localization.

d. Include all portal strings: Select this check box to delete any strings that were removed from
the Site since the last translation (for example, if you have removed items from the Site menu
bar, checking this check box would remove them from your Localization file).

e. Remove strings that are no longer used: Select this check box to delete any strings that were
removed from the Portal since the last translation. For example, in the next version of the
Portal there might be a couple of messages that are no longer used. Checking this check box
would remove them from your Localization file.
Tip: After the export you will be given a chance to view the file. The first time, you will most
likely have to pick a file association before the file can be opened. The export file holds XML
so it is best to associate an XML Editor with the .cld extension. You can also use Windows
Explorer to set up the file association.

5. Translate the exported XML file using an XML Editor, your favorite translation tool, or even Notepad.

6. When you have finished translating the file, click the Import button to import the file back into CSM.

7. Associate a culture with the default Site: This allows for the default language to display in the
Language Selector on the Site Application Bar.

a. Language name/Language: Select a culture using either drop-down. The Name field
automatically defaults to the language/country.

b. Flag/icon: The image identifies the culture by flag. Click the icon to change it, if needed.

c. Show language selector on application bar: Select this check box to give Customers a choice
to display either the translated or default Site.
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8. Click OK.8. 

Related concepts
Translating Strings for Portal Sites
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Refine/Edit a Site Reference
Additional details for refining and editing a Site.

Available Menu Bar Actions
The following are Actions that can be added to the menu bar:

• One-Step Action: Runs a One-Step Action. You can choose to run an existing One-Step Action or
create a new One-Step Action.

• Command: Runs a system command applicable to the Portal. Categories include:
◦ Managers: Adds a command to launch an Item Manager so that a Customer can choose an

item to open/run (ex: Add the Report Manager to the Site menu bar so that Customers can
choose to run an available Report).

◦ Recent Items: Provides a Recent Items list that displays the last five (5) items of the specified
type selected by the Customer (ex: the last five Reports run by the Customer). This makes
sense if you have made the Manager available.
Note: Recent Items lists must be placed inside folders (they cannot be at the top level of the
Site menu bar), and it is recommend that they be placed as the last item in the folder.

◦ Chat: Includes commands related to remote support services (example: Bomgar) (only
available if you have Chat and Remote Support Connector Settings enabled in CSM
Administrator).

◦ (Other) Business Object Search: Provides common Site searches (example: Business Object
to search, how the results should be sorted, whether to limit to the current Customer, limit to
Open or Closed records, etc.).

◦ (Other) Create Business Object: Creates a new Business Object (record) but with several
powerful options, such as a One-Step Action to run as part of the creation process and
whether a custom Form should be displayed (which can be different than the OOTB Form
used for viewing a Business Object).

◦ (Other) Go to Edit Mode: Puts a Business Object record into edit mode so that a Customer or
User can immediately edit it. This command is designed to be used in an Execute Command
One-Step Action, which is the automated equivalent of a Customer or User clicking the Edit
button in the Portal.

◦ (Other) Home: Takes the Customer to the Startup Item (Dashboard, HTML page, etc.).

◦ (Other) New Bus Ob Drop-down: Automatic command that displays a default list of create
commands for all Associated Business Objects for the Site.
Note: This command must be placed in a folder.

• Dashboard: Displays a Dashboard. You can display an existing Dashboard or create a new
Dashboard.

• Report: Runs a Report. You can run an existing Report or create a new Report.

• Search: Runs a Search Group. You can run an existing Search Group or create a new Search
Group.

• Page: Displays an HTML page. You can display an existing HTML page or create a new HTML
page.
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• Document Repository: You can display an existing Document Repository or create a new Document
Repository.

• Action Catalog: Displays an Action Catalog. You can display an existing Action Catalog or create a
new Action Catalog.

• Folder: Adds a folder to the toolbar so that you can organize Actions into another level.
Note: Some Actions also allow you to limit scope and Associated Business Object (click the
activated Options button). We recommend that you limit Customers to just the Site scope and make
items available in just that scope.

Available Site Items
Available Site Items that can be selected for a Portal Site include:

• Action Catalog, (special Widget), a Dashboard, a Document Repository, an HTML page, a Report,
or a Search Group (used to display a list of records).
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Select a Startup Portal Site
If you have more than one Site on your Portal, you can choose a Site to first display if the Customer goes
to the main (or an invalid URL):

http://MyServer/CherwellPortal

Customers can also go directly to a particular Portal Site by specifying it as part of the URL:

http://MyServer/CherwellPortal/IT

To select a Startup Portal Site:

1. Open the Site Manager.

2. Right-click and Site, and then select Set as Default.

3. Click OK.3. 
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Troubleshoot a Portal Site
Use the following table to troubleshoot Portal issues.

Problem Solution

Cannot access tools to create
a Portal or Site

Check your functionality rights (CSM Administrator>Security>Edit
security groups>User Security Group>Rights tab).

Customer cannot access a
Portal or Site

Check the Customer's functionality rights (CSM
Administrator>Security>Edit security groups>Customer Security
Group>Rights tab).

Customer cannot access data
on a Portal or Site

Check the Customer Security Group's data rights(CSM
Administrator>Security>Edit security groups>Customer Security
Group>Business Objects tab).

Portal does not display correct
form

Make sure the forms where designed in the Portal View not in the
Default View.

Query does not work
Make sure the query is set up correctly (that is, not limited to a
particular group, etc.). Also, check security; records might not show up
if the Customer does not have appropriate rights.

Automatic Actions not working Make sure automatic Actions are run from the Portal View not the
Default View.

Customer can edit another
Customer's record Change the record ownership rights.

Windows Account not
registered message Create login credentials for the Customer.

CSM 9.4.0 Client Suite 209

CSM 9.4.0 Client Suite



Configuring a Portal
Before Customers can access a Portal, you must:

• Configure Portal security rights.

• Configure Client Application settings (URL, timeout, and access to RSS Feeds).

• (Optional) Specify a default domain for the Portal.

• (Optional) Configure login, authentication, and inactivity settings for the Portal (only if you want them
to be different than the Desktop Client).

• Configure anonymous login settings.

• Configure Cherwell credential settings (User/Customer password rules).

• Configure Miscellaneous Browser/Portal Settings.

• Create Portal login credentials (for a Customer).

Note: The majority of the configuration is conducted from the Browser and Mobile Settings
page in CSM Administrator.
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Configure Portal Security Rights
Because Portal access must be set differently for Anonymous Browsers as well as logged-in Customers,
there are several places that Portal security rights must be set in CSM Administrator before Users and
Customers can access the Portal. The following are all the rights that must be configured for Anonymous
Browser and Portal Customers:

• Application rights

• Browser and Mobile device rights

• Calendar rights

• Chat Service Integration rights (Bomgar)

• Command Manager rights

• Dashboard rights

• Document Repository rights

• HTML Page rights

• Knowledge rights

• Record locking rights

• One-Step Action rights

• Report rights

• Searches rights

• Security features rights

• Sites rights

• Sites Manager rights

• Users rights

• Visualization rights

• Web Service One-Step Action rights
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Config Management Page
Use the Browser and Mobile Settings page (CSM Administrator>Browser and Mobile) to access many
of the Portal and Browser Client management and configuration tasks, including:

• Site Manager: Use to manage Portal Sites.

• Browser Application Settings: Use to configure URLs, session timeouts, and RSS Feeds.

• HTML Page Manager: Use to manage HTML Pages.

• Document Repository Manager: Use to manage Document Repositories.

• Twitter Account Manager: Use to manage Twitter Accounts.

• Web Services Manager: Use to configure web services used for One-Step Actions.

• Edit Mobile Configuration: Use to set defaults (Dashboards, Business Objects, and Actions) for the
entire system or for each Role for Cherwell Mobile™.

• Open Mobile Dashboard Editor: Use to manage Mobile Dashboards specifically designed for use on
mobile devices.
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Multi-Tab Browsing Support
The Browser Client and Customer Portal allow you to operate in multiple web browser tabs, which
enables you to work on multiple pages within CSM. This allows technicians, system administrators, and
customers to work more efficiently.

Multi-tab browsing allows you to:

• Open CSM in up to five tabs in the same browser window (or multiple browser windows).

• Log in via the first tab and then load CSM in additional tabs without needing to log in again or
consume additional licenses.

• Work with multiple CSM features at the same time. For example, a technician might log an Incident
in one tab and view their default Dashboard in another.

• Open tabs in multiple languages (using the Culture Selector) and work in the tabs independently
within the same session. If a User has multiple tabs open in different languages and the session
expires or the User manually logs out, the User is logged out of all tabs. When the User logs back in
to a tab, the language for that tab automatically resets to the default language for the User's Role;
the other tabs reload using the language that was selected before the User logged out.

Note: You must have Globalization enabled to use the Culture Selector.

Multiple features use a unique tab display name, which allows Users to easily identify what they are
working in each tab. Features that support tab names include:

• Forms: Major Business Objects (Incident, Problem, etc.) use the Public ID field to populate the tab
name. The Public ID is defined in the Business Object Properties window.

• Quick Search: Quick Search results use the phrase Quick Search Results and Business Object
Quick Search Results use the phrase <Business Object> Search Results in the tab name.

• Search Groups: Searches use the phrase <Search Name> Search Results in the tab name.
Search names are defined using the Search Manager.

• Tools: Tool drop-down items (Contact Manager, Table Management, and CMDB) use the phrase
<Tool Name> Search Results to populate the tab name.

• Reports: Reports use the phrase <Report Name> in the tab name. Report names are defined using
the Report Manager.

• Dashboards: Dashboards (Global IT, Portal pages, etc.) use the phrase <Dashboard Name> as the
tab name. Dashboard names are defined in the Dashboard Properties window.

• Calendars: Calendars use the phrase <Calendar Name> as the tab name. Calendar names are
defined in the Calendar properties window.

• Quick View: Quick View selections use the Public ID field to populate the tab name. The Public ID
is defined in the Business Object Properties window.

• Go to Item Functionality: Go To Item selections use the Public ID field to populate the tab name.
The Public ID is defined in the Business Object Properties window.
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• Startup Items: Portal Site startup items use the phrase <Startup Item Name> as the tab name. The
startup item name is defined on the Display page of the Site Editor.

• Service Catalog: The Service Catalog in the Customer Portal uses the phrase <Service Catalog>
as the tab name. The tab name is defined in the Widget Properties window of the Service Catalog
Widget.

• HTML Pages: HTML Pages use the Name field to populate the tab name. The Name is defined in
the HTML Page Options window of the HTML Editor.

• Document Repository: The Documentation Repository in the Customer Portal uses the phrase
Document Repository as the tab name.

Multi-tab browsing support is powered by a Command called New Window, which can be found in the
Command Manager.
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Open a New Tab in the Browser Client
Use multi-tab browsing support to open a new tab in the Browser Client.

1. Open a web browser.
2. Navigate to the Browser Client (http://MyServer/CherwellClient).
3. Log in using the appropriate credentials.
4. Click the User Information section of the Application Bar and select New Browser Window.

A new tab opens and displays the default Dashboard.

Note: If you open a new tab outside of CSM, navigate to the configured URL. Do not copy
the URL from the address bar in one tab and use it in another.

5. (Optional) Open up to four additional tabs.
When the session expires or the User manually logs out, the User is logged out of all tabs. Once the
User logs back into one of the tabs, the other tabs become active so the User can continue their
work.
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Open a New Tab in the Portal
Use multi-tab browsing support to open a new tab in the Portal.

1. Open a web browser.
2. Navigate to the Portal (http://MyServer/CherwellPortal/SiteName).
3. Log in using the appropriate credentials.
4. Click the User Information section of the Application Bar and select New Browser Window.

A new tab opens and displays the default home page.

Note: If you open a new tab outside of CSM, navigate to the configured URL. Do not copy
the URL from the address bar in one tab and use it in another.

5. (Optional) Open up to four additional tabs.
When the session expires or the User manually logs out, the User is logged out of all tabs. Once the
User logs back into one of the tabs, the other tabs become active so the User can continue their
work.
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Add a New Window Command to the Browser
Client and Customer Portal

Use the New Window Command to add multi-tab browsing support to additional areas of the Browser
Client and Customer Portal.

When the Command is implemented, you can navigate to CSM in additional tabs without needing to log in
again or consume additional licenses (the new window opens the main Dashboard by default). Consider
creating a One-Step using the Execute a Command Action to add the functionality to even more areas of
your system.

You can add the Command to multiple areas of the Browser Client, including Forms and Dashboards.

For example:

• Add the Command (via a One-Step) to a Knowledge Article form using a Link Label Control so
Users can easily navigate to a new window while keeping Knowledge Article information open.

• Add the Command (via a One-Step) to the Global IT Dashboard so Users can easily navigate to a
record while simultaneously viewing their metrics.

You can also add the Command to areas of the Portal, including the menu bar and Forms.

For example:

• Add the Command (via a One-Step) to the menu bar so Users can easily navigate to a new window
from anywhere in the Portal.

• Add the Command (via a One-Step) to the read-only Knowledge Article form using a Link Label
Control so Customers can easily navigate to a new window while keeping Knowledge Article
information open.

Note: For a full list of areas where you can add Commands in CSM, refer to the One-Step
documentation.
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CSM Administrator
Cherwell® Service Management Administrator (CSM Administrator) is CSM's administrative tool, which is
used to configure, manage, secure, integrate, and automate your CSM system.
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About CSM Administrator
Administrative features include:

• Automation Processes: Pause/resume the Business Process Server, enable/disable Automation
Processes, manage automation rules, and define Business Hours.

• Blueprints: Configure and manage system definitions (example: Business Objects, Fields, Forms,
Grids, etc.) and CSM Items (example: Dashboards, Search Groups, etc.), and to access definition-
driven tools/functionality (example: Directory Service settings, Schemas, etc.).

• Browser and Mobile Settings: Edit Browser and Mobile options (HTML Page Manager, Twitter
Account Manager, etc.).

• Database: Import and export data, and perform system maintenance.

• E-mail and Event Monitoring: Pause/resume the E-mail and Event Monitor Server, configure
Outlook® Integration, and configure/manage e-mail accounts and settings.

• Globalization: Translate text, referred to as "strings," into one or more single-byte languages so
Users can use a single CSM installation to view the same data in multiple languages.

• mApp Solutions: Transfer bundles of CSM functionality between CSM systems.

• Performance: Run the Health Check tool to monitor and optimize system configurations that impact
performance.

• Scheduling: Pause/resume the Scheduler and manage scheduled items.

• Browser and Mobile: Build/manage Customer Portals, manage Browser App settings, manage
browser tools, and manage Mobile configurations/Dashboards.

• Security: Use Security Groups, Roles, Teams/Workgroups, and User/Customer profiles to control
people, functionality, data, environment, and sharing.

• Settings: Configure Global System settings, such as General settings (example: Search, display,
etc.), User Interface settings (example: Task Pane, toolbar, etc.), Table Management settings, etc.

• Trusted Agents: Connect to the Trusted Agents Hub and create Trusted Agents service groups.
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Log in to the CSM Desktop Client or CSM
Administrator

To log in to the CSM Desktop Client:

1. Double-click the blue Cherwell Service Management icon  or orange CSM Administrator

icon  on the desktop, or click Start>All Programs>Cherwell Service Management or
Cherwell Administrator.

Note: If the Automatically Use Connection Without Asking check box was previously
selected or if the system administrator already set up a permanent database connection, the
database connection window will not open.

2. Select a database connection:

Note: Typically, Users connect using an Application Server (3-tier connection), identified by

the Application Server icon .

a. Click the All Users tab to view database connections available to All Users or the User tab to
view database connections available to only to the User logging in.

b. Click a database connection.

Note: To create a database connection, click Add to launch the Connection Wizard. To modify
an existing database connection, click the database connection, then click Edit. To delete an
existing database connection, click the database connection, then click Delete.

c. Select the Automatically Use Connection Without Asking check box to automatically use
this database connection each time CSM is launched. Afterward, the prompt is no longer
available to select a connection.

d. Click OK.
3. Provide the CSM login credentials:

a. User ID: Provide the CSM login ID (this could be domain name/network Username or just
Username).

b. Password: Provide the CSM password. Passwords are case-sensitive.

Tip: By default, there is a User ID called CSDAdmin with a password of CSDAdmin in the
Demo and Starter databases.

c. Automatically Login Without Asking: Select this check box to automatically use the above
information at the next log in. This avoids a login prompt.

d. Click OK.

e. If a User is assigned to more than one CSM Role (and have not previously selected thee. 
Automatically Use Selected Role check box), the Choose Role window opens.
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4. Select the login Role for the session:
a. Click the appropriate Role.

b. Always Use Selected Role: Select this check box to automatically use the selected Role at the
next log in. This avoids the Role prompt.
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Tour the CSM Administrator User Interface
The CSM Administrator User Interface (UI) is dynamic and changes to show helpful and appropriate
options for the administrative tasks being performed. Generally, the Main window shows the following
items:

• Menu bar: Access general administrative tasks.

• Task Pane: Access common administrative tasks, and administrative tasks organized by category.

• Main Pane: View data and to perform the majority of your administrative tasks.

When you first log in to CSM Administrator, the Main Pane displays a Getting Started page to help initially
configure the system. After initial configuration, the Main Pane automatically displays the Home page

, which lists the administrative task categories.

When working in a Blueprint, the entire UI (menu bar, Task Pane, and Main Pane) dramatically changes to
accommodate the Blueprint Editor, which is required to perform Blueprint operations.

Note: For more information about the Blueprints and the Blueprint Editor, see the Blueprint
documentation.

The following figure shows two sample Main windows:

• The Home view that appears when logging in to CSM Administrator (or click the Home button )
and includes categories of functionality.
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• The Blueprint Editor, which appears when creating a Blueprint. Notice that the Menu bar and Task
Pane change to accommodate whatever item is active in the Main Pane. A toolbar shows when the
Blueprint Editor is active.
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CSM Administrator Getting Started Page
By default, CSM Administrator opens a Getting Started page to help set up the CSM system.

Note: Also access the Getting Started page by selecting Help>Go to Getting Started Page.
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To use the Getting Started page, click the task to complete. Available options include:

• Organization Info: Edit the name, the logo, and a theme that represents the organization.

• E-mail: Select e-mail addresses to be used in Automation Processes and for various notifications.
Edit the e-mail signature in this location.

• Active Directory/LDAP: Edit the LDAP settings used to access information in a Directory Service
(a directory stored on a server).

• Escalations: Select which escalations and notification Automation Processes to enable or disable.

After you complete a task, a green check mark appears over the number of the task. When finished
setting up the CSM system and the Getting Started page is no longer needed, clear the check box at the
bottom of the window.

Note: The Menu bar is limited to File and Help and no toolbar exists. All options are accessed in
the panes.
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Global Settings
Global settings control how CSM looks and behaves by default for all Users or in some cases, Users
assigned to specific Roles. Configure Global settings from CSM Administrator.
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Configure Global System Settings
Configure Global system settings for Search, Display, Dashboards/Calendar/Visualization, Catalog, Rich
Text, Record Locking, Help, and more. Most of these settings can be configured Globally, by Role, and by
User.

To configure the Global System Settings:

1. In the CSM Administrator main window, click the Settings category, and then click the Edit System
Settings task.

2. Click the Search page and configure the Global Search settings: Full Text Search, Quick Search,
and Knowledge Search settings.

3. Click the Display page and configure the Global Display settings: DPI/Scaling settings, Multiple
Monitor settings, and an OOTB theme.

4. Click the Dahsboards page and configure the Global Dashboard, Calendar, and Visualization
settings: OOTB Dashboard, HUD, Calendar, and Visualization.

5. Click the Catalog page and configure the Global Catalog settings: Whether or not to store primary
system definitions in a local catalog file on a User's machine, to allow Users to decide whether or
not use a definition catalog, and to force catalog files to be rebuilt each time a User restarts a CSM
Application.

6. Click the Rich Text page and configure the Global Rich Text settings: Determines how images are
stored and shown in Rich Text Fields and the default font for Rich Text.

7. Click the Locking page and configure the Global Record Locking settings: General Record Locking
settings, OOTB Record Locking settings for all Major Business Objects, and Portal Record Locking
settings.

8. Click the Globalization page and configure the Global Globalization settings: Determines culture
settings for your system. You can override these settings for Roles or for individual Users. This page
is only enabled when globalization is enabled for your system. For more information, see Enable
Globalization.

9. Click the Help page and configure the Global Help settings: Help system settings, and whether or
not to globally enable/display Process and Terminology Help for Business Objects and Fields.

10. Click the Advanced page and configure the Global Advanced settings: Dashboard Widget refresh,
system notifications, and web service call settings.
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Configure Global Search Settings
Use the Search page in the CSM Administrator System Settings window to define Global Search settings
for:

• Full-Text Search: Select how to search in Fields and if other forms of words can be used (example:
Plural).

• Quick Search: Select all words or any words.

• Knowledge Search: Select all words or any words.

To configure Global Search settings:

Text Search

Define how string searches (example: CSM Software) are conducted, either:

• All Search Words Should Exist in the Same Field: Returns records only when both
words are found in a single Field (example: CSM and Software are found in the
same Field).

• Search Words Can Be Found in Different Fields: Returns records if both words are
found in different Fields in the same Business Object (example: CSM is found in
one Field and Software is found in another Field).

Search For Different Forms of the Word: Returns records that have plural and past
tense forms of the word and different verb tenses. For example, if the search is for find,
the records found will be those with find, finds, found, etc.

Quick
Search

All Words: Search uses all words (AND is used to separate words in search).

Any Words: Search uses any of the words (OR is used to separate words in search).

Knowledge
Search

All Words: Search uses all words (AND is used to separate words in search).

Any Words: Search uses any of the words (OR is used to separate words in search).
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Configure Global Display Settings
Use the Display page in the CSM Administrator System Settings window to configure Global Display
settings for Multiple Monitors and Desktop Client Application Skin.

Multiple Monitors
Specify where to open/restore CSM Application windows after they are closed (if there are multiple
monitors):

• Original Monitor
Window opens in the same location on the same monitor where it was last closed.

• Application Main Window Monitor
Window opens in the same location on the same monitor as the application Main window (the
upper-left of the main application is the control point if the application straddles multiple monitors).

• Mouse Pointer Monitor
Window opens in the same location on the same monitor as the mouse pointer. This option only
differs from the Application Main Window Monitor option when the User uses the keyboard to open
windows in CSM, and the mouse pointer is located on a different monitor from the one where the
application Main window is located. For example, if you have the CSM Main application on monitor
2, but bring up the One-Step Action Manager and drag it to monitor 1, when you edit an existing
One-Step Action, the Manager will appear on monitor 1, even though the main application is still on
monitor 2.

Note: This setting applies to all CSM databases (example: CSM Administrator) on your
current computer. Windows that always open fully on the screen are not governed by these
changes. If a window is too large to physically fit on the monitor, it will be snapped to the left
and/or top edges depending on if it is too big in just one or both dimensions. You might
notice this if you consistently drags windows partially off of the screen and expect them to
open that way the next time.

Application Skin
Select a default application skin from the Skin list to control the appearance of the Desktop Client and
Administrator Client shells. Options are Cherwell Light (default), Cherwell Blue, or Cherwell Dark.

The skin selected affects all Users by default. However, Users can change the application skin in the
Desktop Client, which only affects their personal interface.

Note: Users may need to close and reopen the Administrator Client for this change to take effect
in that client.

CSM 9.4.0 Client Suite 230

CSM 9.4.0 Client Suite



Configure Global Dashboard, Calendar, and
Visualization Settings

Use the Dashboards, etc. page in the CSM Administrator System Settings window to configure a Global
default:

• Dashboard (Home Dashboard)

• Heads Up Display (HUD)

• Calendar

• Visualization

To configure Global Dashboard, Calendar, and Visualization settings:

Default Dashboard Click the Dashboard button to open the Dashboard Manager, and then select an
existing Dashboard or create a new Dashboard to use as the system default.

Default Heads-up
Display

Click the Dashboard button to open the Dashboard Manager, and then select an
existing Dashboard or create a new Dashboard to use as the OOTB HUD.

Default Dashboard
Theme

In the drop-down, select a Dashboard Theme to apply to all Dashboards in the
system.

Default Calendar Click the Calendar button to open the Calendar Manager, and then select an
existing Calendar or create a new Calendar to use as the default.

Default config
visualization

Click the Visualization button to open the Visualization Manager, and then select
an existing Visualization or create a new Visualization to use as the default.
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Configure Global Catalog Settings
When the Desktop Client is initially launched, core system definitions are retrieved from the server and
stored in a local catalog file. Definitions do not need to be retrieved again unless a Blueprint is published.
Use the Catalog page in the CSM Administrator System Settings window to define Global setting for the
catalog, such as whether or not to:

• Store primary system definitions in a local catalog file on a User's machine.

• Allow Users to decide whether or not use a definition catalog.

• Force catalog files to be rebuilt each time a User restarts a CSM Application.

To configure Global Catalog settings:

Store Primary System
Definition in a Local
Catalog File on Users'
Machines

Retrieves core system definitions from the server when the Desktop Client
is initially launched, and then stores them in a local Definition Catalog file.
Definitions do not need to be retrieved again unless a Blueprint is
published.

Allow Users to Decide
Whether or Not to Use a
Definition Catalog

Allows Users to override the above default and set their own personal
Catalog defaults in the CSM Desktop Client (Tools>Options>General
page).

Invalidate all Current
Catalogs

Forces all local Catalog Files to be built the next time each User starts a
CSM Application.
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Configure Global Rich Text Settings
Use the Rich Text page in the CSM Administrator System Settings window to:

• Determine how images (example: Embedded screenshots) are stored and shown in Rich Text
Fields, including file type (JPEG or PNG), display mode (thumbnail or full), and size limits (in KB or
MB).

• Set default font for text.

To configure Global Rich Text settings:

Image Format Select either JPEG or PNG. Images not in a default format are converted to the
default image format (either JPEG or PNG).

Default Display
Mode  

Form Images
Are Displayed
As

Determines how embedded images are shown in the Rich Text Field:

• No Image Support: No image is shown.

• Small Thumbnails: A small thumbnail of the image is shown.

• Medium Thumbnails (default): A medium thumbnail of the image is shown.

• Large Thumbnails: A large thumbnail of the image is shown.

• Full Images: A full-sized version of the image is shown.

Zoomed
Images Are
Displayed As

Select an option (No Image Support, Small/Medium/Large Thumbnails, Full Images
(default)) to determine how embedded images in Rich Text Fields are shown in the
Rich Text Zoom window.

Size limits
• Maximum size per image (default is 500 kilobytes)

• Maximum total size for images (default is 3 megabytes)

Custom Default
Font

Uses a default font for all Rich Text Fields.

Click the Ellipses button to open the Font window. Select a Font, Font style, and
Size.

Note: The default font selected here applies to all Rich Text Fields that do not have a
default font specified in Field Properties. It overrides any font selections made in the
Form Editor during Form design. However, if a default font was selected in the Field
Properties for a specific Field in a Business Object (example: Resolution Fields in
Problems), it overrides the default font selected here.
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Global Record Locking Setting Options
Define the options below for Record Locking Settings.

Enable Record
Locking Enables Record Locking

Unlock Records when
User session ends
(Recommended)

Automatically unlocks all of a User's records when the User logs out of a
session. If cleared, the record remains locked until the record is saved (if
configured), until the lock expires (if configured), or until the record is manually
unlocked.

Update Lock Status
and Notify of Any
Changes, When
Possible

Automatically shows status and change notifications (example: Reload and
Merge) to the lock holder and any other User who might be viewing a locked
record. If not selected, Users are notified only if they attempt to edit a record.

Note: Automatic notifications are not available in the Browser Client.

Configure OOTB
Record Locking
settings for all Major
Business Objects

These OOTB settings can be overridden on a per Business Object basis by
configuring Record Locking settings for a Business Object.

Default Lock Type: Select one lock type.

• None: Does not enforce or inform record locking even though it is
enabled for the system. Tip: Use this option to enable record locking for
the system but not use it for most Business Objects, then enable/
configure Record Locking settings on a per Business Object basis.

• Enforced: Prevents Users from editing a record when it is locked by
another User (the lock holder).

• Informational: Warns Users when a record is currently locked by
another User so that Users do not attempt to edit the same record. If two
Users do edit the same record, CSM gives Users the option to merge
the edits.

Default Lock Type

• None: Does not enforce or inform record locking even though it is
enabled for the system. Tip: Use this option to enable record locking for
the system but not use it for most Business Objects, then enable/
configure Record Locking settings on a per Business Object basis.

• Enforced: Prevents Users from editing a record when it is locked by
another User (the lock holder).

• Informational: Warns Users when a record is currently locked by
another User so that Users do not attempt to edit the same record. If two
Users do edit the same record, CSM gives Users the option to merge
the edits.

Lock Record Upon
Editing

Automatically locks the record when a User attempts to edit the record. If
cleared, Users must manually lock records.
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Unlock Record Upon
Saving

Automatically unlocks the record when a User saves the record. If cleared, the
record remains locked until the User ends his session (if configured), until the
lock expires (if configured), or until the record is manually unlocked.

Lock Expires After

Enables lock expiration and specifying the time limit in minutes (example:
30). If cleared, the record remains locked until the User ends his session (if
configured), until the record is saved (if configured), or until the record is
manually unlocked.

Minutes Before Lock
Expiration to Notify
Users

Notifies Users of impending expiration and allow renewal before expiration.
Users can specify the number of minutes before expiration to notify Users
(example: 3 minutes).

Maximum Number of
Records a User Can
Have Locked at One
Time (Per Business
Object Type)

Specify the maximum number of records a User can have locked at one
time, per Business Object (example: Each User can lock only ten Incidents at
a time).

Customer Portal
Settings

Portal Participates in Record Locking (applicable only for enforced locking):
Allows Customers working in the Portal to lock records and see locks on
records.

Note: When a Customer attempts to edit a record, the record is automatically
locked; and, when the Customer saves the record, the record is automatically
unlocked. This prevents Users from editing records at the same time as
Customers. However, the Customer does not see messages about locks
unless they attempt to edit a record that is locked by another User or
Customer.

Note: If the Portal does not participate in record locking (or record locks are
Informational), the Customer is able to edit records even if a User has the
record locked. The User is given the option to merge the Customer’s edits.
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Configure Global Help Settings
Use the Help page in the CSM Administrator System Settings window to configure the following Global
Help settings:

• If and where to access an alternative Help System rather than the context-sensitive CSM Help
System.

• Whether or not to globally enable/display Process and Terminology Help for Business Objects and
Fields: Process and Terminology Help text/Help Systems/sites are defined for each Business
Object/Field in the Process and Terminology pages in the Business Object/Field Properties
windows.

To configure Global Help settings:

Alternate Help Site Accesses a defined Help System/site rather than the OOTB CSM Help
System. Then define which Help System/site to use (in the URL field).

URL Specify the URL to where the alternative Help System/site is stored.

Pass Parameters Enables passing parameters.

Show Process and
Terminology Help

Enables/shows Process and Terminology Help in CSM. Process and
Terminology Help text is defined in the Process and Terminology pages in the
Business Object/Field Properties windows.
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Configure Global Advanced Settings
Use the Advanced page in the CSM Administrator System Settings window to configure the following
Global Advanced settings:

• How many Dashboard Widgets to refresh simultaneously.

• How long to wait between notification checks.

• How to handle web service calls.

Note: No Role or User Advanced settings are available.

About configuring the Global Advanced settings:

Max
simultaneous
Widget refresh

Define the maximum number of Widgets that can be refreshed simultaneously
(default is 5). Use the up/down arrows to increase/decrease the number.

Note: When a Dashboard is set to reload its data, it will combine refresh
requests. Increasing this number might make Dashboards update more
smoothly, but might also increase network traffic and slow down other
Users/operations.

Configure
Notification
Settings

The Cherwell Application Server sends messages to clients regarding updates
(example: Definitions need to be reloaded, Queues need to be updated, or records
have been locked, etc.). This information is attached to regular requests from the
client to the server. However, if the client has not communicated with the server
within the maximum notification time, the client checks for updates.

Note: Decreasing these values can make clients get updated data more
frequently, but also increase network traffic.

Max time
between client
notification
checks

 

Max time
between server
notification
checks

 

Web Service
Settings

The settings defined here might override some of the settings defined when you set
up a web service.
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Calling Web
Services from
Client

Select an option for allowing web service calls from a client.

• Allow: Select this option to allow web services to be called from a client.

• Don't Allow: Select this option to prevent web services from being called by
clients. Users who try calling a web service from a client will receive an error.

• Force to Server: Select this option to force client web service calls to the
server.

• Based on Security: Select this option to determine whether a client can call a
web service based on security rights (Allow calling web services from client
machine).

Unsecured Calls
(HTTP)

Select an option for unsecured web service calls.

• Allow: Select this option to allow unsecured (HTTP) web service calls.

• Don't Allow: Select this option to prevent unsecured web service calls. Users
who try making unsecured calls receive an error.

• Force to HTTPS: Select this option to have all unsecured web service calls
forced to HTTPS.

Allow self-signed
certificates
(HTTPS)

Select this check box to allow calls to web services with self-signed certificates
(certificates not signed through a signing authority such as VeriSign).

If this box is cleared, Users receive an error whenever they try to call a self-signed
web service.

Auditing

Select an option for determining what to audit (log).

• None: Select this option to audit nothing.

• Based on Service Settings: Select this option to audit based on the web
service's auditing setting.

• All Web Service Calls: Select this option to audit all web service calls.

• Server-Based Calls: Select this option to only audit web service calls made
from the server.

Note: Web service calls are audited by writing an entry into the Cherwell
Application Server log (which can write to a file, to the event log, or to an
external logging tool such as Splunk). The log must be configured for web
service calls to be captured.
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Warning: Using the Use legacy rules for related data retrieval check box is not recommended.
It allows the system to emulate legacy behavior. Doing so loads Relationships beyond the second
level and can severely degrade system performance or cause recursion problems.
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Configure Cherwell Mobile Settings
Cherwell Mobile settings define which:

• Mobile Dashboard (Home) to display by default.

• Mobile Dashboard (Alert) to display by default.

• Business Objects to make available. Associated Search Groups will also be available.

• Actions/One-Step Actions to allow for each Business Object.

The default Cherwell Mobile settings (either Global or Role) are initially configured in CSM Administrator.
If a User has security rights, she can configure her User (personal) Cherwell Mobile settings.
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Configure Global/Role Cherwell Mobile Settings
Use the Mobile Configuration window in CSM Administrator to configure how Cherwell Mobile looks and
behaves on mobile devices, Globally or by Role. You can configure which:

• Mobile Home Dashboard to display by default.

• Mobile Alert Dashboard to display by default.

• Business Objects to make available. Associated Search Groups will also be available.

• Actions/One-Step Actions to make available for each Business Object.

To configure Global/Role Cherwell Mobile settings:

1. In the CSM Administrator main window, click the Browser and Mobile category, and then click the
Edit Mobile Configuration task.

The Mobile Configuration window opens, listing the available Roles (Default is a global default, is
always defined, and applies for all Users/Roles unless overridden). The small green check mark
indicates that settings have been configured for a particular Role.

2. Click Default (Global) or a Role, and then click the Edit button.

Note: Our example uses Global. If you select a Role, you have the option to override the
Global default and configure Cherwell Mobile settings from scratch.
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Tip: Click the Clear button to clear configured settings for a selected Role. If no defaults are
configured for a Role, members of that Role see the Global default settings (which cannot be
cleared).

The Mobile Access Setup window opens, listing the objects (Dashboards and Business Objects)
currently being displayed on mobile devices.

3. Select default Mobile Dashboards (Home and Alert):

Tip: If you do not want to display any Dashboards, remove the Dashboard item from the List of
Objects to Display on Mobile Device list.

a. Home Page: Select a default Mobile Home Dashboard.
◦ Click the drop-down to select from a list of recently used Mobile Dashboards.

◦ Click the Mobile Dashboard button  to open the Mobile Dashboard Manager, and
then select an existing Mobile Dashboard or create a new Mobile Dashboard.

b. Alerts Page: Select a default Mobile Alert Dashboard.
◦ Click the drop-down to select from a list of recently used Mobile Dashboards

◦ Click the Mobile Dashboard button  to open the Mobile Dashboard Manager, and
then select an existing Mobile Alert Dashboard or create a new Mobile Alert Dashboard.

4. Select the Business Objects to make available in Cherwell Mobile:
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Important: In order for a Business Object to be available, it must have the Show in Search
Manager property set (in the Business Object properties within a Blueprint).

a. Override List of Objects to Display on Mobile Device: Select this check box to override the
current Global default list of Business Objects. This check box does not appear when
configuring Global defaults because there is nothing above them to override.

b. Click Add, and then select the Business Object to make available on mobile devices.

Tip: Click Edit to edit a selected item. Click Remove to remove the selected item from the list.

c. Define how to display the Business Object in Cherwell Mobile:
◦ Custom Name: Provide a display name to use in Cherwell Mobile. If blank, the Business

Object name is displayed.

◦ Custom Image:

Click the Image button to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

If no image (None) is selected, the default image for the Business Object is displayed.

Android: Android devices use standard color images. For the best results, use the
images in the BusObs>32x32 folder in the Image Manager. If you are setting up a mobile
configuration for use on both Android and iOS devices, use the iPhone-specific images.
They will be automatically mapped to equivalent standard images for non-iOS devices.

CSM 9.4.0 Client Suite 243

CSM 9.4.0 Client Suite



d. Select the Actions/One-Step Actions to make available in Cherwell Mobile:
i. Click Add to add a new Action/One-Step Action to the list.

Tip: Click Edit to edit a selected item. Click Remove to remove the selected item from

the list. Use the Up/Down arrows   to change the order of the Actions/One-Step
Actions when displayed in Cherwell Mobile (ex: In the Actions list).

ii. Define additional options for the list of Actions:
◦ Also Show Default Business Object Actions: Select this check box to also make

available any default Actions for the Business Object. This option is only available if
the Business Object has default Actions available (ex: Approvals have built-in
functionality to approve, deny, and abstain).

◦ Also Show Global Actions: Select this check box to make available any Actions that
were defined for the Business Object as part of the Global default settings.

Note: This option is available only if you are configuring settings for a Role.

5. Configure the order of the Actions when displayed in Cherwell Mobile (ex: On the Actions popup
list):

a. Use the Up/Down arrows   to order the Actions.

6. Click OK.6. 
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Configure Global Task Pane and Search Control
Settings

Configure which items appear in the Task Pane or which Search Control is used on the CSM Menu bar.
These settings can be applied to globally all Users or for Users assigned to specific Roles.

To configure Global/Role Task Pane and Search Control settings:

1. In the CSM Administrator main window, click the Settings category, and then click the Edit Default
Task Panes and Menu Search task.

Note: Default is a Global default and applies for all Users/Roles unless overridden. The
small green check mark indicates that Task Pane and Search Settings have been defined for
a particular Role. If no defaults are defined for a Role, members of that Role see the Task
Pane and Search Settings for the Global default, if defined.

2. Click Default (Global) or a Role, and then click the Edit button.

The Global or Role Task Pane and Search Settings window opens (our example shows how to edit
the OOTB task pane and search settings, which applies to all Users and becomes the Default Task
Pane Setup).

3. Configure Task Pane settings:
◦ View or hide sections.

◦ Add new sections.

◦ Configure sections (only applicable to new sections).

◦ Delete sections (only applicable to new sections).

◦ Organize sections.

4. View or hide the following sections in the Task Pane (select or clear the corresponding box):
◦ Quick Search

◦ Common Tasks

◦ Actions

◦ Queues

◦ Process and Terminology

◦ Customer Information

5. Add Sections to the Task Pane:

Note: Any items added to the Global Task Pane become part of the Global default task pane
setup. If editing the Task Pane and Search settings for a Role, select the Use default task
pane setup check box to use the settings defined for the Global default. This check box
must be cleared to add items to a Role Task Pane.

a. Click Add.
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b. Provide a title for the Task Pane section.

c. Click Add to open the Action Manager.

d. Select the CSM Items to show in the Task Pane (Calendars, Commands, Dashboards,
Document Repositories, One-Step Actions, Reports, Searches, or Visualizations).

e. Click OK.e. 

Tip: Click Configure to edit the title and list of Actions for a newly added section. Click Delete
to delete a newly added Task Pane section. Use the up/down arrows to change the order of
Task Pane sections.

6. Customize the CSM Search Control in the Menu bar Search Options:
◦ Use Default: Uses the OOTB Search Menu Search Widget, which allows Users to run a Quick

Search on multiple Business Objects simultaneously (example: Knowledge Article, Incident,
Problem, and Change Request). Users can also select a Business Object in the drop-down to
search one item at a time (example: Specific Search).

◦ Use Search Widget: Uses a specific Search Widget. Click the Ellipses button to open the
Widget Manager, and then select an existing Search Widget or create a new Search Widget.

◦ No Menu Bar Search: Removes the Search Control from the menu bar.
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Configure Custom Global Toolbars
Create and configure custom toolbars to provide quick access to CSM operations for all Users or Users
assigned to particular Roles.

To configure a custom Global toolbar:

1. In the CSM Administrator main window, click the Settings category, and then click the Edit Custom
Toolbars task.

The Configure Toolbars window opens.

Note: Default is a Global default and applies for all Users/Roles unless overridden. The
small green check mark indicates that a custom toolbar has been defined for a particular
Role. If no defaults are defined for a Role, members of that Role see the custom toolbar for
the Global default, if defined.

2. Click Default (Global) or a Role, and then click the Edit button.

The toolbars for <Global/Role> opens.

3. Click the Add button.

4. Define general properties and Actions for the toolbar:
a. Name: Provide a name for the toolbar. This is the name that shows in the toolbar context

menu (in the Desktop Client, right-click toolbar to show a context menu of available toolbars to
display).

b. Show by Default: Shows the custom toolbar in the Desktop Client by default. Otherwise, Users
have to manually show it (right-click toolbar>select a toolbar to display).

c. Add Action: Click this button and select the type of Action to add to the custom toolbar.

A CSM Item Manager opens (varies by type of Action selected in the previous step), and then
select/create the CSM Item to initiate through the Action.

d. Select a CSM Item (example: A specific Dashboard).

e. Define properties for the Action:
◦ Action: Shows the name of the Action as it is recognized by CSM (example: Name of the

Dashboard or Report).

◦ Display text: Provide the text to show on the toolbar button if Show text on button
(below) is selected.

◦ Image button:

Click the Image button to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

◦ Help text: Provide a tooltip to show when the cursor is on the menu item.
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◦ Begin group: Shows a horizontal line before the menu item, separating it from other
menu items.

◦ Show text on button: Shows the Display Text on the toolbar button.

f. Add additional Actions to the toolbar.

5. (Optional) Create additional custom toolbars.
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